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Documentation Updates
The title page of this document contains the following identifying information:
l

Software Version number, which indicates the software version.

l

Document Release Date, which changes each time the document is updated.

l

Software Release Date, which indicates the release date of this version of the software.

To check for recent updates or to verify that you are using the most recent edition of a document, go
to:
http://h20230.www2.hp.com/selfsolve/manuals
This site requires that you register for an HP Passport and sign in. To register for an HP Passport
ID, go to:
http://h20229.www2.hp.com/passport-registration.html
Or click the New users - please register link on the HP Passport login page.
You will also receive updated or new editions if you subscribe to the appropriate product support
service. Contact your HP sales representative for details.
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Support
Visit the HP Software Support Online web site at:
http://www.hp.com/go/hpsoftwaresupport
This web site provides contact information and details about the products, services, and support
that HP Software offers.
HP Software online support provides customer self-solve capabilities. It provides a fast and
efficient way to access interactive technical support tools needed to manage your business. As a
valued support customer, you can benefit by using the support web site to:
l

Search for knowledge documents of interest

l

Submit and track support cases and enhancement requests

l

Download software patches

l

Manage support contracts

l

Look up HP support contacts

l

Review information about available services

l

Enter into discussions with other software customers

l

Research and register for software training

Most of the support areas require that you register as an HP Passport user and sign in. Many also
require a support contract. To register for an HP Passport ID, go to:
http://h20229.www2.hp.com/passport-registration.html
To find more information about access levels, go to:
http://h20230.www2.hp.com/new_access_levels.jsp
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Introduction to Service Manager 9.32
Service Manager (SM) 9.32 has been designed to improve overall product quality, as well as add
significant new internal functionality and end-user facing features.
Starting with end-user features, in this release both the Service Request Catalog and Mobility have
been extended to allow you to better customize the user experience to match your business
processes. In addition, end users will appreciate the numerous usability enhancements in the web
client and find that navigating the documentation has been vastly improved as well.
As an administrator you can now interact with Service Manger through a RESTful API, which
makes integrating with Service Manager easier than ever before. Additionally, you can improve
Service Manager reliability by replacing the SM Software Load Balancer with an F5 Hardware Load
Balancer. There is also a new tool called HP Service Manager Doctor (“SM Doctor”) built-in to
Service Manager to aid in troubleshooting product issues. Further, Service Manager now supports
Common Access Card Sign-On, FIPS compliance, and use of the IPv6 protocol for network
communication. Finally, a new Survey Integration tool allows you to reach out to your users and
customers like never before.
To get a better idea of these features, we invite you to watch the Service Manager 9.32 New
Features Overview video on the HP Live Network.
And last but not least, SM 9.32 continues the trend over the last 18 months of improving product
quality. The majority of the backlog of customer-reported important defects have now been fixed.
We still need to make continuous effort in improving quality, however, based on the customer
feedback we have received, our focus going forward is on adding new functionality. New
functionality does not only happen in the minor-minor patch releases. Additional Service Manager
content is released on the HP Live Network. Be sure to watch for new optional features!
As always, we encourage you to actively participate in making Service Manager better. Please
follow us on Twitter at @HPITSM, or on our blog.
Sincerely,
The SM Product Delivery Team
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What's New in This Release
This section describes important changes in this release. The following table lists the new features
in this release and the required versions of components (prerequisites) for using them.
Feature

Prerequisites

Mobility Client

l

SM9.32 server

l

SM9.32 applications, or SM9.30/9.31 applications
+ unload files

Service Request Catalog

RESTful API Framework

Support of F5 Hardware Load Balancers

Cross-Table Join Query Improvements

Support of Primary Keys and Not Null

l

SM9.32 server

l

SM9.32 applications

l

SM9.32 server

l

SM9.32 applications

l

SM9.32 server

l

SM9.32 Windows/web client

l

SM9.32 server

l

SM9.30, 9.31 or 9.32 applications

l

SM9.32 Windows/web clients

l

SM9.32 server

l

SM9.32 applications

l

SM9.32 Windows/web client

l

SM9.32 server

l

SM9.32 applications

l

SM9.32 clients (Windows, web, Mobility, and

Constraints

IPv4/IPv6 Dual Network Support

SRC)
Common Access Card (CAC) Sign-On

HP Service Manager (9.32)

l

SM9.32 server

l

SM9.32 web client
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Feature

Prerequisites

FIPS 140-2 Compliance

l

SM9.32 server

l

SM9.32 applications

l

SM9.32 clients (Windows, web, Mobility, and
SRC)

HTML Email Solution

l

SM9.32 server

l

SM9.32 applications

l

SM9.32 Windows/web client

l

SM9.32 server

l

SM9.32 applications

l

SM9.32 Windows/web client

Service Manager Doctor (SM Doctor)

l

SM9.32 server

Enhanced Inactivity Timer Mechanism

l

SM9.32 server

l

SM9.32 applications

l

SM9.32 web client

Updated Web Tier Directory Structure

l

SM9.32 web client

Usability Improvements

l

SM9.32 server

l

SM9.32 applications

l

SM9.32 Windows/web client

Survey Integration Solution

Mobility Client
The Service Manager 9.32 Mobility client (also referred to as the "Mobile Applications client" in the
Service Manager documentation) offers the following features:
l

Broad Smartphone Support
The Mobility client adds support for iOS, Android, and BlackBerry mobile operating systems,
with a modern flat-style UI.
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l

Additional Language Support
Unlike previous versions, the SM9.32 Mobility client supports all languages that the Service
Manager (SM) server supports, except for two right-to-left display languages, Arabic and
Hebrew. The Mobility client directly retrieves the list of login languages from the SM server,
without the need to configure supported languages. See "Local Language Support" on page 227.

l

Increased Load Capacity
The maximum allowed number of concurrent users has been increased significantly. The
Mobility client now supports up to 1000 concurrent users.

l

Support of More Approval Types
The SM9.32 Mobility client supports approvals of the Service Desk and Change Management
modules:
n

A Service Desk Agent can approve or deny an interaction request submitted from Service
Desk.

n

A Service Request Catalog Approver can approve or deny an interaction request submitted
from Service Catalog.

n

l

A Change Approver can approve, deny or retract a Change request.

Robust Tailoring Capability
Tailoring is not possible in the SM9.30 or SM9.31 Mobility client. The SM9.32 Mobility client
provides the following tailoring options:
n

Add, rearrange, or remove fields on an out-of-the-box (OOB) Mobile Applications form

n

Add existing or custom Service Manager views to the Mobility client user interface (UI)

n

Create Mobile Applications forms for added views

n

Customize action bar options in the Mobility client UI

n

Configure a prefix for a record type that is used for quick search

In addition, the Mobile Applications now supports 15 form controls.
l

Quick Search

HP Service Manager (9.32)
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The SM9.32 Mobility client adds a quick search functionality. Users now can immediately locate
a record by entering its record ID (including the ID prefix) in a search box.
l

Support of SSL, TSO, and LW-SSO
n

Support SSL (Secure Sockets Layer) to protect communications between Mobile
Applications and the Service Manager server.

n

Support Trusted Sign-On (TSO) and Lightweight Single Sign-On (LW-SSO):
o

By enabling LWSSO, SM is able to authenticate a user with credentials retrieved from
another LW-SSO-enabled product without the need to enter a username and password
manually.

o

By enabling TSO, similar to LW-SSO, users can access the Mobility client with valid
credentials directly. For example, users can log in to an enterprise portal first, and the
portal will pass the authentication information to SM for TSO.

l

IPv6 Support and Federal Information Processing Standards (FIPS) Compliance
The Mobility client now offers IPv6 support and is FIPS 140-2 compliant.

For details, see the Service Manager 9.32 Mobile Applications User Guide.

Service Request Catalog (SRC)
SRC 9.32 provides the following new features.
l

Rebranding
SRC is now re-branded to match the version of Service Manager with which SRC is released.
The previous release of SRC was numbered version 1.40, and was released together with
Service Manager 9.31. This release is now numbered the same as the Service Manager version
with which it is released, 9.32.

l

Recurring Costs
Recurring Costs are now clearly identified in the costs area when you select an item. The cost
area displays the base cost and then lists any recurring costs for each time period (for example,
+10 USD/month). In addition, recurring costs for an item can now be highlighted by a price tag
icon in the Pending Approvals window of your Request Inbox. Whether this icon appears is
configurable by the system administrator.
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l

Dynamic user options
Administrators can now configure items in the Service Catalog in Service Manager to present
options and fields dynamically to users. This feature can be used to gather additional information
from end users that is specific to their request and can also reduce the size of the Service
Catalog by allowing items to be configured dynamically (therefore, administrators do not need to
specify multiple variants of the same item). As such, end users may see additional fields or
options appear as they make their requests.

l

User Interface Customization
In this version, Service Request Catalog extends its customizability features by allowing
administrators to tailor virtually every label in Service Request Catalog. In addition,
administrators can customize the default SRC checkout panels. Together, these additions
provide an almost limitless combinations for administrators to design the SRC UI.

l

Additional Language Support
This version of Service Request Catalog adds Hebrew to the list of translated languages in
which SRC is deployed. In addition, Right-to-Left support was fixed so that Right-to-Left
languages like Hebrew and Arabic behave as expected. Also, because of the extended
customizability of the user interface, it is now possible for an organization to completely
translate all strings in the SRC UI, which effectively enables an organization to self-translate
SRC to whatever languages they wish.

l

Enhanced Look-up Fields
In this release of Service Request Catalog, when you make a request and select a value from a
look-up field, you can select the data from a multi-column list (a QBE list in Service Manager)
that displays all information for that record. In earlier versions of Service Request Catalog, not
all of this data was presented. For example, a look-up for a contact name would show only the
first and last names that matched your search. However, this was problematic in large
organizations, where two individuals could share the same name, or the organizations business
practice required you to identify the user by a unique identifier, such as employee ID. Now, you
can see all information in a table, displaying the users first and last name, their department and
employee ID, or whatever else the administrator has configured for that record. Note that, after
you select a record, all record information is included in the request, even though only part of it
may be shown in the SRC UI.

l

Upgrade Tool

HP Service Manager (9.32)
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This release of Service Request Catalog introduces a new upgrade tool. The Upgrade Tool
allows you to automatically migrate your customizations from your deployed SRC 1.4 .war to
SRC 9.32.
l

Support for IPv6, Common Access Cards (CAC), and Federal Information Processing
Standards (FIPS)
Together with Service Manager 9.32, Service Request Catalog offers support for IPv6, Common
Access Cards (CAC), and Federal Information Processing Standards (FIPS). For more
information on these features, see the Service Manager documentation in addition to the Service
Request Catalog documentation.

For more information, see the following documents:
l

Service Request Catalog 9.32 Interactive Installation Guide

l

Service Request Catalog 9.32 Customization Guide

RESTful API Framework
Service Manager 9.32 now supports a RESTful API framework, which supports lightweight queries
and operations on Service Manager data through a single Uniform Resource Identifier (URI). The
RESTful API framework is easier to use than the Service Manager traditional SOAP API.
The following query functions are provided in this RESTful API framework:
l

Basic queries for elements/collections

l

Service Manager native query language

l

Sort and pagination in queries

l

Three query views: Summary, Condense, and Expand

By using the RESTful API Framework, you can also create an application that can perform actions,
including intrinsic operations such as CRUD (Create, Read, Update and Delete) and extrinsic
operations such as SM specific actions (such as Close, and Resolve), on Service Manager
objects.
Note: The existing SOAP-based web services available in previous version are still available
in Service Manager 9.32.
For more information, see the Service Manager 9.32 Web Services Guide.
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Support of F5 Hardware Load Balancers
Service Manager 9.32 provides the ability to replace the Service Manager software load balancer
with an F5 hardware load balancer (F5 LB).
Note: In this section, a web server refers to Apache or IIS, a web application server refers to
Tomcat, WebSphere, JBoss, or WebLogic, and an SM application server refers to a server
hosting the SM RTE, which is comprised primarily of SM servlets.
Newly Supported Scenario
The following item describes this newly supported scenario:
l

Web server (s) + Web application servers <-> F5 LB <-> SM application servers

Note: Support for this scenario is limited to devices from F5.

Previously Supported Scenarios
Prior to the 9.32 release, there were a number of supported scenarios where hardware load
balancers (HWLB), such as F5, could be used with Service Manager:
l

Browsers <-> F5 LB <-> Web server(s) + Web application servers

l

Browsers <-> F5 LB <-> Web application servers (not recommended if requires TSO/SSO)

l

Web Services clients <-> F5 LB <-> SM application servers

Note: These three scenarios are still supported with the 9.32 release and are unchanged.

Note: For instructions on configuring hardware load balancing between browsers and web
servers/web application servers, see the specific hardware load balancer documentation and
web server/web application server documentation.
Best Practice
HP has observed that customers may choose to omit the web server component in their
implementations. Because this is a viable configuration and the exact reasons for choosing such a
configuration vary, HP recommends customers adhere to the best practice of implementing the SM
Web Tier in a standard web server + Web application server configuration. That is, use a
combination of products such as Apache HTTP Server + Apache Tomcat to host the SM Web Tier.

HP Service Manager (9.32)
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This is particularly important when there is a requirement to implement SSO/TSO functionality in
your environment.
Sample Architecture Diagram
The following architecture diagram depicts an environment in which an F5 load balancer is
implemented in all supported load balancing scenarios. Note that this diagram does not show
hardware load balancing between browsers and web servers, and the part highlighted in red
indicates the newly supported scenario.

For more information, see the topics in the following section in the online help:
l

System Administration > Configuring installation and setup options > Server implementation
options > Hardware load balancers

Server Refactoring
Service Manager 9.32 has the following refactoring of the Service Manager server to achieve better
performance and optimized functionality.

Cross-Table Join Query Improvements
The performance when running a join across database tables has been vastly improved as
compared to previous releases of Service Manager prior to version 9.32. Previously, a query

Page 16 of 229

HP Service Manager (9.32)

Release Notes
What's New in This Release

running across two tables was performed in memory by Service Manager. For data sets that
contain millions of record, this process could be extremely time consuming. Now, the RDBMS
handles the initial join operation and returns a subset of results to Service Manager.
Benefits
The new mechanism has the following benefits:
l

Improved Performance
Customers may have several million tickets and in addition high volumes of master data, for
example, contacts (>350,000), departments (>50,000), locations (>10,000), and subscriptions
(>500,000). Usually inboxes should display data from several tables, where the inbox query runs
against several queries. Being able to do cross-table queries in SM makes the tool
unrecognizably faster because so many things require one iteration, and it allows a much more
normalized database design.

l

Reduced Maintenance Effort
The cross-table queries are required to avoid duplication of data within Service Manager. Having
this functionality now makes duplication of data unnecessary; this in the end reduces the
maintenance effort, because data modifications (for example, in master data) are easier to
perform.

l

Simplification
Running a direct SQL cross-table query provides a simple way of returning a list of ticket
numbers that meet complex cross-table where clauses. It can also help to exactly align (remove
doubt) for certain SQL queries across systems (SM, reporting, sql connections and extracts
directly from the database) for a single version of the truth.

For more information, see the topics in the following section in the online help:
l

System Administration > Database Administration > Data persistence > Database performance
tuning > Cross-table join query improvements

Limitations
Due to the fact that the RDBMS now performs this work, a number of limitations have been
imposed. For more information, see the following topic in the online help:
l

Limitations on cross-table join queries

Support of Primary Keys and Not Null Constraints
Prior to version 9.32, Service Manager did not support primary keys or Not Null constraints in the

HP Service Manager (9.32)
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tables contained within the RDBMS. While the Service Manager logical representations did include
support for unique keys with an Not Null constraint, this support was managed entirely within
Service Manager and not in the RDBMS. Because of this lack of functionality, SQL queries
generated by Service Manager added an Is Null condition in the WHERE clause. This
mechanism resulted in poor performance when considering the speed advantages of leveraging the
inherent integrity of the database.
As of version 9.32, Service Manager supports primary keys and "Not Null" constraints on the
unique keys.
Primary Key Mode
By default, primary key mode is disabled. To use primary keys, you must enable primary key mode
in all SM server nodes. This can be done by configuring the parameter primary_key_mode:1 in the
sm.ini file.
Caution: For upgrades from Service Manager 7.11, 9.30, or 9.31, make sure the primary key
mode is disabled before upgrading from the Service Manager 7.11, 9.30, or 9.31 applications;
for new installations of Service Manager, make sure that primary key mode is disabled before
loading the out-of-the-box application data.

Caution: If you plan to apply Process Designer Content Pack 9.30.2 or 9.30.3 on top of the
SM9.32 applications, make sure primary key mode is disabled before applying the content
pack; otherwise the content pack installation will fail.
HP does not recommend enabling primary key mode unless you have already Process
Designer Change Management and Help Desk implemented.
You can also see if primary key mode is enabled in Service Manager by running the following script
in Script Library:
var retValue;
retValue = system.functions.sysinfo_get ("PKMode" );
print ( "Current value of PKMode is " + retValue );

This will return one of the following messages:
l

"Current value of PKMode is true", which indicates primary key mode is enabled.

l

"Current value of PKMode is false", which indicates primary key mode is disabled.

For more information, see the following topic in the online help:
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l

Parameter: primary_key_mode

Unique Key Conversion and Modification
The sm -system_addconstraint server command adds a Not Null constraint to the first unique
key or converts the first unique key to a primary key for the specified database tables, depending on
usage.
Caution: An attempt to revert from a primary key to a unique key may cause unpredictable
results.

Caution: HP does not recommend running the command without any tables specified;
otherwise the system will try to add primary keys or "Not Null" constraints to all tables.
Instead, you should run the command on demand. For example, for the out-of-the-box system,
HP recommends that you run the following command to improve system performance:
sm -system_
addconstraint:probsummary,incidents,screlation,cm3r,cm3t,schedule,device,ope
rator,contacts,cirelationship:0
For more information, see the following topics in the online help:
l

Parameter: system_addconstraint

l

Modify keys: Convert the first unique key to primary key

l

Modify keys: Add "Not Null" constraints to the first unique key in a table

Limitations and Considerations
When using this feature, be aware of a number of limitations and considerations. For more
information, see the following topic in the online help:
l

Working with primary keys

IPv4/IPv6 Dual Network Support
As of version 9.32, Service Manager supports IPv4/IPv6 as a dual stack network. This addresses
the needs of being able to run Service Manager infrastructure in an organization where both IPv4
and IPv6 are enabled in parallel.
Most Service Manager components support IPv6 from Service Manager 9.32, except for the
following legacy features which still support only IPv4:

HP Service Manager (9.32)
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l

HP Service Manager Open Database Connectivity (ODBC) Driver

l

HP ServiceCenter Automate (SCAuto) Software Development Kit (SDK)

Note: In a dual stack network, the required IPv4 configuration is the same as before.
For more information about supported IPv6 address formats and required IPv6 configuration for the
Service Manager server, clients (Windows, web, SRC, and Mobility), integrations (KM search
engine, LDAP, and SMTP), see the topics in the following section in the online help:
System Administration > Configuring installation and setup options > IPv6 overview

l

Common Access Card (CAC) Sign-On
As of version 9.32, the Service Manager web client supports Common Access Card (CAC) sign-on.
CAC sign-on enables users to log in to the web client directly with a smart card that stores a valid
user certificate. Users only need to enter a card PIN, instead of a user name and password.
During CAC sign-on, Service Manager web tier gets access to the user authentication public
certificate and its counterpart private key through the underlying client crypto architecture. In other
words, Service Manager does not directly communicate with the card reader. Technically, Service
Manager supports any smart cards that store an X.509 user authentication certificate and are
designed to work with smart card middleware (such as ActivClient) that is installed on the user's
computer.
Note:
l

Once enabled, CAC sign-on is enforced for all web client users. Standard login using a
username and password is no longer possible.

l

The Windows client does not support CAC sign-on. It supports the same sign-on modes as
in previous versions.

l

Once CAC sign-on is enabled on the SM server, two-way SSL must be configured between
the SM server and all clients (Windows, web, Mobility, SRC, and web service integrations),
and between the web server or web application server and user's browser.

For more information, see the following help topics:
l

Common Access Card (CAC) sign-on
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l

Requirements for CAC sign-on

l

Example: enabling CAC sign-on

FIPS 140-2 Compliance
As of version 9.32, Service Manager is FIPS 140-2 (level 1) compliant. FIPS (Federal Information
Processing Standards) are a set of standards that describe document processing, encryption
algorithms and other information technology standards. The FIPS 140-2 standard, “Security
Requirements for Cryptographic Modules,” specifies the security requirements for cryptographic
modules utilized within a security system that protects sensitive or valuable data.
About FIPS Mode
Service Manager can run in either of these modes: FIPs mode (FIPS 140-2 compliant mode), and
standard mode (non-FIPS mode). The FIPS compliance is achieved through the use of FIPS 140-2
validated cryptographic modules (the OpenSSL FIPS Object Module in the server, and the RSA
BSAFE Crypto-J module in the Windows and web clients).
Note: By default, Service Manager runs in non-FIPS mode, and uses the same data encryption
algorithm (64-bit DES) as in previous versions.

l

FIPS mode requires the database to upgrade to the 256-bit AES data encryption algorithm. You
need to run the sm -upgradeencralg command to do so. This upgrade is irreversible and
therefore you need to back up your database before the upgrade.

l

In a horizontal scaling environment, all server nodes must run in the same mode (either FIPS
mode or non-FIPS mode).

l

Once you have enabled FIPS mode in the server (by specifying fipsmode:1 in sm.ini), you
must configure all clients (Windows, web, Mobility and SRC) to run in FIPS mode, otherwise
they cannot connect to the server.

l

The Lightweight Single Sign-On (LW-SSO) framework is not FIPS compliant; however, LWSSO still works well when Service Manager has FIPS mode enabled.

Warning on AES Algorithm Upgrade
Enabling FIPS mode requires the 256-bit AES encryption algorithm. This means a greater field
length is required to save the encrypted data. This algorithm change will affect all encrypted fields
including your custom ones. To ensure a smooth upgrade to the AES algorithm, before the AES
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upgrade, you must double-check the lengths of all encrypted fields and ensure the lengths are
enough to save AES-256 encrypted data.
Use the following formula to determine a safe length for an AES encrypted field (in bytes):
Safe_Length=32 + 2 * source_string_length

Where: source_string_length is the length of the source string (for example, if you enter an 8character password, the source string length is 8 bytes). The safe length is no less than the actual
length of the encrypted field, which is several times the length of 32 bytes.
For example, if you have an encrypted field with a source string of 10 bytes, then the safe length for
the AES-256 encryption will be 32+2*10=52 bytes. You can add a buffer length based on your
business needs, and then increase the field length properly.
Sample Script to Scan Your Encrypted Fields
You can find a sample script to get all encrypted fields in your system in this HP knowledge base
article:
http://h20230.www2.hp.com/selfsolve/document/KM00490597
For information on how to enable FIPS mode in Service Manager, SRC, and the Mobility client, see
the following documents:
l

Service Manager 9.32 help:
n FIPS mode
n

Configure FIPS mode in Service Manager

l

Service Request Catalog 9.32 Customization Guide

l

Service Request Catalog 9.32 Interactive Installation Guide

l

Service Manager 9.32 Mobile Applications User Guide

HTML Email Solution
The HTML Email solution, which was previously released as a stand-alone content pack on HP
Live Network, has been merged into Service Manager 9.32. You can now directly configure and set
up the solution from Tailoring > Notifications.
This solution is intended for system administrators who manage Service Manager notifications or
email setup, and for engineers who send HTML emails to notify users. The solution provides an outof-box set of email notification definitions and HTML templates that supports most common
notification scenarios in three Service Manager applications: Service Desk, Change Management,
and Incident Management.
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You can use these notification definitions and HTML templates as a basis for customizing your
notifications. You can also create your own notifications and templates for other Service Manager
applications.
For details, see the topics in the following section in the online help
l

System Administration > Status and Notifications > HTML Email.

Survey Integration Solution
The Survey Integration solution, which was previously released as a stand-alone content pack on
HP Live Network, has been merged into Service Manager 9.32. You can now directly configure and
set up the solution from Tailoring > Integration Manager.
The Survey Integration enables you to integrate your Service Manager installation with third-party
survey solutions. The integration provides you with two integration methods: an API-based
connector that uploads data directly to the survey solution (enabling you to manage the survey
directly through Service Manager) and a URL-based connector that sends survey request emails
containing a survey-specific URL to intended survey-takers.
For more information, see the following section in the online help:
l

System Administration > Integrations > Survey Integration

Service Manager Doctor (SM Doctor)
As of version 9.32, the Service Manager server provides an embedded troubleshooting tool, SM
Doctor. You can find a folder named smdoctor directly under the server installation directory. This
folder contains all files required for running this tool.
SM Doctor enables support engineers to collect configuration and diagnosis data from Service
Manager. This tool eliminates the need of excessive exchanges of emails between support
engineers and customers before engineers can have all needed information to analyze a reported
incident.
This tool collects these types of information:
l

SM server configurations and reports

l

Operating system configurations

l

Database configurations on the database server

l

SM server logs

HP Service Manager (9.32)
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l

List of files in the <SM server>/RUN, <SM server>/RUN/lib/endorsed, and <SM server
>/RUN/lib folders.

l

Additional configurable data collected by third-party tools, such as supportTool.sh and
generateSchema.sql.

For more information, see the topics in the following section in the online help:
l

Guides and reference > Troubleshooting > HP Service Manager Doctor.

Enhanced Inactivity Timer Mechanism
Service Manager 9.32 has enhanced the inactivity timer mechanism so that administrators can set
up an inactivity timer for a specific operator; this enhancement also improves performance by
eliminating the use of the inactive.startup background process.
Note: Before you can use the enhanced mechanism, be sure to restart the inactivity timer as
described in the "Inactivity timer" help topic.
Backward Compatibility
This release is also compatible with the old mechanism. If you use an applications version earlier
than 9.32, Service Manager will use the old mechanism, even if you have upgraded to the SM 9.32
server and web client.
Operator Level Settings
Administrators can now configure the inactivity timer settings for a specific operator, by specifying
the Warning Time and Allowed Inactive Time fields on the Security tab of the operator record.
Operator level settings take precedence over system level settings specified in the Start Inactivity
Timer form.
Obsolescence of the inactive.startup Process
This enhancement eliminates the need to use the inactive.startup background process. HP
recommends that you delete this process to save your system resources.
Usability Improvements
This enhancement also includes usability improvements described in the following table.
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Improvement

Previous Behavior

Adding validation against the idletime and

In previous versions, this validation is not

warntime fields on the inactivity timer setting

available.

form
Renaming the Reset Inact button to Save,

In previous versions, the Reset Inact button

which is now always displayed in the form

displays only when the inactivity timer is
running.

Keeping the user staying with the inactivity

In previous versions, the page is closed

timer settings page after the user clicks Start or

immediately after the user clicks either button.

Save
For more information, see the following topic in the online help:
l

Inactivity timer

Updated Web Tier Directory Structure
In Service Manager 9.32, the directory structure of the Web tier has been modified such that the SM
build number is included in the URL. These changes were implemented because occasionally,
upon web tier upgrade, resources cached in the user's browser would be incompatible with those in
the new web client. When such incompatibility exists, asking all end users to clear their browser
cache is not practical. With this revised implementation, users will no longer need to clear their
browser cache.
Note: MySM does not use the new versioning URL syntax. If any changes are made to MySM
via a future patch or hotfix, MySM users need to clear their cache when the web tier is
upgraded with that fix. For SM 9.32, there is no change to MySM when compared to 9.30 or
9.31 or any of the associated patches.
Additionally, the default cache time (maximum age value in the application-context.xml file) is
changed from 8 hours (28800 seconds) to 6 months (15552000 seconds) to better utilize browser
cache.
For more information, see whitepaper Updates to the Service Manager Web Tier Directory
Structure shipped with the 9.32 release.
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Usability Improvements
Service Manager 9.32 includes the following usability improvements. Most of the features are only
available in the web client.
Single-Click on Navigator (Web Client Only)
You can now single-click nodes in the System Navigator, instead of double-clicking. The feature
behaves in the following manner:
1. If you single-click or double-click on the folder, the entries below the clicked node expand or
collapse.

Note: This is the same behavior that occurs when you click the arrow.

2. If you single- or double-click on an individual menu item, or a node that represents a view, the
detail is displayed on the right panel.

Note: There is no change in behavior under "Manage Favorites".

Hover Window Indicator (Web Client Only)
When viewing the details of a record, a gray info icon ( ) has been added to the Comfill component
to indicate the field can display additional information in a hover window.
Close Button on Inactive Tabs (Web Client Only)
A Close button ( ) now displays on both active and inactive tabs. You can directly close an
inactive tab by clicking the Close button if the Close operation does not return a confirmation
message. If the Close operation returns a confirmation message, the tab becomes active.
Note: The Close button never displays on the first tab.
Quick Ticket Search Using the Search Line (Web Client Only)
A Quick Ticket Search feature has been added to the toolbar section of the Service Manager
graphic user interface. When enabled, this feature works as follows:
l

For users who have access to the Service Manager command line, a new icon (displayed as
either
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new Quick Ticket Search feature.
l

For users who have no command line access, a search line box is available.

This feature enables users to enter a record ID in the search line field, which opens the record
directly when executed.
By default, this feature is disabled. To enable it, you, as a system administrator, must select the
Enable Universal Search option in the System Information Record.
Notes:
l

This feature in available only in the standard index.do web client.

l

Out of the box, the search line only supports searches by record ID (with ID prefix) for the
following record types : SD (interactions), C (change), IM (incidents), and CI (configuration
items). You can enable more record types for quick search. To configure a record type for quick
search, you, as an administrator should add the record type and prefix in global list: 'UniSearch
Types' and start lister process in System Status; if no prefix matches the input query string, SM
will search for the configuration item (in the device table) with that ID number.

l

To enable a record type for quick search, the profile for the record type should have a field with
type of "tableaccess" and the view access must be set to true; if no view access is defined,
records of this type will not be available for quick search.

l

This feature requires both your Applications and web client to upgrade to version 9.32; if you only
upgrade the web client, the command line behavior will remain the same as before.

For details, see the following topics in the online help:
l

Activate the command/search line toggle button

l

Search for a record using the Search line

l

Adding prefix for a record type

Quick Jump in Record Detail Forms (Web Client Only)
End users can now use a drop-down list, next to the More button, to quickly jump to the desired
section of a record’s detail format. This feature allows quick access to important sections of the
record, which prevents tedious mouse scrolling.
The drop-down list includes the names of all visible groups designed within the Group and Notebook
controls if the following control properties are set:
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l

Group control: "Collapse enabled" and "Floating group enabled" are set as "true".

l

Notebook control: "Group rendering enabled" is set as "true"; or in Process Designer, "Preferred
notebook style" is set as "Groups".

Users can use the ALT+J keyboard shortcut to move the focus to the drop-down list, and to expand
or collapse the drop-down list.
List State Persistence (Web Client Only)
The list-detail page of a record can now retain the expand-collapse state of the List Pane in each tab
within the user’s current session. When the list is collapsed it allows a larger portion of the record’s
detail to be displayed, which prevents tedious and unnecessary mouse scrolling.
You can enable or disable this behavior by configuring the enableListFrameStateRetain
parameter in the web.xml file.
Note: In the list detail page, you can now use the Alt+U keyboard shortcut to expand or
collapse the List Pane. The key combination is configurable.
Merge Conflicted Updates (Window and Web Clients)
When there are concurrent updates from a user and background processes, the user can now
merge the conflicted updates and save the merged result of a record without the need to abandon
the current updates.
l

If different fields in the record are updated simultaneously, the system merges the updated fields
automatically when the user tries to save the updates.

l

If the same fields in the record are updated concurrently, the user is able to manually merge the
conflicted updates when trying to save the updates.

Administrators can now disable the superfluous pop-up window for reloading the latest record when
users starts to edit a record. An option Disable the Pop-up Window to Reload Records is
available in the System Information Record. It is unchecked by default.
The Merge Conflicted Updates feature is out of the box for HP Service Manager 9.32 default user
operations. However, to apply this feature to a record with customized operations, you need to first
tailor your customized operations.
For more information, see the following topics in the online help:
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l

Editing records

l

Enable the Merge Conflicted Updates function for customized user operations

New Keyboard Shortcuts (Web Client Only)
This release of the web client supports the following new keyboard shortcuts:
l

CTRL+ALT+T: Closes the current active tab.

l

CTRL+ALT+H: Moves the focus to the header of the current active tab.

Only the header of an active tab can be focused. When the focus is on the header of an active tab,
you can use Left/Right Arrows to switch to other tabs.
Sending Notifications to Specified Operators (Web Client Only)
You can now tailor Service Manager to notify specified operators by a pop-up notification in the Web
client. For example, you can send notifications to specified operators when an Incident ticket is
created or updated.
Note: In the Windows client, the notification does not pop up, but appears in the message log;
in addition, the notification will not be sent to offline operators.
For more information about the tailoring process, see the following topic in the online help:
l

Example: Notifying specified operators upon an incident update

New JavaScript Methods/Functions, RAD
Functions, and System Parameters
Service Manager 9.32 includes the following new or updated items. Unless otherwise noted, they
have been added or updated in Service Manager 9.32.
For details, see the Service Manager 9.32 Programming Guide or the System Configuration
Parameters section in the online help.
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JavaScript Method
JavaScript method

Description

SCFile.setBinary()

This method saves binary data to a field in a Service Manager file object.
Note: Introduced since SM9.31 patch 1.

JavaScript Function
The following JavaScript function was introduced in this release.
JavaScript
function

Description

skipApproval

A JavaScript function that allows you to prevent an item's approval status
from being reset to "pending."

removeTemplate A JavaScript function that removes / restores the relationship between
restoreTemplate

operator records and their associated template.
Note: These functions are not documented in the Programing Guide. See
"New JS Functions to Remove or Restore Templates for Operator
Records" below instead.

New JS Functions to Remove or Restore Templates for Operator Records
If an operator record uses a template, some fields of the operator record do not store the values in
the operator record itself. Instead, these values are stored in the template operator record. When a
query is made to an operator record using such fields, Service Manager needs to query all the
records and merge the data in the server. The performance associated with this operation can be
slow. For more information about this issue, refer to defect QCCR1E91526.
To avoid this performance issue, this release introduces two new JS functions. These functions
can check for the existence of these types of operator records, and then populate the relevant
values from the template operator into the related operator records, or vice versa.
These two new JS functions are added to the out-of-the-box JavaScript library in package
BaseUtilities:
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l

lib.TemplateUtil.removeTemplate ()

This JS function removes the relationship between records and their associated template.
l

lib.TemplateUtil.restoreTemplate ()

This JS function restores the relationship that has been removed by the
lib.TemplateUtil.removeTemplate () function.
To support these new JS functions, two new underlying rtecall functions templateremove and
templaterestore are also added.
Caution: The rtecall functions templateremove and templaterestore can remove or restore
templates for any tables in Service Manager. Be cautious when changing your data by using
these two rtecall functions in your tailoring.
To remove or restore templates for records by using the new JS functions, follow these steps:
1. Add a new field ("systemplatebak") for the file that associates with the performance issue:
a. Log on to the Service Manager Windows client as a system administrator.
b. Click Tailoring > Database Dictionary, enter the name of the file that you want to modify,
such as "operator", and then click Search.
c. Click "descriptor", and then click New Field/Key.
d. In the popup window, enter the name as "systemplatebak", select the type as character,
and then the click Add.
The new field is added and the popup window closes.
e. Double-click the newly added "systemplatebak" field, and then set the following fields in
the popup window.
SQL Name: SYSTEMPLATEBAK
SQL Type: VARCHAR(60)
SQL Table: m1
f. Click OK. The dialog window closes.
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g. Click OK on the dbdcit window. The "alter table" window displays.
h. Click SM Alters.
2. Modify and run the Java script to remove or restore templates for the file that you specified:
a. Click Tailoring > Script Library.
b. In the Name field, enter "TemplateUtil", and then click Search.
c. Uncomment one of the last two lines:
//removeTemplate('operator');
//restoreTemplate('operator');

d. Change operator (<filename>) to the name of the file that you want to modify.
e. Click Save, Compile, and then Execute.

RAD Functions
RAD function

Description

datecmp

A RAD function that translates the date/time fields to the correct SQL
statement dialect. You can use this function in expert search of incidents, as
well as in JavaScript programming.
Note: Introduced since SM9.31 patch 1.

filequeryex

A RAD function that returns the query parameters of a file variable.

isExpressionValid A RAD function that determines if a RAD expression is a valid expression of
a specified data type.
rtecall

A RAD function that returns an array containing the primary key values for a

("getprimary")

current record. The keys can later be used to retrieve the record using the
rtecall("getrecord") function. This function can only be used against tables
that have a primary key. Otherwise, error code 2 is returned.

rtecall

A RAD function that returns an array containing the Unique key values for a

("getunique")

current record. The keys can later be used to retrieve the record using the
rtecall("getrecord") function.
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RAD function

Description

sysinfo.get

A RAD function that returns the primary key mode for the system.

("PKMode")
updatestatus

A RAD function that returns the result of the last update operation on a
Service Manager file.

System Parameters
The following table lists, in alphabetical order, parameters that have been added or updated in the
SM9.32 release.
Parameter

State

Description

agstackl

Updated This parameter defines the length of the stack the HP
Service Manager server allocates to run RAD
applications.
Note: The default has been changed from 400 to
600.

CAClogin

New

Enabling this parameter causes the Web client to
present a Common Access Card (CAC) certificate as
authentication information and use SSL connections to
the Web tier.
Default: false (Disable)

cacsignon

New

This parameter defines whether trusted clients can log
on to the Service Manager server with a Common
Access Card (CAC), without entering log-on
information. When this parameter is enabled, Service
Manager allows trusted clients to bypass the Service
Manager log-on screen and directly log in with a valid
certificate stored in a CAC.
Default: 0 (Disable)
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Parameter

State

Description

changeencrkey

New

This parameter defines the encryption key for
encrypting fields in the database. The value of this
parameter must be either 8 characters (64 bits) long in
non-FIPS mode or 32 characters (256 bits) long in
FIPS mode, and consist of alphanumeric characters.
Note: The parameter has been updated to support
encryption keys that are either 8 (default) and 32
characters long.

debugrest

New

This parameter enables the HP Service Manager
server to write detailed log trace for RESTful web
services diagnostics.
Default: 0 (Disable)

dao_sessiontimeout

New

This parameter specifies the seconds the Service
Manager server to wait before terminating RESTful
threads. Unless the client sends subsequent requests
within the timeout, the Service Manager server will
recycle the session for re-use and re-allocate it on
demand.
Default: 0 (Disable)

dao_threadsperprocess

Updated This parameter specifies the maximum number of
threads allowed to run concurrently in the process for a
RESTful Web Service application.
Note: The default has been changed from 5 to 10.

disableloginautocomplete

Updated This parameter allows administrators to enable
password auto-complete for the SM web client login
page.
Note: The default has been changed from false
to true.
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Parameter

State

Description

disableJumpAddress

New

This parameter controls if the Quick Jump component
displays in a record detail form (for example, the
Change Detail form). The Quick Jump component
enables you to navigate to a group section quickly.
Default: false (Enable the Quick Jump component)

enableExitConfirmMessage

New

If this parameter is enabled (set to "true"), when the
user clicks the Close ("x") button of the SM web client
page or manually refreshes the entire web client page,
a confirmation message displays that indicates the
user might have unsaved data and asks the user to
confirm whether to stay on the current page or leave
the page.
Default: false (Disable)

encryptionkey

Updated This parameter defines the encryption key for
encrypting fields in the database. The value of this
parameter must be either 8 characters (64 bits) long in
non-FIPS mode or 32 characters (256 bits) long in
FIPS mode, and consist of alphanumeric characters.
Note: The parameter has been updated to support
encryption keys that are either 8 (default) and 32
characters long.

enableListFrameStateRetain New

This parameter enables the list detail page to retain the
expand-collapse state of the List Pane when the list
detail page refreshes. If you set this parameter to
false, the List Pane is always in expanded state once
the list detail page refreshes.
Default: false (Disable)

external_lb

New

Must be set to "1" in the sm.ini file when the Service
Manager server uses an external hardware load
balancer (default:0).
Default: 0 (Disable)
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Parameter

State

Description

externalLB

New

Must be set to "1" in the web tier's web.xml file when
the Service Manager server uses an external hardware
load balancer (default: false)
Default: 0 (Disable)

fipsmode

New

This parameter determines if the Service Manager
server runs in FIPS 140-2 compliant mode ("FIPS
mode").
Default: 0 (Disable)

ir_sql_limit

Updated This parameter determines the maximum number of
records to be fetched from the RDBMS in a combined
IR and SQL query.
Note: In this release, support of value "0" has
been added: ir_sql_limit:0 means there is no
limit.

JCEProviderClassName

New

This parameter specifies the class name of a FIPScertified third-party Java Cryptography Extension
(JCE) provider (for example, RSA BSAFE) that you
plug in when configuring FIPS mode in the web client.
Default: None

JCEProviderName

New

This parameter specifies the name of a FIPS-certified
third-party Java Cryptography Extension (JCE)
provider (for example, RSA BSAFE) that you plug in
when configuring FIPS mode in the web client.
Default: None

primary_key_mode

New

This parameter specifies whether Service Manager is
in primary key mode or not.
Default: 0 (Disable)
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Parameter

State

Description

showNavIcon

New

If this parameter is set to true, each System Navigator
menu item will display an icon that indicates the type
of menu item. If the parameter is set to false or not
present, the navigator menu items do not display
icons.
Default: false

system_addconstraint

New

This parameter can only be used from an OS
command line. It adds a Not Null constraint to the first
unique key or converts the unique key to a primary key
for the specified database tables, depending on usage.
Default: 0 (By default, this parameter adds only a "Not
Null" constraint on the first unique key on all files in the
system.)

tracememerror

New

This parameter specifies whether to print memory
trace information in the sm.log file and generate
coredump when the memory is handled incorrectly.
Default: 0 (Disable)

upgradeencralg

New

This parameter upgrades the database encryption
algorithm from DES to AES by updating all encrypted
fields with a new 256-bit key.
Default: xxxxxxxxxxxxxxxxxxxxxxxx

usedmemcompmode

New

This parameter determines the method for calculating
memory usage.
Default: 0 (Specifies that used memory will be the sum
of committed memory plus the reserved memory)
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The following table lists, in alphabetical order, parameters that have been added or updated in
SM9.31 patch releases.
Parameter
acceptsharedcert

Description
Note: Introduced since SM9.31 patch 2.
This parameter defines how the HP Service Manager server handles
signed SSL certificates from incoming client requests in a Trusted
Sign-On configuration.
When the parameter is enabled (acceptsharedcert:1), the Service
Manager server allows Trusted Sign-On connections using a socalled "shared certificate."
Default: 0 (Disable)

emailout

Note: Updated since SM9.31 patch 2.
Prior to SM9.32p2, there are N+1 "EMAILOUT" threads in System
Status and the logged-in users are counted as N+1; as of SM9.32p2,
there is only one "EMAILOUT" thread and the logged-in users are
counted as 1.
Default: None

KMSearchEngineTimeout

Note: Introduced since SM9.31 patch 2.
This parameter defines a timeout value in seconds for all Knowledge
Management search server hosts (including indexing hosts, search
hosts, and load balancer hosts).
This parameter is used to prevent overloaded KM search servers
from causing Service Manager to hang.
Default: 20 (seconds)
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Parameter

Description

maxloginspercluster

Note: Introduced since SM9.31 patch 2.
In a horizontal scaling implementation, Max Logins for operators is
enforced at the cluster level. This parameter allows administrators to
turn off this feature.
Default: 1 (Enable)

onewayssl4ws

Note: Introduced since SM9.31 patch 2.
This parameter provides the option to use one-way/anonymous SSL
for web services clients in a Trusted Sign-On (TSO) or Common
Access Card (CAC) configuration. When enabled, this parameter
allows web services clients to access SM SOAP interfaces without
a certificate.
Default: 0 (Disable)

Deprecations
Deprecations in This Release
As of this release, the following items are deprecated:
Item Name

Type

Notes

unmaskDeferMillis

Web

In previous releases, this parameter defers the unmasking of

parameter

a browser window after an unmask request is issued. It

(in the

relates to how much time the client browser needs to finish

web.xml

rendering after a page is loaded.

file)
inactive.startup

Background In previous releases, you need to start this process to run the
process (in

Inactivity Timer . As of this release, the Inactivity Timer no

System

longer needs it.

Status)

HP Service Manager (9.32)

Page 39 of 229

Release Notes
What's New in This Release

Future Deprecations
Item Name

Notes

ServiceCenter In a Service Manager 9.3x Windows/web client, the default starting page is a To
classic style

Do Queue for the user logged in, which is different from that in ServiceCenter

starting page

6.2. The new starting page is more intuitive, clean and simplified and thus has
gained much better user experience. HP recommends that all customers
leverage the new modern UI design, and stop using the ServiceCenter classic
style starting page. The ServiceCenter classic style starting page will be
deprecated in the future.

Certifications
This release includes the following new certifications:

Service Manager Server
l

F5 hardware load balancers

l

DB2 10.1 (for non-HP-UX platforms)

l

Windows Server 2012

l

Microsoft Hyper-V 2012

Windows Client
l

Windows 8

Web Client
l

Internet Explorer 10

Mobility Client
l

Tomcat 7.0 (7.0.32 or greater)

l

iOS 6.x
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l

Android 4.x

l

BlackBerry 10.0, 7.0, 6.x

Service Request Catalog
l

Internet Explorer 10

l

Firefox 17 or greater (Extended Support Releases)

Knowledge Management Search Engine
l

Windows Server 2012

Documentation Enhancements
The Service Manager 9.32 online help and manuals (in PDF format) are available from the HP
Software Manuals Site at:
http://h20230.www2.hp.com/selfsolve/manuals
The Service Manager online help has been extensively redesigned, to make it easier for end users
to find tasks that are relevant to their roles in Service Manager. This has been done in accordance
with the Service Manager Processes and Best Practice Guide, which describes how Service
Manager aligns to ITIL processes. Enhancements include:
l

Pages for the primary user roles, inclusive of links to their various ITIL tasks. For example, a
Problem Manager can find all the ITIL–related tasks that are applicable to his role under the
Problem Management > Problem Management user roles > Problem Manager page.

l

Graphs have been added to the ITIL tasks to show how the ITIL defined-processes are
supposed to work, and show users how their particular tasks fit in.

l

Administrative tasks for individual ITIL modules and processes have been separated. Module
administrators who want to find out how to modify the background processes or configure a
module in general can look here.

Additional Changes
l

The Service Manager landing page was re-designed to make it cleaner and easier to navigate.
Mini-landing pages were also created throughout the Help Center.
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l

A new “Navigate the Documentation” page was created, which details, in one location, every
supplemental PDF manual.

l

A new section for system administrators was created, and all system level-specific information,
such as Application Setup and Database Administration, was placed under this section.

l

A new “Guides and reference” section was created to house the troubleshooting sections and
parameter information and guides. In addition, the following guides were converted from PDFonly versions, and placed in this section. The content of these guides is indexed and searchable
from the Service Manager online help.
n

Tailoring Best Practices Guide

n

Programming Guide

n

Document Engine Guide

n

Web Services Guide (includes the documentation for the new REST API)

n

Wizards Guide

New Feature Videos
Finally, a number of New Features videos were created to better illustrate the improvements in
Service Manager 9.32. We have created videos to highlight the following features:
l

What's New Overview

l

Survey Integration

l

Process Designer Help Desk (Content Pack)

l

Web Client Usability Enhancements (Parts I and II)

l

Mobility

l

Cross-Table Query

l

SRC 9.32

l

RESTful API

You can find these videos under the Service Manager section on the HP Live Network as well as on
YouTube:
https://hpln.hp.com/
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Open Source and Third-Party Redistributables
Package
In this release, the web tier package and each of the server packages contain a compressed file,
sm9.32.0016_Redistributables.zip. This zip file contains all open-source and third-party source
code used in this release, as well as their associated license agreement files.
Note: The content of this .zip file is an updated version of that in the Redistributables folder
on the Service Manager 9.30 installation media.
For a complete list of open source and third-party acknowledgments, see the Service Manager 9.32
Open Source and Third-Party Software License Agreements manual (in PDF format), which is
available from the HP Software Manuals Site:
http://h20230.www2.hp.com/selfsolve/manuals
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Enhancements
This release includes the following enhancement type fixes.

Applications
CR

Problem

Solution

QCCR1E21846

Enhance Virtual Join to take advantage of the

l

sort.fields array in the link file. This would allow

Now the default sort field and sort order can
be defined in the link file for subviews.

for Virtual Join record lists to be returned in the
specified order.

l

The default sort field and sort order are
always defined in the first line if there are
multiple links defined for a field.

Note: To take advantage of this fix, you need to
upgrade both the server and applications to this
release level.

HP Service Manager (9.32)
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CR

Problem

Solution

QCCR1E32251

There is no mechanism to track failed

The information is now written into the syslog

authentications caused by invalid login names

file if there is a failed authentication attempt with

(not just invalid passwords). The login process

either an invalid login name or an invalid

currently updates an operator record when there

password.

is a failed authentication attempt (a valid
username with an invalid password). However,
nothing is recorded when a login attempt fails
due to an invalid username.
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Enhancements

CR

Problem

Solution

QCCR1E55614

Templates do not provide the option to populate

Now, users can plan an array of structure field

structured arrays. Fields that were mapped to a

using the Set Expected State feature in the

BLOB-type field (the structured array type in

Change Management Module. The "Set the

ServiceCenter) in Oracle in ServiceCenter 6.2

expected state of a configuration item" feature

were available in the data policy record in

has been enhanced as follows:

ServiceCenter 6.2. However, those same fields
that are mapped as BLOBs (the structured array
in Service Manager 7.x) do not appear in the
data policy record in Service Manager 7.11.

l

Added support for array of structure
fields planning
n

When picking an attribute from the value
list, the datatype is evaluated so that the
appropriate control can be displayed.

n

Structure member fields are now
displayed in attribute drop-down list.
Because they are not in datadict, the field
name from dbdict is used and structure
members are treated like array fields,
reflecting the way the dataModEvent table
stores it.

n

The Append to current value checkbox
has been added to support complex data
types. You can choose whether to append
or overwrite with the new values.

n

While planning new values, you can have
a preview of the current field values for all

HP Service Manager (9.32)
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Enhancements

CR

Problem

Solution
affected CIs.
n

The Set to Null checkbox has been
added so that you can set field back to
null. This checkbox is only available for
fields that are not defined as mandatory on
datadict and not for dbdict's unique or "no
null" keys.

l

Fixed some other minor functionality
issues to provide better user experience
n

The Set Expected State wizard can be
started only if at least one Affected CI has
been specified.

n

The out-of-box "edit mode" (to load already
planned changes into the wizard) is now
working.

For details, see the following help topics:
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l

Set the expected state of a configuration item

l

Example: How to plan an array of structure
field
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Enhancements

CR

Problem

Solution

QCCR1E55885

Enhancement Request to have the Service

Primary keys and "Not Null" constraints on

Manager application provide the ability to

unique keys are now supported.

change DBDICT unique keys to primary keys in
the RDBMS, if required.
QCCR1E60939

For more information, see "Support of Primary
Keys and Not Null Constraints" on page 17.

Building global lists may cause poor

The build.list application was improved so that it

performance in the following situations:

retrieves only specific columns rather than all
columns. In addition, the global list for the inbox,

l

User login

l

Creating the inbox (on the scm.advanced

which caused additional processing, was
removed.

screen)
l

QCCR1E75417

The lister process rebuilding global lists

HP Service Manager users are timed out after a

Administrators now can set an inactivity timer

specified period of inactivity. This is problematic

for a specific operator (operator record >

when users need to search a long time for

Security tab > Inactive Timer Settings

information related to the work they are doing in

(minutes)).

SM. There should be a mechanism that allows
individual users to have an inactivity timer
specified in their operator record.

Note: This feature requires you to upgrade your
SM server, applications, and clients to this
release level.
See also "Enhanced Inactivity Timer
Mechanism" on page 24.
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Enhancements

CR

Problem

Solution

QCCR1E89360

The following procedure is recommended to

Applying SM9.32 after PD CP4 will solve the

install PDCP2 correctly:

conflicts automatically without the need to load
the merge unload file manually.

1. Install PD CP2
2. Apply SM9.31 applications
3. Load QCCR1E78589_SM931_PD2.unl
However, this procedure causes the
objects in the unload file to overwrite any
tailored versions of those objects.
QCCR1E89901

An easy and configurable method is needed to

The Quick Ticket Search feature has been

access records in the Web client.

implemented to allow users quickly open a
record from a search line box.
See also "Quick Ticket Search Using the
Search Line (Web Client Only)" on page 26.
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CR

Problem

Solution

QCCR1E90039

It takes three different WSDL calls to create

A new API

each ticket for an integration, which causes

(CreateSRCInteractionViaOneStepRequest) in

significant performance issues when the volume ServiceCatalogAPI enables you to open a
of tickets is large (for example, batch jobs could

service request in one single call. It

dump thousands of tickets per minute).

accomplishes the same work of the following
three API calls used by Service Request
Catalog:
l

CreateCart

l

AddItemToCartViaOrder

l

CreateSRCInteraction

This new API creates a cart, add one or more
items to the cart, submits the cart, and then
creates the corresponding interaction in Service
Manager. Its usage is not limited to Service
Request Catalog.

HP Service Manager (9.32)

l

Service Name: ServiceCatalogAPI

l

Name: svcCatAddSubmitItem

l

Object Name: SRCInteractionViaOneStep

l

Allowed actions: CreateRequest

l

Action Names: Create
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CR

Problem

Solution
l

Action Type: Application Pass Through

l

Custom action to perform: Service Catalog Dispatcher

Note:
l

This API adds a new table:
svcCatAddSubmitItem.

l

New ScAPI_svcCatRequestOneStep
ScriptLibrary function was added to
implement the basic logic.

QCCR1E90300

When you try to save (to release lock) a record

When you try to save a record that has been

that has been already modified by another

already modified by another thread, the data that

thread (for example, by a background process),

you entered is not lost.

the data that you entered is lost when the
"Record has been modified since read"
message appears.
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Server
CR

Problem

Solution

QCCR1E21846

Enhance Virtual Join to take advantage of the

l

sort.fields array in the link file. This would allow

Now the default sort field and sort order can
be defined in the link file for subviews.

for Virtual Join record lists to be returned in the
specified order.

l

The default sort field and sort order are
always defined in the first line if there are
multiple links defined for a field.

Note: To take advantage of this fix, you need to
upgrade both the server and applications to this
release level.
QCCR1E55885

Enhancement Request to have the Service

Primary keys and "Not Null" constraints on

Manager application provide the ability to

unique keys are now supported.

change DBDICT unique keys to primary keys in
the RDBMS, if required.
QCCR1E62952

For more information, see "Support of Primary
Keys and Not Null Constraints" on page 17.

Support of hardware load balancers (F5) is

Service Manager now provides full support for

required to replace sm -loadbalancer.

F5 hardware load balancers.
For more information, see "Support of F5
Hardware Load Balancers" on page 15.
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Enhancements

CR

Problem

Solution

QCCR1E75417

Service Manager user sessions are timed out

See applications fix "QCCR1E75417" on page

after a specified period of inactivity. This is

48.

problematic when users need to search a long
time for information related to the work they are
doing in SM. There should be a mechanism that
allows individual users to have an inactivity
timer specified in their operator record.
QCCR1E77118

JGroups processes get shunned.

JGroups has been upgraded to version 3.2,
which is the latest stable version.

QCCR1E77350

Service Manager user sessions are timed out

When the user session is about to time out, SM

after a specified period of inactivity. This is

will play a sound and display a warning message

problematic when users need to search a long

box to prompt the user to extend the session.

time for information related to the work they are
doing in SM. There should be dialog box that
warns users when their session will expire.
QCCR1E80116

QCCR1E84596
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There is no mention of DB2 10.x in the Service

DB2 10.1 is certified on SM 9.32 (for non-HP-UX

Manager Support Matrix.

platforms).

Service Manager 9.3x should be supported on

Windows Server 2012 is supported for SM 9.32

Windows Server 2012.

or later.
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Enhancements

CR

Problem

Solution

QCCR1E88815

Need a new RTE function that returns the query

A new RAD function filequeryex(file) has

parameters of a record list.

been introduced. This function returns the query
parameters of a file variable.
For details, see the Service Manager 9.32
Programming Guide.

QCCR1E89688

There should be a pop-up message that is

You can now tailor Service Manager to notify

displayed to all members of an assignment

specific operators by a pop-up window in the

group when a new Incident is created or

Web tier when an incident is created or updated.

updated. However, there is no mechanism to do
this.

For more information, see "Sending
Notifications to Specified Operators (Web Client
Only)" on page 29.

QCCR1E91115

The sm -reportlbstatus command does not

Now the sm -reportlbstatus command

work for an HWLB (hardware load balancer )

works fine no matter whether an HWLB

configuration. Therefore, a replacement or

configuration is used or not.

equivalent of -reportlbstatus is required for
HWLB configurations.
QCCR1E91736

A RTE function is needed to retrieve the result

RAD function updatestatus() has been

of the last update operation on a file.

introduced to achieve this.
For details, see the Service Manager 9.32
Programming Guide.
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Enhancements

CR

Problem

Solution

QCCR1E93257

SM server log output does not include session

The log information about threads initialization

counts. It is hard to determine the current

and termination has been improved to include

number of active session in the process.

session counts, so that support personnel can
gain as much information as possible from the
log.

QCCR1E95215

Currently there is no RAD function available to

RAD function isExpressionValid has been

determine if a RAD expression is valid or not, so

introduced to address this issue.

the RAD team uses "parse.evaluate" to do it.
The problem is that parse.evaluate will send
error messages to the client when the

For details, see the Service Manager 9.32
Programming Guide.

expression is invalid.

Web Client
CR

Problem

Solution

QCCR1E75417

Service Manager user sessions are timed out

See applications fix "QCCR1E75417" on page

after a specified period of inactivity. This is

48.

problematic when users need to search a long
time for information related to the work they are
doing in SM. There should be a mechanism that
allows individual users to have an inactivity
timer specified in their operator record.
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CR

Problem

Solution

QCCR1E77350

Service Manager user sessions are timed out

See server fix "QCCR1E77350" on page 53.

after a specified period of inactivity. This is
problematic when users need to search a long
time for information related to the work they are
doing in SM. There should be dialog box that
warns users when their session will expire.
QCCR1E89217

In the Web client, sometimes there is a scroll

In the Web client, there is no longer a scroll bar

bar displayed for the hover-over form for a field

displayed for the hover-over form for a field.

depending on the content. However, there is no
scroll bar displayed for a hover-over form in the
Windows client.
QCCR1E89553

QCCR1E89688

Service Manager 9.3x does not support Internet

Service Manager supports Internet Explorer 10

Explorer 10.

as of version 9.32.

There should be a pop-up message that is

See server fix "QCCR1E89688" on page 54.

displayed to all members of an assignment
group when a new Incident is created or
updated. However, there is no mechanism to do
this.
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Enhancements

CR

Problem

Solution

QCCR1E91013

In the SM 9.x web tier, the images for all items

A new parameter, showNavIcon, has been

and modules are the same and this is a

introduced in the web tier configuration file

regression from the previous SM 7.x version. An

(web.xml):

enhancement is needed to use different icons to
visually distinguish between different items.

<context-param>
<param-name>showNavIcon</param-name>
<param-value>false</param-value>
</context-param>

If it is set to true, each System Navigator menu
item will display an icon; if it is set to false or not
present, the navigator menu items do not display
icons. By default, it is set to false.
QCCR1E91583

A user cannot close tabs within Service

The user can now close an inactive tab page

Manager without activating them first by clicking directly without activating it first (unless it is the
on them. The tab should close by clicking on the

first tab page, or closing this page returns a

"close" button of the tab exactly once.

confirmation).
See also "Close Button on Inactive Tabs (Web
Client Only)" on page 26.

QCCR1E97570
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The externalLB parameter does not exist in

The externalLB parameter is now available in

web.xml.

web.xml.

HP Service Manager (9.32)

Release Notes
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Windows Client
CR

Problem

Solution

QCCR1E72973

Line numbers are missing in the upgrade merge

Line numbers are displayed in the upgrade

panel.

merge panel.

Service Manager 9.x Windows client is not

Service Manager 9.x Windows client is now

supported on Windows 8.

supported on Windows 8.

There is no option in the connections dialog in

The Windows client now provides an option

the Windows client for setting an External Load

named Connect to External Load Balancer on

Balancer. Users are required to manually edit

the connections dialog. Users must select this

the launch file to enable the "external_lb"

option when connecting to a hardware load

parameter.

balancer.

QCCR1E89183

QCCR1E94117

Service Request Catalog
CR

Problem

Solution

QCCR1M750

The Request opens up but the recurring cost

Now the interaction details page and approval

does not show up.

details page display the recurring cost.

Users cannot change the person to be notified

The checkout panel is implemented as out-of-

about a service catalog request. It is a step in

the-box custom fields. Users can define the

the wizard, but these is no way to change the

checkout panel as they wish.

QCCR1M1076

person to be notified.
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CR

Problem

Solution

QCCR1M1507

The Dynamic Value Dependency (DVD)

The following features have been implemented.

functionality is missing on Service Request
Catalog (SRC) user options.

l

A new feature to support dynamic value
dependency/dynamic visibility/dynamic
mandatory for user options fields

l

Configurable out-of-the-box fields/sections in
the checkout panel (including attachment
enable/disable).

QCCR1E71212

When resubmitting a request in SRC, the user is

Added a new panel to allow users to remove/add

not allowed to add more attachments. If a new

attachments while resubmitting a request.

item is added that needs an attachment, the
user cannot add it.
QCCR1E75671

You cannot customize existing out-of-the-box

Now, users can use custom fields to collect

fields in Service Request Catalog. The following

request associated information instead of

list demonstrates some features that would be

hardcoded fields.

useful:
l

The ability to remove/modify out-of-the-box
fields when submitting a request.

l

The ability to make out-of-the-box fields
mandatory or non-mandatory.

l

The ability to modify out-of-the-box fields
labels.
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CR

Problem

Solution

QCCR1M3753

The input of English+Arabic+Number

Now it carts to Arabic native speaker's reading

combination does not match Arabic native

habit.

speaker's reading habit.
QCCR1M4222

Monthly/Weekly/Daily recurring fees are not

Recurring costs are now displayed on

displayed in the Request/Approval details page.

submission pages, details pages, and approval

By default, all costs and recurring costs should

pages.

be displayed in the Request and Approval
details page (unless it is disabled in the property
file).
QCCR1E79275

You cannot set the urgency for an Interaction

Users now can enable/disable any of the out-of-

when a catalog item has been requested through the-box fields as they wish.
SRC.
QCCR1E79725

An enhancement is requested to make the

The visibility of the SRC Attachment section is

visibility of the SRC Attachment section

now configurable.

configurable.
QCCR1E84188

The closure code displayed for a closed

The closure code's style has been modified. The

interaction/request in SRC looks like a button.

font color has been changed to blue, and the

There should be a mechanism to remove or

background color has been removed.

modify how the "Closure code" is displayed in
SRC for a closed interaction.
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CR

Problem

Solution

QCCR1E87627

There is no easy way to get back to the SRC

A Back button was added to the Service and

search results screen after you have navigated

Support Details pages. Now, users can return to

away. If you click the browser back button

the previous page by using this button.

several times, you typically return to the search
results, but the behavior is inconsistent and not
user-friendly.
QCCR1E87630

Add an option to hide the first SRC

You can hide the Request button in

service/support "Request" button to force users

Search/Browse list view by setting the following

to read the item "Detailed Description" before

properties to false in the

requesting a service or support item from the

applicationContext.properties configuration file:

service desk.
l

For Service:
src.ui.service.enableDirectRequest

l

For Support:
src.ui.support.enableDirectRequest

By default, these properties are set to true.

Page 61 of 229

HP Service Manager (9.32)

Release Notes
Enhancements

CR

Problem

Solution

QCCR1E87730

The SRC "Line Item" status should display the

SRC uses two statuses to show the progress of

real approval status of the line item.

a requested line item: line item approval_status
and request fulfillment_status for the line item.
(here we can assume that request fulfillment
record is quote).
Before expanding request item details, users
can see a line item’s approval_status; after
expanding the line item, users can see the
corresponding request fulfillment_status for the
request item. Request fulfillment_status is
mapped from the quote by svcCatStatusMap, in
accordance with the Service Manager process.
Note that line item approval status is not equal
to the related fulfillment record approval status.
For example, if a line item has "approved" for the
approval_status, a new fulfillment record (quote)
will be created. If the current_phase of the quote
is "Ordering" and in the "initial" status, the
fulfillment_status in the request item will be
"Requested Request Ordered Request
Approved" according to the svcCatStatusMap
definition.
Now, the Line Item status can be hidden by
setting the src.ui.service.enableLineItemStatus
property to false in the

HP Service Manager (9.32)
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CR

Problem

Solution
applicationContext.properties configuration file.

QCCR1E87769

When adding user selections to catalog items,

The contact lookup component supports

some new fields are configured to retrieve data

dynamic multi-column display.

from other tables and fields. However, there is
no mechanism to tailor that search criteria for
any table to add secondary fields in addition to
the default fields.
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CR

Problem

Solution

QCCR1E88075

In some configurations, approvals may be

SRC now allows you to specify which status

performed on the quote instead of on an

indicators will display in the "Your Requests"

Interaction. In this case, when a user submits a

widget. To hide these statuses, remove the

service catalog request, the Interaction is

pound sign (#) from properties that are

created and approved automatically.

commented out in applicationContext.properties

Therefore, when an end user views the status of
this request in the “Your Requests” widget, the
request is displayed as “Approved” even though
the related line item (the quote) is still pending
approval. In addition, the “Pending” & “Denied”
status always has 0 records because the
Interaction can never have an approval.status of
pending or denied. These behaviors are very
confusing to end users.

configuration file for those properties you wish to
display. For example, remove the pound sign (#)
for the following properties to hide the Pending
and Approved statuses in the "Your Requests"
widget:
src.ui.service.enablePendingOnWidget=false
src.ui.service.enableApprovedOnWidget=false
#src.ui.service.enableClosedOnWidget=false
#src.ui.service.enableDeniedOnWidget=false
#src.ui.support.enableDirectRequest=false
#src.ui.service.enableLineItemStatus=false
In addition, you can specify the status indicators
on the "Service" sub-menu of the "Request
Inbox" section. For example, remove the pound
sign (#) from the following properties to hide the
Pending and Approved statuses:
l

HP Service Manager (9.32)

src.ui.service.enablePendingInbox=false
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CR

Problem

Solution
l

src.ui.service.enableApprovedInbox=false

l

#src.ui.service.enableClosedInbox=false

l

#src.ui.service.enableDeniedInbox=false

Note: By default, all display options are set to
true. Therefore, a property that is commented
out, is equivalent to setting a property as true.
To a change the widget label display name from
"Approved" to another label, modify the following
property in the custom.properties file. For
example, change the "Approved" label to "open",
remove the pound sign (#) (Not shown) and
change "Approved" to "Open."
l

account_view.status_approved=Open

l

account_view.status_approved_
approval=Open

QCCR1E88705

In SRC, only one field is displayed to select

The contact lookup component supports

user option values in a table. When selecting the dynamic multi-column display.
user option, SRC should display a QBE format
similar to that in the SM9 ESS client, which
shows a list of useful columns to help select the
correct value.
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CR

Problem

Solution

QCCR1E88772

The Contact Name field is currently read-only

The Contact Name field is now modifiable when

when you submit a request from SRC. This field

you submit a request from SRC.

should be modifiable.
QCCR1E90029

There is no text associated with the KM search

SRC now enables administrators to define

button (it is a magnifying glass) in SRC 1.4.

descriptive text in the search area by default and

There should be a mechanism to label this icon

customize the content . When the end user

with some text, like “Enter Search.”

clicks or types in the search text area, the text
will disappear.

QCCR1E90505

SRC does not support the following

To comply with the convention of Hebrew and

functionalities for Arabic:

Arabic customers, Hebrew language support
(out-of-the-box support) and RTL support for

l

Text alignment is right-to-left.

l

Labels that describe the text boxes are to the

both Hebrew and Arabic has been implemented.

right of the text box, and the same for any
object.
l

Tabs start from right to left, and the first tab
is to the right.

l

HP Service Manager (9.32)

Menu driving (such as Catalog) is from right.
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QCCR1E93703

Service Request Catalog does not allow

Out-of-the-box custom fields have been used

administrators to hide or remove fields.

instead of hardcoded fields in the check out
panels to collect request information, so that
customers can re-define (add,update, or
remove) the out-of-the-box custom fields to
meet their requirements.

QCCR1E93810

When you order an item from the Catalog in

Changed the "Request Name" to "Title". To

SRC, the 'Request Name' field is confusing.

keep consistency, changed the "Request
Description" field label to "Description".

QCCR1M1929

On the dashboard, if you enter a search key in

Now SRC enables the search icon, and it would

the search box, then click the search icon in the

return search results after clicking.

search box, no response is returned. The icon is
disabled.

Mobility Client
CR

Problem

Solution

QCCR1E73069

Tomcat 7.0 was not officially supported by the

Tomcat 7.0 (7.0.32 or later) is now officially

SM Mobile Applications.

supported by the SM 9.32 Mobile Applications.
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Fixed Defects
This release fixes the following defects.

Server
CR

Problem

Solution

QCCR1E31324

With Syslog audit turned on, only a syslog

If a user logs off, the corresponding log record in

record showing login is created; no record for

SYSLOGM1 will be identified. The STOP_TIME field in

logoff is recorded if the user does not log out

this record will be populated with the shutdown time and

"normally."

the CURRENT_STATUS field in this record will be set
to "log off".

QCCR1E31614

QCCR1E49614

Service Manager periodically produces core

Service Manager no longer produces core files that result

files that result in the loss of the session.

in the loss of the session.

If you have record list enabled in the client,

Sorting QBE lists in descending mode now becomes

sorting QBE lists in descending mode becomes

faster when record list is enabled in the client.

very slow as compared to when record list is not
enabled.

Known issues:
l

If DB and SM are installed in different machines, the
sorting speed will be affected by network condition.

l

The sorting speed will not improve if the customized
view contains a field of another table.
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CR

Problem

Solution

QCCR1E56278

Joined queries in inboxes (views) perform

The new cross-table join queries feature has solved the

poorly. When using views that utilize joins

performance issue.

across tables, performance is very slow.
There is a new feature in Service Manager (SM)
7.X that allows the creation of views that use
joined query tables. When a view uses a join
across two tables, the performance degrades
substantially, particularly where there are large
numbers of records in the joined tables (such as
20,000 records each). For example, selecting a
view and displaying the search results in the
Windows and web clients took four minutes.
Note: If the same joined query is run directly
against the database, the result is displayed in
less than one second.
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QCCR1E62586

If a date is entered incorrectly, the following

If users enter a date incorrectly, the value no longer

error message is displayed:

defaults to 00:00:00.

"Field contains an invalid date/time value
(display,show.rio)."
For example, if the text 'Bob' is entered into the
expected.resolution.time (previously empty)
field, the value defaults to 00:00:00 and exclude
the date. The field only defaults back to the
correct date and time format (such as, 10/12/10
22:04:58), if it was populated in the field
previously.
QCCR1E65082

JavaScript that triggers RAD application

An error message is written to the log file (and a GUI alert

workflows with rio/fdisp or pop-up panels results

if running in GUI mode) and the Signal 11 error no longer

in a Signal 11 error.

occurs.

Note: This behavior can apply to any RAD
application/panel that internally call the
evsuspend for asynchronous operation.
QCCR1E73860

The server will leak memory when if it fails to

The server will not leak memory when if it fails to send a

send a message to the client due to a client

message to the client due to a client connection error (for

connection error (for example, when the client is

example, when the client is terminated by the user).

terminated by the user).
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QCCR1E78485

Sometimes, a poorly constructed query results

The session is now terminated properly on the server

in a long running transaction. If the user waits for side when the client session expires.
a few minutes, and then terminates the client
session, the server session continues to run the
query until the session is terminated from
system status. However, the session should be
terminated automatically when the client is
disconnected.
QCCR1E83730

In the SM9.30 documentation (under Knowledge

Service Manager now allows searches to start with an

Management -> Searching the Knowledgebases

asterisk.

-> Special Characters in Search Queries); there
is a cautionary note underneath the asterisk
description that states the following:
"Do not use the asterisk to specify the first
character of a wildcard string."
This is a request to make knowledge
management work with an asterisk at the start
of the search term.
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QCCR1E84136

The Coordinator runs out of memory and cannot

This is a defect in JGroup. A timeout connect method is

respond to new member's join requests. This

now used in JGroup API to work around this issue.

issue occurs when a custom load balancer
failed to join the application cluster, which
prevented the JGroups from forming properly
and the system was inaccessible to users.
Termination and restoration of the load balancer
process resolved the issue.
QCCR1E88186

When you add new fields through dbdict, the

When the system starts up, it tests whether the current

dbdict.alter.g form (which has the SM alters

process has the privilege to create tables in the DB

button) does not appear. Even though all fields

server by trying to create a test table. The test result is

are added as expected, those fields are corrupt.

saved in shared memory and is never tested again.
Within the function for this procedure, if the test table
already exists, the old code does not attempt to drop the
table and then re-create it. Instead, the function directly
returns to the caller with the result that no create table
privilege is granted.
Now, when you add new fields through dbdict, the
dbdict.alter.g form (which has the SM alters button)
appears.
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QCCR1E88334

If the tablespace names do not match when

If the tablespace names do not match when loading in a

loading in a system unload from db2 to a system

system unload from db2 to a system running Oracle with

running Oracle with a different tablespace, an

a different tablespace, you can use the

error is returned that states the tablespace does

ignoretablespacemapping option to ignore the tablespace

not exist.

and use the default tablespace; or, you can use the
replacetablespacemapping option to replace the
tablespace by specifying the tablespace name.

QCCR1E88327

QCCR1E89016

RTE Signal 11 occurs when running the

Signal 11 does not occur when running the

"xml.setContent" js function.

"xml.setContent" js function.

The CollectionDelete() RAD function only

The function now frees memory of each item.

removes all the items from a collection group,
but not frees memory of each item.
QCCR1E89661

The core dump generated on AIX is not a full

Full core dump now can be generated on AIX.

core dump, which makes it difficult to analyze.
QCCR1E90187

The Count button does not work when view

The date condition in the "count" query is now properly

recordlist is disabled and there is a date

translated.

condition in the query.
QCCR1E91092

You cannot use the 'file.load' application to load

You can load interaction records via the command line.

interaction records from the command line.
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QCCR1E91557

If you setup the Javamail as explained in the

This issue was caused by the Apache Email API. Now

“Emailout parameters in the sm.ini file” help

the SM RTE supports email addresses with an alias.

section, you can only configure one e-mail
address in the mailFrom field of the form (Ex.
<user@example.com>). However, there is no
way to include the name of the user (Ex.
user<user@example.com>).
QCCR1E91996

The documentation for the agstackl parameter

The correct value is 600. When you run the "sm –

has a default value of 400, which is incorrect.

helpstart" command, the default value of agstackl
displayed is now 600.

QCCR1E95026

In the wsdl responses the 'type' attribute is

Now in the wsdl response the 'type' attribute appears in

missing in the <messages> tag. It lacks the

the <message> tag.

words "type=String". By the absence there is an
error in the SAP system via which the web
service is accessed. This system expects a
'type' attribute in the response.
QCCR1E95578
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Message "STRING is not null terminated!!!"

The stack trace is printed when the RTE gets the error

does not give much detail about which STRING

"STRING is not null terminated!!!", which is useful to

has the problem.

identify the specific problematic string.
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QCCR1E95771

When the memory is freed unexpectedly, there

Memory trace information is now provided when the

is no clue for the developer to figure out the root

memory is handled wrongly. A new parameter

cause.

(tracememerror) has been added in the server to control
whether to print stack trace or generate the coredump.
You can set this parameter to:

QCCR1E95954

0: default value, disable this feature;

l

1: print call stack;

l

2: print call stack and generate coredump.

When the mutex lock/unlock fails, you have no

In order to analyze why the mutex lock/unlock fails, SM

clue to analyze which mutex has the problem

will generate coredump and print a more detailed log.

and what the status of the shared memory is.
QCCR1E95984

l

Java Script doCount does not return correct

Note: You need to set enablecoredump:1 in sm.ini.
doCount returns 0 when no record is found.

value when no record is found.
QCCR1E96053

When running SM, if you run command "sm -

When SM command exits, SM will check the database

reportstatus", a signal 11 will occur and core

environment. If the database environment is not

dump can be seen in sm.log.

initialized, SM will skip the database operation. No signal
11 occurs.
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QCCR1E96115

The KMSecurity script does not appear to be

There was a limit in the RTE DB access interface, which

building the $G.viewid variable correctly as a

limited the records that could be fetched. Now the limit

number of users are missing kmcategory

has been removed.

records for categories they should have
permissions for.
QCCR1E96102

The ir_sql_limit parameter does not take effect

Now the ir_sql_limit parameter takes effect for a merged

for a merged file, causing inconsistent and

file. Furthermore, now you can configure ir_sql_limit:0 to

unexpected IR search results when searching

fetch all the rows from the RDBMS for the IR query.

Incidents using a combined IR and SQL query.
QCCR1E96157

QCCR1E96206

HP Service Manager (9.32)

When KMUpdate fails, incremental update does

When KMUpdate fails, incremental update continues to

not continue.

work.

A field is displayed twice after it is added into a

The redundant field will now be filtered out when doing

view.

the DB query.
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QCCR1E96284

The following message is received:

This issue was caused by the attempt to remove those

The record being updated has been modified
since read when saving around 10% of operator
records.

capabilities merged from the template record when a
template-lized record became non-template-lized (see
QCCR1E32145). After this fix, the capabilities that came
from the template record will remain unchanged.

From the log trace, it looks like the operator
capability array is truncated. This only occurs in
environment where the binaries have been
upgraded to 9.31.2018. If you restart the same
server, using the backed up 9.30.282 binaries,
you are able to save the record without the
warning message.
QCCR1E96352

KM Plugin crashes when transferring HTML to

KM Plugin will not crash when transferring HTML to text.

text.
QCCR1E96690

Error message occurrs in the log: _____

The changes of QCCR1E90073 have been reverted.

JNIMemoryAllocator::unlink - mem at 09a64600
is not in our map!
QCCR1E96815

A view that includes joined fields does not

After making changes to a record, the refresh of the view

refresh as expected after making changes to a

including the changed record works well.

single record in the record set.
QCCR1E96880
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Mass unload using Database Manager will not stop at 10

10 000 records when using merged file.

000 records when using merged file.
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QCCR1E96960

The Inactivity Timer mechanism needs to be

The Inactivity Timer mechanism has been refactored for

enhanced to improve performance.

better performance.

The default value of the inactivity timer is set in

The inactive.startup background process is now

the scheduler application. When the user logs

obsoleted, which eliminates the need to start this

in, the SM server needs to fetch it from the

process in order to start the Inactivity Timer. Once your

database, which may result in performance

server has upgraded to 9.32 or later, you can delete this

issues.

process if it still appears in your System Status's Start
Scheduler list.

Web Client
CR

Problem

Solution

QCCR1E31719

If there are unsaved changes and the user select

Now, a confirmation message box will be

disconnect, or click the "X" (Close) button, the

prompted when user clicks the "X" (Close)

current view or window will be directly closed

button in the browser.

without prompting for saving changes.

Limitations:
l

The user should first change the default value
of the context parameter
"enableExitConfirmMessage" in web.xml to
"true";

l

HP Service Manager (9.32)

The solution only works on the Web client.
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QCCR1E53587

If a timer widget is added to the form

If a timer widget is added to the form

SD.update.interaction with the input value set to

SD.update.interaction with the input value set to

$L.handle.start, the Windows client and Web clients

$L.handle.start, now both the Windows client

display different times for an existing record. The

and web client display the same value 00:00:00

Windows client displays 00:00:00 and then

for an existing record.

increments, but the Web client displays the system
time.
QCCR1E59865

In the Web client, a Comfill widget with the

In the Web client, a Comfill widget with the

Mandatory property checked never displays the

Mandatory property checked displays the

mandatory marker if the Array Length property of

mandatory marker as required.

this Comfill is set to a number greater than 1.
QCCR1E60807
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The HTML editor is read-only after it is set to

read-only in the web client.

read-only in the web client.
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QCCR1E65794

If you extend the height of a Text Area widget with

Now, if you extend the height of a Text Area

"Extend enabled" attribute set to true, it may overlap

widget with "Extend enabled" attribute set to

the widgets below it in Web client.

true, it do not overlap the widgets below it in
Web client.
Known issues
l

"Extend enabled" attribute is only supported
by the Text Area widget, do not use it for the
Text widget;

l

For IE only:
The first time you click the expend button,
there will be a slight position change for the
Text Area on the web page.

l

For both FireFox and IE:
If you expand at least two Text Areas on the
web page by setting the height value to a
very large number, and then collapse one of
them, vertical scroll bar will appear for the
group containing these Text Areas.
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QCCR1E65826

In the Web client, after continuously clicking on the

In the Web client, after continuously clicking on

"Save" button to save a "change" record, on-screen

the "Save" button to save a "change" record, on-

messages stop displaying and the System

screen messages display normally and the

Navigator freezes.

System Navigator works normally.

The Employee Self Service (ESS) client has

Now, the buttons do not overlap with each other

overlapping buttons when the French language is

in the ESS mode.

QCCR1E68874

applied.
Note: This issue can be seen when you view closed
requests on ESS.

Limitation:
Under the following cases, the label on the
button may be truncated:
l

The label on the button is too long, or

l

The user uses a low screen resolution, e.g.
1024*768, or

l

QCCR1E69692

The major Service Manager CSS and JavaScript

The browser width is resized too small.

The locations of the major CSS and JavaScript

resources do not expire if the customer upgrades the resources are changed to a path that reflects the
Web tier without changing the context path.

current build number. Therefore, the client's
browser does not make use of the CSS and
JavaScript cache from an old version.
See the "Updates to the Service Manager Web
Tier Directory Structure" whitepaper at the HP
Software support Web site.
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QCCR1E69935

While deploying Service Manager 9.X, users are not

These parameters now take effect after you

permitted to add or manage their favorites. Trying to

change the configuration in the web.xml file.

hide the Add Favorite and Manage Favorite buttons
by editing the web.xml and then stopping and
restarting the Web Tier, but the favorite buttons still
appear.
QCCR1E71401
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Nothing happens when you press the Alt+F6 key

Pressing Ctrl+Shift+F6 now closes an Incident

command to close an Incident in the Web client.

in the web client.
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QCCR1E74392

It is difficult for blind users to define their position

Now the accessible web client behaves as

within the Accessible Web tier.

follows:
l

You can move the focus to the current active
tab header using the keyboard shortcut
"CTRL + ALT + H".

l

When focusing on the tab header, use the
left/right arrow key to switch to the left/right
tab of the current active one.

l

You can close the current active tab using
the keyboard shortcut "CTRL + ALT + T".

Konwn issues:
In accessible mode, the following known issues
exist when JAWS is running:
l

When using the "H" key or "CTRL + ALT +
H" to focus a tab header, and then press Tab
or Shift+Tab, the headers of the previous and
next inactive tabs are still focusable.

l

When using Shift + Tab to focus a tab
header, the header will be read as "[header
text] heading level one". The previous or next
unfocusable element is focusable.
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QCCR1E76272

In a customer's Production environment sometimes

By the timely releasing of Java heap memory,

Tomcat memory suddenly spikes and then exceeds

now the memory usage by the Web tier in an

available memory when certain Change records are

application server will not exceed the limits.

viewed in Web client. This problem neither occurs
with all Change records nor occurs in a Test or
Development environment with the same records.
QCCR1E76629

A collapsed list view in a list detail page will expand

Changed the code to "remember" the list view

again after the page is refreshed.

current "state" in the list detail page. When any
modifications were resulted from a page refresh,
the list view retains its original state. The state
is captured and saved in the current session for
each tab, and in the same tab, for each type of
list views, the state is remembered separately.
Note: The list view always displays in expanded
mode for search results of the first time search.
To enable this feature, set
"enableListFrameStateRetain" in the web tier's
web.xml to "true".
<context-param>
<param-name > enableListFrameStateRetain</
param-name>
<param-value > true</ param-value>
</context-param>

HP Service Manager (9.32)

Page 84 of 229

Release Notes
Fixed Defects

CR

Problem

Solution

QCCR1E79210

All collapsed sections in detail form are not

All collapsed section in the detail form are

accessible by the keyboard and JAWS cannot read

accessible now. When you focus on the toggle

the open status of these collapsable sections.

button, JAWS will read: "Expand/Collapse" +
[section header text]

QCCR1E79208
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RecordList data and header cannot be read by

After setting ARIA related roles and attributes to

JAWS and is not keyboard-accessible in the Web

RecordList, it can now be read by JAWS and is

client.

also keyboard-accessible.
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QCCR1E79365

When multiple thread tabs are open, the JAWS

l

The current active tab header can be focused

screen reader cannot determine which tab is active

by using the keyboard shortcut "CTRL + ALT

or selected.

+ H".
l

When focusing on the tab header, use the
left/right arrow key to switch to the left/right
tab of the current active one.

l

The current active tab can be closed by using
the keyboard shortcut "CTRL + ALT + T".

Konwn issues:
In accessible mode, when JAWS is running:
l

When using the "H" key or "CTRL + ALT +
H" to focus on a tab header, and then press
Tab or Shift+Tab, the headers of the previous
and next inactive tabs are still focusable.

l

When using Shift + Tab to focus on a tab
header, the header will be read as "[header
text] heading level one". The previous or next
unfocusable element is focusable.
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QCCR1E79435

When new tabs or pages are loaded, the JAWS

Only an active detail tab header is focusable,

reads the tab headers as "[header text] Heading

and when focused the tab header is read as "

level one" instead of "[header text] tab"

[header title] tab".
Known issue:
In accessible mode, when JAWS is running, if
you use "H" key or "CTRL + ALT + H" to focus
the header of the current tab, the header will be
read as "[header text] heading level one" rather
than "[header text] tab" only.

QCCR1E79492

When opening a new change, the user is presented

When the user tabs through the change

with a table object listing the Change Categories.

categories list, the screen reader reads out the

However, the screen reader does not read these

currently focused element.

categories to the user when tabbing through the
categories, nor does the screen reader provide a
general overview of what is listed in the table object.
QCCR1E79618

JAWS always reads the last item on the left

The Miscellaneous option on the left Navigation

Navigation pane as "List of two items" even if the

pane reads "Miscellaneous tab open/close", and

list is collapsed. That is, the Miscellaneous option

no additional unnecessary statement is read out.

on the left Navigation pane always reads "List of two
items" after focusing on Miscellaneous.
QCCR1E88476

When using the old ServiceCenter style menu, if

The "Main Menu" tab now displays correctly

users click the "Main Menu" tab, the tab disappears.

when users use the old ServiceCenter style
menu.
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QCCR1E88836

The Decimal widget displays shorter in the Web

Now the Decimal widget displays the same

client than in the Windows client.

width in both the Web client and Windows client.

The record list disappears after saving the record

When saving a record which contains special

that contains special characters.

characters, the record list does not disappear.

When you try to show multiple records from a sub-

When you try to show multiple records from a

format within the Notebook in the Web client, only

sub-format within the Notebook in the Web

the first record is shown, and it is shown multiple

client, all records are shown correctly.

QCCR1E89209

QCCR1E89670

times.
QCCR1E89764

QCCR1E89928

When an array of records display in a Subform in the

When an array of records display in a Subform in

Web client, the clicking of the "find" button of each

the Web client, now the clicking of the "find"

record always shows the detail information of the

button of each record shows the detail

first record.

information of the corresponding record.

If you try to directly open a record in Web client

Now you can directly open a record in the Web

through a query URL and enter an incorrect

client through a query URL even if after a failed

password on your first attempt to log in, the

login.

reference to the particular record in the URL will be
changed and you can no longer open the record
directly.
QCCR1E89976

In the Web client, when you type a valid entry into a

Now in the Web client, when you type a valid

Combo Box or a Comfill with "value List" specified

entry into a Combo Box or a Comfill with "value

and "Combo Button Visible" set to true, the typed

List" specified and "Combo Button Visible" set

input gets mixed with the auto-matched entry.

to true, the typed input is successfully autocompleted and will not get mixed with the automatched entry.
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QCCR1E90582

In the Web client grouping view, the previously

In the Web client grouping view, the previously

focused group header still gets a focused style after

focused group header gets a normal style after

the focus goes to a data row.

the focus goes to a data row.
Known issue:
If you move the focus off the RecordList, the
focused style of the last focused group header or
data row remains unchanged.

QCCR1E90705

Read-only Comfill and combo boxes allow you to

No actions are allowed to change value in read-

move between items when you use a Value list or

only Comfill or Combo boxes.

Display list.
QCCR1E90749

When the Readonly DVD condition of a Comfill is

The display value no longer changes after you

true, the display value of the Comfill changes to its

save it.

value after you save it.
QCCR1E90750
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The current value of a select-only Comfill is kept

if the value list does not contain it.

even if the value list does not contain it.
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QCCR1E90934

When you search Knowledge Management and then

The document opens correctly without errors.

click on any document in the hitlist, the
webtier/browser generates the following error:
TypeError: parent.tpzExecute is not a function
javascript:parent.tpzExecute
('activeLink90cdb1e13cb0f3ea013cb15d526e0011');
()
Note: This error is retrieved from Firefox FireBug.
Other browsers may generate a different error
message.
QCCR1E91182

QCCR1E91235

Pressing of the Enter key on the RecordList Count

Pressing of the Enter key on the RecordList

message box drills down to the detail view of the

Count message box now dismisses the

highlighted record instead of dismissing the

message box instead of drilling down to the

message box.

detail view of the highlighted record.

The title on "mb.yes.no" windows is displayed as

Now, the Title is set as follows:

"Main Menu<OPERATOR FULL NAME>" on the
Web client instead of the localized version.

l

"Question" for a message box of "Yes/No"
type.

l

"Warning" for a popup message box with
"Warning" type.
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QCCR1E91463

Affected CI text fields overlap with elements

A vertical scroll bar is displayed if many affected

underneath it if you select more than three CIs back

CIs are selected.

from the fill field form.
QCCR1E91461

QCCR1E91511

QCCR1E91524

Focus moves unexpectedly after you fill in a value

Focus is kept at the original fill input box when

back from the fill field list form.

you go back to the detail page.

The count-record button is not large enough for the

This defect has been fixed by modifying the

full label in some languages.

style sheet.

JAWS fails to distinguish different buttons in the

JAWS can now distinguish different buttons in

paging bar of the RecordList. It reads the same

the paging bar of the RecordList. It reads

message "Button, to activate press the spacebar"

different messages for different buttons.

for the First, Previous, Next and Last buttons.
QCCR1E91577

When setting "attributes and values" for "Expected

When setting "attributes and values" for

States" of a Configuration Item (CI), if the type of

"Expected States" of a Configuration Item (CI),

the first field is array-of-datetime, the following

all array-typed fields are displayed correctly.

array-type fields will also be displayed as array-ofdatetime type.
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QCCR1E91561

When you open the "Search CIs" under

Now the behavior is the same as the Windows

Configuration Management -> Resources, click the

client; the DVD Select statement lists the

"CI Type" dropdown to make a selection, and then

expected subtype values.

click "CI Subtype," all the valid CI Subtypes display
as expected. However, if you have to leave the
"Search CIs" tab open and then search CIs on any
other module based on CI Type and CI Subtype,
when you return to the "Search CIs" tab, click on CI
Type dropdown to make another selection of the CI
Type, and then click the CI Subtype dropdown, no
values are returned.
QCCR1E91758

QCCR1E91953

QCCR1E92503

The default focused row is not in the grid view area

The default focused row now displays in the grid

after the list-detail view is refreshed by pressing the

view area after the list-detail view is refreshed

ENTER key in the detail form.

by pressing the ENTER key in the detail form.

The Web client hangs when trying to show a view

The Web client now shows the view with an

with an array field.

array field correctly.

If Popup Subform is enabled for a Comfill field, when If Popup Subform is enabled for a Comfill field,
a value in the display list is equal to another value in

the Popup Subform always shows correct detail

the value list, the Popup Subform shows wrong

information when hovering over the field.

detail information when hovering over the field.
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QCCR1E92671

When you move the cursor over certain fields in

The pop-up window now appears fully within the

Service Manager, a pop-up window appears in

view.

which you can see some information related to that
field. When you do this with a field that is located on
the very right side on the format, part of the pop-up is
out of the range of the web client window.
QCCR1E92682

For ListBuilder in the web tier, the highlighting for an

For ListBuilder in the web tier, now at most one

option is not removed from one list when you make a option of the two lists is allowed to be
selection in the other list.

highlighted.
Known issue:
FireFox behaves differently from IE in the focus
handling of the ListBuilder widget, such as
clicking into the list or using space bar or arrow
keys to select the option. This is the difference
of browsers for handling the native HTML
<select> element.

QCCR1E93276

The following message appears periodically in the

The error message has been changed to a debug

SM web tier client logs:

warning.

ERROR ajp-bio-8009-exec-16551
com.hp.ov.sm.client.webtier.SCLogging - Jan 14,
2013 20:12:15 GMT [ERROR] Dangling transition
detected in workflow.
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QCCR1E93560

On a SM system with load balance configured and

On a SM system with load balance configured

honorUrlPort enabled, a page refresh operation will

and honorUrlPort enabled, a page refresh

cause the web client to display an inaccurate

operation will cause the web client to display an

message "You are trying to connect to a different

accurate message "The Service Manager main

server while the Service Manager main application

application is already open in another browser

is already open in another browser tab. If needed,

tab or you recently refreshed the current page. If

save your work in the other tab first, and then

needed, save your work in the other tab first, and

continue". After clicking the "OK" button on this

then continue". After clicking the "OK" button on

message page, the web client logs off.

this message page, the web client goes back to
the previous page.

QCCR1E94522

The Fill function works incorrectly in the Web client

The Fill function works correctly in the Web

when the focus is not on the related widget.

client even when the focus is not on the related
widget.

QCCR1E94524

QCCR1E95113

If you click the "Manage Favorite" icon twice, the

If you click the "Manage Favorite" icon twice,

"Add Favorite" icon is displayed again although the

the "Add Favorite" icon is not displayed when

parameter is set as false.

the parameter is set as false.

If a menu item on the System Navigator contains

If a menu item contains special characters, the

special characters, the web client does not render

web client renders the menu tree in the same

the menu tree correctly.

way as the Windows client.
Limitation:
If the menu item contains a colon (":"), it will not
be rendered as expected.
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QCCR1E95522

Sometimes the focus is not on the RecordList when

Now the focus is always set to the first cell of

it is displayed in Internet Explorer (IE).

the RecordList when it is displayed in IE.

In Change Management if you have multiple

In Change Management if you have multiple

approvals for one change, when you try to override

approvals for one change, you will now override

one approval, you will get an alert message "The

one approval successfully without any alert

cursor is not on a current or future pending group."

messages.

QCCR1E95569

Known Issue:
Now, you'll have to click in the "Correct" cell of a
row before you can successfully carry out
further operations base on your selection.
For example, before doing an override operation,
be sure to click in the "Group/Operator Name"
cell of an approval in the "Future Approvals"
table, or click in the "Approval Group/Oper" cell
of an approval in the "Completed Approval
Actions" table.
QCCR1E95597

QCCR1E95809
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The "Collapse Enabled" function displays a

The "Collapse Enabled" function no longer

JavaScript error for a group widget.

display a JavaScript error for a group widget.

After creating an Incident view with the "Assignee-

After creating an Incident view with the

Security Group" field and then trying to show this

"Assignee-Security Group" field and then trying

view, the Web client hangs and a blank page shows

to show this view, the Web client shows the

in the end.

view correctly.
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QCCR1E95969

You receive a "Webpage has expired" message if

The backspace key is blocked for knowledge

you press the backspace key when viewing a

management records.

knowledge document in Internet Explorer.

Known issue:
If the document type is external and status is
external, when the focus is on the bottom frame
of the document detail, the backspace key is not
blocked.

QCCR1E96013

The last active group is expanded or collapsed after

The last active group stays unchanged after

pressing the spacebar on a focused column header.

pressing the spacebar on a focused column
header.

QCCR1E96047

Subformat table rows are not displayed in web

Rows are displayed correctly in web client.

client.
QCCR1E96100

If you set Tab Stop value for a Notebook widget to "-

The Tab Stop property works on the Notebook

1", the keyboard tabbing in the Web client still sets

widget now. If you set Tab Stop value for a

focus to the Notebook tabs.

Notebook widget to "-1", the keyboard tabbing in
the Web client will not set focus to the Notebook
tabs.

QCCR1E96218

HP Service Manager (9.32)

You cannot adjust the table column width of the

Now you can adjust the table column width of

ToDo Queue and View in the first tab using Firefox

the ToDo Queue and View in the first tab using

21.

Firefox 21.
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QCCR1E96430

The Web client freezes when trying to display a

The Web client displays a page with a

page with a ListBuilder widget, if the ListBuider

ListBuilder widget even if the ListBuider

selections contain the character ‘&’.

selections contain the character ‘&’.

If one Tab of a Notebook widget is invisible on initial

If one Tab of a Notebook widget is invisible on

loading, and then you dynamically set the Visible

initial loading, and then you dynamically set the

Condition of this Tab to true, the Tab contents are

Visible Condition of this Tab to true, the Tab

still invisible.

contents are visible now.

A new dashboard or folder can be created under an

Users can no longer add a dashboard or folder

existing dashboard.

under an existing dashboard now.

Unable to use the "Up" or "Down" arrow to select

Now you can use the "Up" or "Down" arrow to

from a Combo box in the list-detail view when

select from a Combo box in the list-detail view

JAWS is running.

when JAWS is running.

High CPU utilization occurs on the Service Manager

High CPU utilization has been eliminated under

Web client under concurrent load.

concurrent load.

Icons in the workflow list toolbar are lost.

The Icon images file path has been corrected.

QCCR1E96879

QCCR1E97411

QCCR1E97455

QCCR1E97623

QCCR1E97627

Now icons are shown on the toolbar as
expected.
Localization
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QCCR1E70535

In QCCR1E69316, two new labels were added in

The labels now have been localized.

client\webtier\src\java\com\hp\ov\sm\client\webtier\cp
e_web.properties:
WebControllerServlet.login_process=Login is in
progress, please wait ...
WebControllerServlet.do_not_refresh=Please DO NOT
refresh this page to avoid slowing down the login
process.
But they were not localized.
QCCR1E70942

A warning message that appears when you quickly

The warning message has been localized.

switch between tabs in the web client is not localized.
.

Windows Client
CR

Problem

Solution

QCCR1E49438

When returning from certain formats (Ex. from

The function keys always work as expected now.

activityservicemgt to SD.update.interaction),
the function keys (Ex. F10 or F11) no longer
work.
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QCCR1E54677

If a Fill button is clicked after you add an

Now, you can open an attachment in an un-saved record

attachment to an Incident record, the following

even after executing a Fill action.

error occurs when you click on the attachment:
"Could not open attachment."
If the Fill function is not performed, then the
attachment opens without any errors.
Note: The error occurs before the record has
saved, between the time at which the
attachment is added and the Fill action is
performed.
QCCR1E68848

If the client session is terminated while a dialog

The dialog box can be closed by clicking the "X" button.

box is open (for example, as a result of session
a timeout), you can never close the client. You
receive a "Session no longer valid" error
message when you try to close the client.
QCCR1E72274

In the Windows client, when you try to print a

A form containing a comfill widget with DVD conditions

form containing a comfill widget with DVD

can now be printed correctly in the Windows client

conditions, you will receive the following Java

without any errors.

Runtime error: "Unable to get value of the
property 'wrapComfill': object is null or
undefined."
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QCCR1E92085

With a list of "Object" records, after you view

With a list of "Object" records, the Windows client

the "Search Configuration" tab in the detail view

displays correct contents for the "Search Configuration"

of one record, the Windows client shows blank

tab in the detail view for all records.

contents for the "Search Configuration" tab for
the rest of records.
QCCR1E93015

The newly installed Windows client hangs when

The newly installed Windows client connects to a server

connecting to a server if an old version client

successfully if an old version client was in use before,

was in use before. And then if you try to use any

and any of the old versions also works correctly.

of the old versions, it also hangs.
QCCR1E93996

When you configure Service Manager 9.31 with

The language setting now takes effect when a user logs

TSO, the user's language preference is set

in using Trusted Sign-on.

incorrectly. This issue occurs when the "Use
Trusted Sign-on" option is selected in the
connection screen.
QCCR1E94930

When you try to close one of the open windows

When multiple windows are open in the Windows client,

in the Windows client by using the File > Exit

the click of the File > Exit menu only closes the current

menu, all windows are closed. You can only

active window.

close a single window by clicking the "close"
button on the upper right corner of the window.
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QCCR1E95200

The following message box appears in the

When you switch selection in the Connection

Windows client (Service Manager 9.31 Patch 2)

Configuration list the "Save Changes" message box will

when you switch selection in the Connection

not appear if there are no unsaved changes.

Configuration list:
The configuration *** has unsaved
changes. Do you wish to save them?
This issue only occurs when you switch from a
Connection Configuration with the "Remember
my password" check box checked, even though
there are no unsaved changes.
QCCR1E97227

If the operating system (OS) date format is set

If the OS date format is Chinese, the Windows client

to Chinese (PRC), the Windows client does not

now displays only the last Chinese character (one, two,

display the Chinese names of the days of the

three, and so on) of each day of the week in the pop-up

week (such as Monday) completely in the pop-

calendar window.

up calendar window for a date/time field. It
displays only the first two Chinese characters.

Note: Starting with SM9.30p2, the Windows client has
displayed the navigation menu (System Navigator)
based on the OS display language instead of the OS date
format. For example, if the display language is English,
the menu will display in English even if the date format is
Chinese.

Page 101 of 229

HP Service Manager (9.32)

Release Notes
Fixed Defects

Windows Client Configuration Utility
CR

Problem

Solution

QCCR1E95547

The startup.jar file does not exist in the Client

The startup.jar file is not needed as of 9.31 patch 2. After

folder after the installation of SM 9.31.p2

removing the startup.jar validation, the Client

Windows client.

Configuration Utility runs successfully without any

If you run the SM 9.30 Client Configuration

errors.

Utility and input Directory as "C:\Program
Files\HP\Service Manager 9.31\Client", when
you click the Next button, the utility reports the
following error message:
"File does not exist: C:\Program
Files\HP\Service Manager
9.31\Client/startup.jar".
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QCCR1E31131

When using the Baseline Group Wizard, the

Updated the code to make the Link work properly.

dynamic Link in the form
Filter.edit.addFilter.device does not work, and
the following error message is received:
"No link exists for this field, fill
function cannot be performed"
However, it is not clear what the missing link
is.
QCCR1E31324

With Syslog audit turned on, only a syslog

The STOP_TIME field in this record will be populated

record showing login is created; no record for

with the shutdown time and the CURRENT_STATUS

logoff is recorded if the user does not log out

field in this record will be set to "log off".

"normally." If a user logs off, the corresponding
log record in SYSLOGM1 will be identified.
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QCCR1E32007

Line 220 of the createARequest SciptLibrary

The syntax error has been fixed.

record currently reads as follows:
scmessage=system.functions.scmsg(158,
"ScriptLibrary", [ScripLibrary,
RCtoString(rc)]);
However, when you submit a ServiceCatalog
Request, this line produces the following error
message in the log file because of the syntax:
"Script 'createARequest' line 220:
ERROR ReferenceError: ScripLibrary is
not defined at char 1"
Note: The request is not created.
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QCCR1E32156

The ServiceCenter process/client runs in an

SM will not run into an infinite loop when attempting to

infinite loop when attempting to open a new

open a new task.

task. In an OOB system, this happens if you
remove all task categories except for the
"Create Group" Task Category. Then, if you
simply click on Open New Task from the
navigation menu, the process enters an infinite
loop.
This behavior occurs because, when opening a
task, the cm.open application looks for open
Change Requests where the current phase is
one of the available phases from that task
category. If it cannot find one, the search is
repeated in an infinite loop. When this occurs,
the following message appears in the log
repeatedly:
"No Changes were found that match the
allowable Phases."
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QCCR1E8754

When you contribute a new KM document and

When creating a new kmdocument, the expiration date

do not specify an expiration date, no expiration

will be set as defined in the environment record.

date is set. This behavior occurs even though
the KM environment record contains a note
with the following field on the form:

Note: A value of 0 means the document will never
expire.

Default Expiration Period (0 if document never
expires): 365 days (default)
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QCCR1E32188

When an operator does not have the

When an operator does not have the appropriate rights

appropriate rights set in the application profile,

set in the application profile, an attempt to create a

an attempt to create a favorite will result in a

favorite does not result in a SOAP Fault error message,

SOAP Fault occurred: "A CXmlApiException

and the message followed is changed to "You do not

was raised in native code : error 19 : scxmlapi

have rights to create personal views."

(19) - Doc Engine call failed with cc -1",
followed by "You do not have rights to create
public views."

Detail changes are as below:
l

authority to create personal view,

The SOAP Fault error message is unexpected.
This issue occurs in the Web and Windows
l

clients. When an operator does not have the
appropriate rights set in the application profile,

Updated the message when operator does not have

Updated the message receiver to the current loggedin user.

an attempt to create a favorite does not result in
a SOAP Fault error message, and the message
that follows has been changed to "You do not
have rights to create personal views."
l

Updated the message when an operator
does not have authority to create personal
views;

l

Updated the message recipient to the
current logged-in user.
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QCCR1E54551

Clicking "OK" on a reopened incident ticket

The window now saves and exits correctly.

updates the record, but does not Save and Exit
as expected.
QCCR1E56235

In a fill widget, when the end user enters a few

A workaround is available.

characters in a language other than English,
and then hits the fill button, a database search
is launched for values starting with these
characters. Because the database contains
only the English values, no results are returned,
even if the characters are the valid beginning of
a value.
QCCR1E57832

Service Manager will not open a related request

Quotes are generated from Service Catalog correctly

for any Service Catalog item configured to open

even if Quote Category names are similar.

the specific request category.
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QCCR1E58482

When a user has saved a view with a date in it

The date that was entered is correct when the view is

(for example, in the Opened After field) and

reopened.

afterwards edits the view, the date values are
not retained. For example, if a user makes
changes by editing the date, saves the view
again, and exits, when the view is reopened,
the date that was entered is not correct. This
applies to all date fields in the view. There are
very different results; sometimes the whole
date field is empty, sometimes the day and
month have been replaced with each other, and
other times a whole different date has been
filled.
QCCR1E62955

SM treats the non-mandatory Date and Time

SM treats the non-mandatory Date and Time fields

fields defined inside Service Catalog User

defined inside Service Catalog User Selections as non-

Selections as mandatory, as validation errors

mandatory, as validation errors no longer occur on null

occur on null entries of these fields.

entries of these fields. The defect has been fixed by
modifying ScriptLibrary: dynamicFormValidation.

QCCR1E67490

When selecting a localized item within a

When selecting a localized item within a bundle, the

bundle, the additional text instructions do not

additional text instructions display correctly.

display correctly.
QCCR1E67641
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Outage calculations for incidents logged with

The slamonthly report is now recalculated after the new

outage periods in the past are incorrect.

outage end is set.
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QCCR1E68877

When you search for Items or Bundles in

Correct search results are now returned, which contain

Service Catalog and you select a Category that

the category and the bundles or items you searched for.

contains only categories, no search results are
received. However, if you browse through the
catalog categories, you can find the items you
are looking for.
QCCR1E70481

When you use Export to Text file with the

Export to Text works fine for multiple-line text.

delimiters other than Comma Separated Value
(CSV) and Semicolon Separated CSV, if any of
the fields contains a Line Break (New Line), an
empty line is seen in the exported file. This
defect is fixed.
QCCR1E70993

The CI Relationship Graph collapses when you

The CI Relationship Graph is displayed correctly after

expand a group. Instead of extracting the two

the group is expanded.

CIs from the group, the graph will be collapsed
to its first version. All the nodes previously
expanded have to be expanded again in order to
see the CIs that were extracted from the group.
QCCR1E71589

Note: When you change the decorator definition or the
threshold for triggering the formation of a CI group, you
need to log off and log back in for the change to take
effect.

Users with the SysAdmin capability word

You can now delete a field from a Knowledgebase

cannot delete fields from Knowledgebase

definition even if many knowledgebases are displayed.

definitions. This issue occurs only with some
users.
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QCCR1E71665

You receive an error message when you create

To resolve this issue, the holidays in calholiday were

a new ticket if calendars were not extended to

updated until the year 2014.

include 2012 dates: "Record was locked at:
<date-infor>, rescheduling."
QCCR1E72733

The Template functionality in Change

A validation for subcategory was added so that invalid

Management does not respect the selected

subcategories are not saved.

Change Model or change category of the
change to which it is applied. This results in
invalid changes when the Process Designer
Content Pack 9.30.0 is installed.
QCCR1E72880

The Define View wizard does not hide fields

The Define View wizard hides fields that are marked as

that are marked as "unavailable" by using

"unavailable" by using conditions.

conditions.
QCCR1E73953

Some RAD applications have references to a

The invalid references have been replaced with an

non-existent panel. This causes the

appropriate panel.

applications to crash when executed.
QCCR1E73974

The calendar.calc.interval application doesn't

The calendar.calc.interval application now calculates

calculate interval correctly under "24*7" Work

interval correctly after changing the logic.

Schedule when holiday is included into
Working hours.
QCCR1E74348

An operator who has no folder right to view

The operator cannot view the Incident Management

incident management records can incorrectly

records in the folder.

view all incident management records.
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QCCR1E74423

The calculation of payment due dates when

Date Due by monthly generate payment schedule of

using "Generate Payment Schedule" wizard

contract is calculated correctly.

does not populate due dates on all payments if
the operator record and system information
record are not configured for the US date format
(mm/dd/yy).
QCCR1E74482

CI decorators cannot accept multiple

CI decorators can accept multiple conditions.

conditions.
QCCR1E75732

Expanding upstream groups in Relationship

This issue was resolved by removing the redundant

Graph shows extra physical connections.

function invocation.

Specifically, in a device that has one upstream
group and one downstream group, the
individual CIs are shown below the initial CI
and there is an extra physical edge connector
after you expand the upstream group. The extra
connections occur because the expanded CI is
drawn twice. Because each instance of this
drawn CI has the same ID, it appears as if one
CI has two connections.
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QCCR1E75856

When you install the uCMDB Content Pack on

The uCMDB Content Pack installs without errors, if you

a system that already has Process Designer

tailor the devtype datadict.

installed, the following errors are generated at
the end of the installation process:
The record being added contains a duplicate
key (sm.patchrel.data,add.save.record)
file:(datadict) key:(name=NEWCPdevice)
(sm.patchrel.data,add.save.record)
QCCR1E76034

Users can attempt to use the WSDL to JS

SM generates a wrong base64 code string which

function to import a Webservice for

mismatches the base64 code string generated by the

consumption by Service Manager from

WSDL side.

uCMDB. To do this, authentication is required
to access the wsdl. When the user enters the
URL for the WSDL, enters a valid User Name

This problem has been fixed by correcting the base64
encode algorithm on the SM side.

and Password, and then runs the WSDL2JS
function, the following 401 authentication failed
error is received:
WSDL request failed with exception Error
calling method: doHttpRequest in
class:com/hp/ov/sm/server/utility/HttpClient
Exception (java.io.IOException: Server
returned HTTP response code: 401 for URL
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QCCR1E76142

After turning on Response SLOs, users

Now, the record will no longer be updated by the SLA

frequently encounter "record has already been

background refresh schedule, and the "Record has

modified" messages and lose their updates in

already been modified" message will not show.

Incident Management. This happens after
updating an Incident but not changing its
status. This issue occurs when many SLA
refresh schedules are running in the
background, which causes the locks the
record.
QCCR1E76221

QCCR1E76960

Updating a single change record in a QBE list

Updating a single change record in a QBE list only has

causes all records in the list to have an

an impact on that record; It will not make other closed

"update" status.

changes in the QBE list editable.

Performing a Save & Exit after re-opening and

The window is now closed directly when a user clicks

then immediately closing an Incident does not

Save & Exit.

return the user to the Incident list.
QCCR1E77703

Service Manager ignores the effective and

Service Manager now validates the effective and

expiration dates for an SLA when processing

expiration dates for an SLA when processing outages

outages for an availability SLO.

for an availability SLO. If the SLA is not valid, Service
Manager will not generate outage details for an
availability SLO.
Note: Although there is no outagedetail, the slamnonthly
will be generated at a regular interval with Actual
Availability of 100% and attached to the incident record
(the Uptime Objective area).
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QCCR1E78057

SLO Response calculations can be incorrect

The schedules are now processed in the order of

when SLA State Change schedules are

expiration time.

processed in the wrong order.
QCCR1E78441

When viewing a CI's relationship graph, if a CI

The graph displays as expected and includes all CIs

contains too many relations, the following error

and their relations.

is received and only the current CI is displayed:
"The where clause string exceeds 64k
(display,process.option)"
QCCR1E78450

Setting "Generate Order" to false in a Part

Setting "Generate Order" to false in a Part record

record does not prevent an RM Order for the

prevents an RM Order for the Quote Line Item from

Quote Line Item from being generated.

being generated.

This issue occurs because the "Generate
Orders" control setting in Quote phase/ Model
does not work as expected. Therefore, the
order is generated regardless of whether
"Generate Order" is set to true or false in the
phase or the Model control settings;
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QCCR1E78471

When performing a mass update on

Added null check to prevent this syntax error.

Configuration Items after using the "Search
Specific Type" feature, users may experience
errors that resemble the following:
"An error occurred while attempting to apply
template to update record."
This issue occurs because when applying a
template, the syntax of the generated source
code is not correct.
QCCR1E78517

Service Manager does not handle outage

Outage records are now used correctly.

records correctly when using the outage
START and END dates.
QCCR1E78527

An operator cannot create a Known Error Task

The creation of a task will no longer be impacted by the

if an operator's Problem Profile does not allow

Problem Profile, but instead by the Known Error Profile.

the opening of Problem Tasks but allows
opening new Known Error Tasks.
QCCR1E78572

You cannot create an operator from an existing

You can create an operator from an existing Contact if

Contact if the "Always requires a password"

the "Always requires a password" option is enabled.

option is enabled.
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QCCR1E78634

The Fill button of the owner field in the device

The Fill button of the owner field in the device form

form brings up entire list of departments.

brings up the list correctly.

However, the list is not sorted according to the
previous entry made to field before fill button is
pressed.
QCCR1E78626

QCCR1E78698

QCCR1E78696

If a non-default date separator is used, applying

If a non-default date separator is used, applying a

a Template to a Change record may produce an

Template to a Change record will use the non-default

error.

data separator and will not produce an error.

Slow performance when performing an initial

The performance has been improved by using a better

load from uCMDB to SM.

query.

Unable to update budgetcode records because

This defect is fixed by mapping the update.by field in

the update.by field in "budgetcode" file should

"budgetcode" file to VARCHAR(60).

not be mapped to "DATETIME"/"DATE."
QCCR1E78923

QCCR1E78998

SM 9.30 Application Patch 2 deletes Data

SM Application Patch will not delete Data Policy entries

Policy entries for non-OOB fields.

for non-OOB fields.

When a user logs in into to ess.do and wants to

The ess.SD.update.browse form now returns much

update an Interaction (menu-> View open

more quickly.

requests), it may take 40 seconds or longer
from the time the user clicks on the Interaction
until the Interaction appears in the
ess.SD.update.browse form.
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QCCR1E79182

After associating a knownerror-based or

Added a format to display rootcause and knownerror

rootcause-based knowledge record with an

records.

Interaction, you can no longer view the
associated knowledge record from the
Interaction.
QCCR1E79277

System triggers add a new mark for updating

Modified the statement that provides the sedocid, and

the Interaction kmknowledgebase index when

resolved the issue in the kmtriggerBeforeUpdate

creating a new SRCInteraction record.

function.

However, when adding the new mark in
kmknowledgebaseupdate table, the wrong
sedocid value is inserted. This causes errors in
the KMupdate background process.
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QCCR1E79341

When a specific month has holidays set, the

Changed the calculation logic to adjust to the status.

calendar.calc.date.fc function adds the
holidays to the total days of the month.
Example:
For the month of April, the following parameters
are set to call the calendar.calc.date.fc
function.
Start: 01/04/2012
End: 30/04/2012
Schedule: 24 x 7
When there are no holidays in the month, it
returns correctly the amount of days (29
23:59:59). However, if three holidays are added
to the month, it returns the amount of days as +
3 (32 23:59:56).
QCCR1E79421

When you order from the Service Catalog, the

These field are now populated with the correct values.

fulfillment records (that is, the change records
or cm3r) are not created with the correct
initial.impact and severity values.
QCCR1E79412

The lock is not released if an error occurs when

The lock will be released if an error occurs when calling

calling process in the se.view.engine

process in the se.view.engine application.

application.
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QCCR1E79526

After logging in through the Web tier with SSL,

Removed the useless style code that caused the

accessing a knowledge document in

security warning.

Knowledge Library results in the following
security information popup:
"This page contains both secure and nonsecure
items. Do you want to display the nonsecure
items?"
This popup should not be displayed.
Note: There is a workaround provided in
KM1269225, but it is difficult for some users to
change IE setting individually.
QCCR1E79820

When Process Designer is configured so that

The failed validation should halt the revert operation.

when a user reverts a document from KM and
has not provided feedback, the working copy is
not deleted. However, Process Designer's
handling of failed validation returns from the
"Call a Process" action type presents some
issues. Specifically, if you set $L.exit to
"bad.val" or "cancel" a bad validation situation
should occur and the post action should not
run. However, the action is still executed.
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QCCR1E79821

Request to understand conflict resolution of

Removed the following unnecessary fields from the

extaccess records.

extaccess table.

QCCR1E79883

QCCR1E79928

l

incident.id.applog

l

incident.id.approval

l

incident.id.svcCat.

When you are using SRC, dependent line item

When you are using SRC, dependent line item orders

orders are not generated at the same time.

are generated at the same time.

SLAs on Incidents are not calculated correctly.

The sla schedule now updates the status correctly.

For example, an Incident that is only open for 6
minutes and has an 8 hour SLA is shown as
having breached the SLA. When you look at the
slaactive table, it shows that the SLA is still
active, even though the Incident is closed.
QCCR1E79938

When the timezone record is used for a time

When the timezone record is used for a time adjustment

adjustment and there are no switch over dates,

and there are no switch over dates, the application

the application fails and some error messages

succeeds without error messages.

are received.
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QCCR1E79991

When you update the options field in an

Changes were made to the Applications to resolve this

svcCartItem record without entering any

issue. In addition, a warning message was added to

information, or you input a string that is not xml,

state what input is invalid.

the following user-unfriendly message is
received:
"XML.setContent(): XML document failed to
parse".
QCCR1E80230

When searching with Japanese or Korean, stop

When searching with Japanese or Korean, stop words

words did not work well. Addotionally, "<>"

works well, and "<>" can be used in the KM Search box.

cannot be used in the KM Search box.
QCCR1E80317

If you open Interaction from a QBE list, make a

Making a change to an Interaction and then clicking

change, and then click the 'Next' button without

Next will not cause a loop.

saving, you are asked whether you wish to
save the changes or not. If you click 'Yes,' you
are asked the question again, even though the
save has been applied.
Note: In the Eclipse client, if you do not have
'prompt on save' checked, the system will loop
continuously.

HP Service Manager (9.32)

Page 122 of 229

Release Notes
Fixed Defects

CR

Problem

Solution

QCCR1E83730

In the SM9.30 documentation (under

Service Manager now allows searches to start with an

Knowledge Management -> Searching the

asterisk.

Knowledgebases -> Special Characters in
Search Queries); there is a cautionary note
underneath the asterisk description that states
the following:
"Do not use the asterisk to specify the first
character of a wildcard string."
This is a request to make knowledge
management work with an asterisk at the start
of the search term.
QCCR1E83762

When searching the Knowledge Base and

When you "Use solution" with an empty string, no

using no search terms, and a record from the

phrase will be added to the kmadaptivelearning records,

Knowledge library is selected as a solution for

and no document is deleted from the search engine.

an Interaction, either an error occurs, or the
next indexing pass omits the selected record
from the index.
QCCR1E83860

You cannot view or delete a specific feedback

Now you can view and delete a specific feedback

record when multiple feedback records exist.

record as expected when multiple feedback records
exist.

QCCR1E83847

When the security folders are enabled, closing

A Change Phase is automatically changed if the

the last phase of a change causes the

security folders are active when the last task is closed.

background process to fail.
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QCCR1E83877

The Knowledge Management (KM) advanced

The KM advanced search now returns correct

search does not return the correct results when

documents when KM specific fields such as Title are

searching against KM specific fields, such as

used as search criteria. The issue is addressed by

the Title field. When you enter a search string in

adding search keyword grouping to Title and other fields

the Title field, your search should return all

when the search string contains two or more words.

documents whose title contains that string;
however, the correct documents are not

Notes:

returned, while some other irrelevant

After you add a query field in dbdict "kmquery", you

documents are returned.

need to add a row in the field mapping section in each

When searching in the Title field with a search
string that contains two or more words, the

<library name>_kmprocesslibcriteria record, using this
format:

search engine will look for only the first word in

["<query field name>", "<search engine alias>", <true or

the Title field, and search for the rest of the

false>]

words in the default search field (docbody).
This causes the search results to contain
irrelevant items.

See examples below:
this.fieldmapping = [
["incidentlib_number","number",false],
["incidentlib_status","problemstatus",true],
....
Where:
l

<query field name> (for example, incidentlib_
number) is the field name you added to dbdict
"kmquery";
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l

<search engine alias> is the alias of the field
specified in the Field Definitions tab of the
knowledgebase;

l

<true or false>: This part indicates if Advanced
Search uses full match for this field (when set to
true, full match is used); in addition, this will avoid
the incorrect query grouping, which led to the issue.

If there are custom search criteria that are not simply a
'field=value' query, add it to function:'processSpecial'
defined in each <library name>_kmprocesslibcriteria
record.
QCCR1E83919

Target End Dates are not calculated correctly

Target End Dates are now calculated correctly.

when using the calendar.calc.date RAD
application.
QCCR1E84115

In a catalog that has a number of catalog items

All Date fields in the user selection in a newly-ordered

with date fields, the date format displays in US

catalog item are shown with the current user's date

date format (where the server is located)

format in the SM client.

despite users in other locations logging the
request (so their regional settings on their PC
are set to their local region). The users Operator
and Contact records also have their regional
time zones and date formats applied.
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QCCR1E84113

Users receive duplicate email messages

It works fine when referencing the $L.file.save variable

because the Approval Added notification record

in an Approval Added notification record.

cannot reference the $L.file.save variable.
QCCR1E84152

Low on memory message occurs across all

Re-factored the code to improve performance so that

servlets, and the system becomes

the memory issue will not occur.

unresponsive.
QCCR1E84199

SD records are locked by the linker process

The SD records can be released as expected.

and cannot be released.
QCCR1E84200

Many locks are generated for the Problem

The dirty schedule data will no longer affect the normal

Sceduler, which causes the system memory to

schedule process.

become exhausted.
QCCR1E84282

There is no way to delete Affect CIs from

The affected CI can now be deleted successfully from

Problem Management; When you try to delete

Problem record.

and then save the record, the CIs are still
present. This error also occurs in the OOB
system.
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QCCR1E84320

In Service Request Catalog, a user orders two

In Service Request Catalog, a user orders two items,

items, the first of which only requires manager

the first of which only requires manager approval and

approval and the second requires 2 levels of

the second requires 2 levels of sequential approvals (for

sequential approvals (for example, a manager

example, a manager approval first and then a security

approval first and then a security group

group approval) in the Interaction. If the manager

approval) in the Interaction. If the manager

approves the Interaction in the SRC interface, it

approves the Interaction in the SRC interface,

generates a quote for the first item and the Interaction

it generates a quote for the first item and the

approval status will be calculated based on the

Interaction approval status shows approved.

"aggregate Approval" configuration of the Object in

The approval record also shows as approved,

Document Engine and the approval condition type

but must still receive the approval of the

defined in related Approval definitions.

security group in the current pending group
field. If someone in the security group goes
tries to approve the second item in SRC, users
do not see the Interaction record pending
approval because the Interaction approval
status is already approved.
QCCR1E84402

When the first line item of a bundle is closed,

The logic of mark avail.to.order in ocml.mark.avail.init

the third item is set to "ordered" status. This

RAD has been fixed to apply the correct behavior.

behavior violates the dependency sequence of
the line items.
QCCR1E84548

Templates created from a interaction record do

Certain array exceptions are now handled properly.

not handle arrays correctly.
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QCCR1E84557

When closing an Interaction, the updated.by

When closing an Interaction, the updated.by and

field does not use the full name even though the

opened.by fields use the full name if the environment

environment record and/or user profile specifies

record and/or user profile specifies that the full name

that the full name should be used. Instead, the

should be used. Two fields "opened.by.uid" and

opened.by field uses the Corp ID.

"updated.by.uid" have been added to store operator
name only regardless of the environment/profile
settings.
Limitation:
The opened.by.uid and updated.by.uid fields of existing
incidents records will not be automatically updated
when upgrading to or applying the applications patch. To
update the existing records in the database and set
proper values for these two newly added fields, follow
these steps:
1. Go to Tailoring > Script Library.
2. Search Script Library with name:
UpdateAllInteractions.
3. Uncomment the last line of this script:
updateInteractionFields();
4. Click Save, and then click Compile.
5. Click Execute.
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Service Manager updates all existing incidents records
with proper values for the "opened.by.uid" and
"updated.by.uid" fields.

QCCR1E84708

QCCR1E84714

Modifying Columns using "Search Specific

Modifying Columns using "Search Specific Type" now

Type" displays one blank qbe list.

displays the qbe list correctly.

When you input text that can be rendered as

When you enter text that can be rendered as HTML in

HTML in the Notes field under Incident -> More,

the Notes field under Incident -> More, the text is now

the text is rendered as HTML, even though it

displayed as plain text.

should display as plain text. For example, if you
enter the following in the Notes field:
<table>someinfo1</div> someinfo2</div>
someinfo3</div> someinfo3</table>
This text is rendered as an HTML table, instead
of plain text.
QCCR1E84746

An error exists in RAD

The us.unload.delete.wrapper now calls

us.unload.delete.wrapper on the check.done

us.unload.delete and checks the result correctly.

panel.
QCCR1E87617

Inconsistent permission behavior when a

Fixed the permission check when viewing published

published doc or the doc from a link is

documents so that the behavior is now consistent.

displayed.
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QCCR1E87729

The Close Incident button is not displayed for

The Close Incident button is displayed for Incident

Incident operators if the "Allowed" status is

operators who have the "Allowed" status specified in

specified in their profiles.

their profiles.

An ESS session crashes with a Signal 11 error

The apm.mb.ok RAD application checks for the $G.bg

after you update an Interaction. This issue

flag, bypasses the dialog box, and then issues a

occurs when the RAD flow attempts to display

message by using the msg panel.

QCCR1E87848

a dialog box from a background action.
QCCR1E88011

When you try to update an Incident, you

Users can now compare an old incident with a new

receive a notification error. This issue occurs

incident file in a notification after a save, update, or

when there is no value for $file.save in

close action.

us.notify. This causes the SD records to be
locked and they cannot be unlocked.
Investigation shows that the 'us.linker.remove'
application exits an error, but does not unlock
the SD record.
QCCR1E88246

CI visualization can build a very long series of

There are no error messages when CI visualization has

'or' queries that cannot be parsed by the server.

long queries. The ScriptLibrary builds queries by using

This results in an error message or a Signal 11

'isin' instead of 'or,' solved this issue.

error.
QCCR1E88537

When you specify the following DEM rule, a CI

A CI is created successfully after you close the

is not created after you close a Change:

Change.

[Open a Change] for [Action if matching record
does not exist]
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QCCR1E88801

When the following error occurs in an alert

When the Unrecoverable error occurs in an alert

process, the alert background process locks

process, the associated incident ticket is now unlocked.

the associated incident ticket:
"RAD E Unrecoverable error in application:
se.call.process on panel call.rad.1"
QCCR1E88790

Link fields on Template Update do not work

Link fields now work as expected.

when you run a mass update on a joinfile. This
behavior occurs if the link is only on a device
link and if the CI type has a second link on an
attribute file or CI format.
QCCR1E88885

SLA alerts for an Incident tickets are deleted

SLA alerts for an Incident tickets are deleted correctly.

only after the operator record is updated.
QCCR1E88939

QCCR1E88984

All non-English scmessage records are deleted

Non-English scmessage records are not deleted when

when you try to create a production patch.

you try to create a production patch.

A language format issue prevents you using the

The "Execute Commands" function works as expected

kill command to terminate sessions in the

in non-English environments.

status monitor.
QCCR1E89086

After you set the "items per page" value and

You can configure the "items per page" value as

then click the "Refresh Display" button on the

expected.

system status page, the "items per page" value
reverts to 20.
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QCCR1E89342

There is no validation of the configuration

A validation was added in configurationItem format

admin group in Configuration Management.

control to validate the input against the assignment
group table(assignment).

QCCR1E89403

QCCR1E89449

QCCR1E89778

The Assignment Group in a Known Error Task

The Assignment Group in a Known Error Task can now

cannot be changed.

be changed.

Add a check to the APM tool to verify the value

A new notes wizard page has been added in the first

of the sessiontimeout and ir_disable

step when you apply a patch. This page informs the

parameters in sm.ini.

user to check the related settings.

After you place an SRC request or an order

The sd.catalog.request RAD is recompiled so that data

from the Service Catalog, the corresponding

is not lost.

Change is either "opened," "in progress," or
"closed." However, after some time, the
svcCart for the Interaction disappears, and the
cartId field in the Interaction is NULL.
Additionally, if you display the cartId field in a
list of Interactions, the field is empty. However,
if you check the record (cartId in $L.file), the
field is populated. The svcCart for an
Interaction will not disappear, and the field
cartId in the Interaction is set to proper cart Id
value.
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QCCR1E89774

You cannot submit the cart in ESS if the

The "Title" field is now populated by using the first non-

"Purpose" field contains an empty line at the

NULL line of the "Purpose" field, which enables you to

start. This issue occurs because the "Title"

submit a cart if the "Purpose" field contains an empty

field is populated by using the first line of the

line at the start.

"Purpose" field.
QCCR1E89814

The Approval status field for service catalog

The Approval status field for service catalog tickets is

tickets is null, regardless of whether they

not Null.

require approval. This behavior prevents the
generation of IM or quote tickets.
Note: Not all the SCAT tickets have the
Approval status field set to null.
QCCR1E89815

The kmknowledgebaseupdates table becomes

The kmknowledgebaseupdates table no longer gets

corrupt, and records become stuck in the

corrupt, and records are not stuck in the

kmknowledgebaseupdates queue. This

kmknowledgebaseupdates queue.

behavior causes the KMUpdate background
process to crash. This issue occurs because of
an incorrect OR conjunction that should be an
AND conjunction.
QCCR1E90058

Interaction templates do not display saved

The wizard:template.editValue_globallist_array is

values in the Assignment Group field.

modified to properly parse $field.values and display the

Interaction templates display saved values in

field values when you edit templates.

the Assignment Group field properly.
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QCCR1E90070

After you upgrade to Service Manager 9.31,

The defect is fixed by recompiling the RAD

problems may occur with the configuration

scauto.inventory.

management module. Specifically, after you
attempt to add or update a configuration item
record by using Connect-It together with an
icma, you receive the following errors:
2012/12/21 09:39:13.000 0 4 Cannot execute
application: scauto.inventory
2012/12/21 09:39:13.000 0 4 Unrecoverable
error in application: scauto.inventory on panel
call.base.method
2012/12/21 09:39:13.000 0 4 Unrecoverable
error in application: se.base.method on panel
start
2012/12/21 09:39:13.000 0 4 Process panel
start in RAD se.base.method encountered error
in line 13 (se.base.method,start)
QCCR1E90161

QCCR1E90286

When you save a new configuration item, the

No errors are thrown by the "StrngUtil" script when you

'StringUtil' script throws errors.

save a new configuration item.

Alert times for 25%, 50%, and, 75% of an SLA

Alert times for 25%, 50%, and, 75% of an SLA are

are calculated incorrectly in Service Manager

calculated correctly when you use the day schedule.

9.31 when you use the day schedule.
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QCCR1E90525

There is no mandatory option available when

The mandatory option is available when you create a

you create a Pick List User Selection for

Pick List User Selection for service and support catalog

service and support catalog items in Service

items.

manager 9.31.
QCCR1E90573

The Response Time Results of Service

The completed.time field is added to the svcCArtItem

Catalog item SLOs are calculated incorrectly.

table. You can use the completed.time field as the End

The Response Time Results of Service

time field in slamodulecontrol.

Catalog item SLOs are calculated correctly.
QCCR1E90658

When linker copies updates from related

When linker copies updates from related Incidents or

Incidents or Changes to Interactions, the time

Changes to Interactions, the time stamp in the update

stamp in the update log of the Interaction uses

log of the Interaction uses the specific timezone of the

the default or system date format Incorrectly,

logged-in user.

rather than the date format pertinent to the time
zone the Interaction was opened in.
QCCR1E90790

QCCR1E90787

RAD applications do not check the record size

RAD applications check the record size limit correctly

limit correctly. This causes slow performance.

and with no performance issue.

When you click “Back” or the “X” button on the

When you click “Back” or the “X” button on the Select

Select Groups window, the review process is

Groups window, the review process is not completed.

completed.
QCCR1E90770
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QCCR1A156582

Service Manager creates duplicate incidents

Now, Service Manager only creates one incident for a

for a single OMi event.

single OMi event.
Note: This fix may cause performance downgrade if the
Service Manager system has a large amount of
incidents. The root cause is that
'external.process.reference' is an array field and it
resides in table m2.
To avoid performance downgrade, you need to move the
array field "external.process.reference" from the m2
table to an alias table as described below:
1. Click Tailoring > Database Dictionary.
2. Type probsummary in the File Name field and
then click Search.
3. On the SQL Tables tab, add a new table a2.
If the a2 value has already been used, use the first
available value between a2 and a99, depending on
your specific implementation.
4. On the Fields tab, change the SQL table for the
external.process.reference fields:
n

external.process.reference (array type): change
the SQL table from null to a2 (or whatever value
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you assigned in step 3 above).
n

external.process.reference (character type):
change the SQL table from m2 to a2 (or
whatever value you assigned in step 3 above).

5. Click OK to save the changes.
This will solve the performance issue.
QCCR1E90827

Interactions that are waiting for approval are

If the Cart has been changed , the Approval records

invisible in SRC if the Cart has been changed.

generated before will be considered dead and are now
removed to prevent this issue.

QCCR1E90876

The linker background process loses the scope

The scheduled update of an Incident ticket does not use

of the $pmc.actions variable after executing an

linker post values from another record.

Interoperability Record schedule record.
QCCR1E90893

When you click the Insert an image button in

The table object that displays the attached documents

the HTML editor in SM 9.31 Web tier, the table

on the Select Document Attachment page of the wizard

object that displays the attached documents on

is displayed correctly.

the Select Document Attachment page of the
wizard is displayed to the right of the screen
and cannot be accessed.
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QCCR1E90927

After users create Favorites Folders or Views,

After users create Favorites Folders or Views, they can

it is not correct behavior to set the selected

only set the selected groups to groups that are included

groups to groups that are NOT included in the

in the user's query groups defined in the operator record.

user's query groups defined in the operator
record.
QCCR1E90994

QCCR1E91035

The cursor does not return to the array field that

The cursor returns to the array field that is defined by

is defined by cursorPosition.

cursorPosition.

When you perform a search in Knowledge

The search result returns the correct document count,

Management, and you type some key words in

and no documents contain the omitted key word.

the "none of these words" field, the search

Additionally, an option is added to remove highlighted

result returns an incorrect document count, and

search results in attachments.

some documents still contain the omitted key
word. Additionally, highlighted search results in
attachments causes a performance decrease.
QCCR1E91092

You cannot use the 'file.load' application to load

You can load interaction records via the command line.

interaction records from the command line.
QCCR1E91148

QCCR1E91171

OMi events generate duplicate incidents in

Service Manager does not create duplicate incidents for

Service Manager.

a single OMi event.

A subcategory field in an ocmq record is not

The subcategory field in ocmq records is populated with

filled when a quote is created by the linker.

the last line item category when a quote is created by
the linker.

HP Service Manager (9.32)

Page 138 of 229

Release Notes
Fixed Defects

CR

Problem

Solution

QCCR1E91367

The autoformat rule of a view does not work

The autoformat rule of a view works as expected if you

properly if you add the rule to a field that has an

add the rule to a field that has an IR Key.

IR Key.
QCCR1E91416

QCCR1E91579

The sla.refresh.active application takes a long

The sla.refresh.active application takes the expected

time to process the validate.duration.field panel

time to process the validate.duration.field panel without

without a database query.

a database query.

Pick list columns are mismatched in the User

Pick list columns now match correctly.

Selection options if a value is deleted from the
list.
QCCR1E91650

If you use "Order from Catalog" to place an

The svcCart record for the order is not deleted.

SRC order that opens a change when the order
is approved, and then another user change
modifies the order, the svcCart record for the
order is deleted, and the cartId field in the
interaction is NULL.
Additionally, if you display the cartId field in a
list of interactions, the field is empty. However,
when you check the record (d cartId in $L.file),
the field is populated.
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QCCR1E91785

SvcCart records are deleted incorrectly when

The svcCartHelper.ClearDeadCartItems script is

they are modified by multiple users. SvcCart

changed so that only the dead cart and cartItems that

records are not deleted when they are modified

are owned and modified by the login user are checked

by multiple users.

and cleared. This behavior rules out the card and
cartItems that are currently modified by another user on
behalf of the login user.

QCCR1E91769

When you select Options > Order From

The Interaction approval status is now set correctly.

Catalog > Cancel in an Interaction, the
Interaction approval status is set to "approved."
QCCR1E91772

QCCR1E92149

SRC generates a "request submission failed"

SRC generates a message that notifies you the request

error when you submit a request outside of the

is outside service hours for SLA when you submit a

SLA hours.

request outside of the SLA hours.

Quote line items that have two dependent

Quote line items that have two dependent quote line

quote line items are ordered when only one of

items are ordered when both of their dependent quote

the dependent quote line items is closed. The

line items are closed.

expected behavior is that the quote line item is
ordered when both of its dependent quote line
items are closed.
QCCR1E92230

Security roles are not interpreted correctly after

You can use a template that is created for a specific

templates that have related folder definitions

security folder.

are applied.
QCCR1E92300

You cannot generate new reports by using the

The report can be generated and printed as expected.

OOB Report Writer functionality.
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QCCR1E92489

The "Update when closed" property in Problem

The "Update when closed" property in Problem

Management Security Profile on the Known

Management Security Profile on the Known Errors tab

Errors tab does not work. Therefore, users

works as expected, and users can update closed known

cannot update closed known errors.

errors.

You search for knowledge from an interaction

You return to the search result page after clicking the

and then you use a solution. Then, you search

Cancel button in the View Record Detail page.

QCCR1E92622

for and view a document from the same
interaction again. When you click Cancel from
the document view, you expect to return to the
Related Search Knowledge Base screen.
However, you return to the interaction ticket.
QCCR1E92804

It is possible to order an inactive item when the

The inactive items are no longer displayed in the "Most

item is visible in the "Most Popular Requests"

Popular Requests" section.

section.
QCCR1E92780
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QCCR1E93038

After you upgrade from Service Manager 9.20

The Relative Date feature in the Advanced Filter tab of a

to Service Manager 9.31, the Relative Date

search screen works as expected.

feature in the Advanced Filter tab of a search
screen no longer works as it did in Service
Manager 9.20. Specifically, the
Filter.parseAdvanced RAD is updated
(specifically the set.equals panel) so that every
date field is surrounded by the date() function.
This causes a full table scan against the
database, and users experience a session
timeout on the web client.
QCCR1E93111

QCCR1E93277

QCCR1E93367

When loading incident records via the

This issue is caused by an uninitialized variable in the

command line, errors are generated in the

RAD code. The RAD code is now modified not to use

sm.log file, and the load operation fails.

an uninitialized variable.

The svcCartItem's duration and schedule is not

The duration and schedule now use the information from

correct.

the objective delivery of selected items .

The generated JS from the WSDL to JS utility

The generated JS from the WSDL to JS utility in SM

in SM 9.31 generates different script than in

9.31 is correct.

7.11. This prevents the interface from
connecting to the external system.
QCCR1E93622

QCCR1E93678

HP Service Manager (9.32)

The SLA expiration time cannot be refreshed

The SLA expiration time can be refreshed after the

after the duration field is changed.

duration field is changed.

Notifications generate duplicate emails to

Notifications do not generate duplicate emails to

approvers when an Approval is added.

approvers when an Approval added.
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QCCR1E93812

It takes a long time to apply the Service

A useless operation was removed to improve

Manager 9.31 application patch.

performance when you apply the application patch.

The Elapsed Time in the sloresponse table is

Elapsed time is calculated based on the order of

calculated incorrectly.

consecutive holidays.

There are issues accessing and cancelling out

You can access and cancel out of Knowledge

of Knowledge Documents that you access via

Documents that you access via a link from another

a link from another Knowledge Document.

Knowledge Document as expected.

QCCR1E93868

QCCR1E94134

Specifically, when you click on the link you are
not taken directly to the linked document.
When you cancel out of the document, you are
taken back to the Main Menu instead of the
source document.
This problem only occurs in Service Manager
9.31 webtier using ess.do.c
QCCR1E94227

On the Request Management line category

On the Request Management line category selection

selection screen, selecting 'Back' may have no

screen, selecting 'Back' works as expected.

effect.
QCCR1E94268

When you export the content of a column that

Performance is improved when you export content and

is reformatted by using a global list, the export

a large amount of items are in the global list.

process is slow.
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QCCR1E94283

The advanced search function in Knowledge

The advanced search function in Knowledge

Management does not return correct results

Management returns correct results when you use the

when you use the "Status" field to filter the KM

"Status" field to filter the KM libraries.

libraries. For example, if you choose the
knownerror library, select "Open" from the dropdown list in the "Status" field, and perform a
true search, no result are returned. However, if
you perform the same search, but manually
type "open" in the "Status" field, the correct
results are returned.
QCCR1E94329

Tabs that contain unsaved changes can be

A dialog box prompts users to confirm that they want to

closed directly.

discard unsaved changes when they click the "x" button
on the tab.

QCCR1E94634

When you approve an interaction and a

The "sm.final.approval" notification does not fail for

conditional statement contains "$L.file.save,"

svcCartItem approvals, and you do not receive an error

the "sm.final.approval" notification fails for

message when you approve an interaction and a

svcCartItem approvals, and you receive an

conditional statement contains "$L.file.save,".

error message.
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QCCR1E94683

There is a leading space before "Work In

The leading space is removed from the term "Work in

Progress" in the validation condition of (not null

Progress" in the "rootcause" format control.

(assignee.name in $file)) of "rootcause" format
control. For example, there are invalid terms in
the format control rootcause, validations, line
12 (demanding not null(assignee.name in
$file)). The Add-, Update, and Delete
conditions, contain the following term: (status
in $file) is in {"Accepted", " Work in Progress"}.
QCCR1E94697

The correct Date/Time format is not identified

The Date/Time format in the Catalog Information

from the operator profile in the Catalog

section is adjusted to match the operator's profile.

Information section on both Service Manager
Windows clients and Service Manager
Windows web clients in SRC 1.30p2 Hotfix 24.
QCCR1E94733

When a problem record is locked by an operator

When a problem record is locked by an operator

session, another operator can still change the

session, other operators cannot change the record by

record by using the "Next Phase" or "prior

using the "Next Phase" or "prior Phase" actions.

Phase" actions.
QCCR1E94767

QCCR1E94862

The cm3r Data Policy changes are overwritten

The cm3r Data Policy changes are not overwritten when

when you apply an applications patch.

you apply an applications patch.

The Refresh button on the queue screen in

The Refresh button on the queue screen refreshes the

Service manager 9.31 does not refresh the

queue correctly.

queue in the same manner as earlier versions
of Service Manager.

Page 145 of 229

HP Service Manager (9.32)

Release Notes
Fixed Defects

CR

Problem

Solution

QCCR1E94961

Dependent line item orders are generated

Dependent line item orders are generated correctly,

incorrectly when an item is dependent on

regardless of the number of dependent items.

multiple items in different groups that have the
same group name in Service Manager 7.11.
QCCR1E95020

QCCR1E95120

Costs are not converted to the approver's

Costs are converted to the approver's operator currency

operator currency in "Edit bundle components."

correctly.

When you add a new option to a Process

When you add a new option to a Process Designer

Designer workflow ruleset in a Phase, will

workflow ruleset in a Phase, displayoptions are

cause unpredictable results when

executed properly as expected.

displayoptions are executed.
QCCR1E95206

The "To Do" page closes unexpectedly if you

The "To Do" page does not close unexpectedly

choose a view that has an xss expression in its

Additionally, you can input only upper and lowercase

name.

letters, numeric digits, hyphen, dot, underscores, the
percentage character (%), and blank signs in the view
name.
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QCCR1E95182

After you apply the HP Service Manager HTML

The following buttons in the HTML editor of Service

Email Solution, the following buttons in the

Desk now work the same way as they do in Knowledge

HTML editor in Service Desk do not work the

Management:

same way as they do in Knowledge
Management:

l

Insert an image

l

Insert an image

l

Insert a link toward an attached file

l

Insert a link toward an attached file

l

Insert a link toward another record

l

Insert a link toward another record

This issue was solved by copying the solution from
Knowledge Management to HTML Templates.

QCCR1E95192

An error occurs when you search for knowledge

No error occurs when you search for knowledge with the

in the incidents or probsummary record and the

kmmapping field added.

name of "target search field" contains a period
(.). This issue occurs after new field mapping is
added to the Search tab of the kmmaping file.
QCCR1E95417

When you mouse over a CI, CI visualization

When you mouse over a CI, the tooltip for the CI node

only displays the CI name instead of additional

displays correctly.

information. Specifically, the Type and Subtype
are missing.
QCCR1E95472
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SRC do not allow you to approve an approval.

be used to approve approvals as expected.
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QCCR1E95642

An incorrect exit exists for a process that has

The exit in the process is correct ("prepare.rule.lookup")

an "init.relationship" label in the

and the correct DDM rule is selected.

"ddm.processData" application. Therefore, an
incorrect DDM rule is selected.
QCCR1E95827

After you apply QCCR1E78572_SM931.unl to

The "Password Change" utility returns appropriate error

a Service Manager 9.31 system, password

messages.

change error messages do not function as they
did before.
QCCR1E95994

An item that has a "denied" approval status

Users can define whether the approval status is reset or

switches to "pending" status if another item in

not.

the cart is modified.
QCCR1E95958

QCCR1E96066

When approving a request (Change) in SRC

When approving a request (Change) in SRC and adding

and adding approval comments, the approval

approval comments, the approval comments are saved

comments are not saved to the approval log.

to the approval log.

In Service Manager 9.31, the deadline alert

The deadline alert function for incidents now works

function for incidents incorrectly uses intervals

correctly.

instead of expressions.
QCCR1E96059

HP Service Manager (9.32)

An error message is thrown, which prevents

No error message is thrown when updating the

users from saving updates to interactions.

interactions.
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QCCR1E96161

CI visualization does not display the tooltip of

CI visualization now inserts a line break for each

an Array type field correctly.

element of the tooltip into Array type (multi-line text)
fields. If the length of one element is greater than 55
characters, the line is truncated with an ellipsis mark
(...).

QCCR1E96960

The Inactivity Timer mechanism needs to be

The Inactivity Timer mechanism has been refactored for

enhanced to improve performance.

better performance.

The default value of the inactivity timer is set in

The inactive.startup background process is now

the scheduler application. When the user logs

obsoleted, which eliminates the need to start this

in, the SM server needs to fetch it from the

process in order to start the Inactivity Timer. Once your

database, which may result in performance

server has upgraded to 9.32 or later, you can delete this

issues.

process if it still appears in your System Status's Start
Scheduler list.
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QCCR1E97049

The enable script throws an error if the

The enable script does not throw an error.

ModuleStatus or extaccess data is modified in
an environment that has PD CP4 applied.
The error occurs if the following conditions are
true:
l

The ModuleStatus "probsummary-Work in
Progress" is not found.

l

The extaccess "probsummary" or
"rootcause" is not found.

This error blocks the enable process.
QCCR1E97158

When upstream CIs are grouped, the grouped

Upstream CIs appear above the target CI in hierarchical

node appears below the target CI in hierarchical

mode.

mode.
QCCR1E97332
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The "Unload Manager" menu item disappears

The "Unload Manager" menu item displays correctly

after you apply PD CP4.

after you apply PD CP4.
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QCCR1E97362

A true query is executed against the svcCart

The true query is no longer executed.

dbdict. This causes a performance problem
when items are ordered from the Service
Catalog.
3368( 492) 06/26/2013 20:04:51 RTE D
RADTRACE 5258 [ 0] svcCart.update.sdID
select.svcCart select CPU( 0 732 )
3368( 492) 06/26/2013 20:04:51 RTE D
(0x3A9AA420) >DBACCESS - Select against
file svcCart
3368( 492) 06/26/2013 20:04:57 RTE D
DBQUERY^F^svcCart(oracle10)^0^0.000000^
^500^5.616000^"true"^ ^0.000000^0.000000 ( [
0] svcCart.update.sdID select.svcCart )
3368( 492) 06/26/2013 20:04:57 RTE D
(0x3A9AA420) >DBACCESS - Select against
file svcCart in 5.616000 seconds [rc=0 ]
(cartId=4568)
QCCR1E97581

The name of the Change tab is "Change

The name of the Change tab is now "Change

Accessment" instead of "Change

Assessment".

Assessment".
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QCCR1E97568

The Mass Cancel button is missing from the

The Mass Cancel button is available in the Change

Change Tasks search list when

Tasks search list when viewrecordlist=false.

viewrecordlist=false.
QCCR1E97755

The "hotfix.manager" form on the "Unload

The "Unload Manager" page displays correctly.

Manager" page does not display correctly.
QCCR1E97867

When cursor.field.name.set() is used in a

When cursor.field.name.set() is used in a display

display option, it does not work. Specifically,

option, the cursor focuses on the specified field in the

the cursor stays where it was before.

display option.

Integrations
CR

Problem

Solution

QCCR1E56128

Release Control receives no results when

Release Control can retrieve records from Service

requesting Service Manager to retrieve the

Manager via a Web service to get the latest changes for

latest changes for display in the Change

display in the Change Calendar.

Calendar. No records are found.
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QCCR1E84364

When “Run in Multi-Company Mode” is enabled

The UCMDB integration now creates changes or

in the System Information Record in Service

incidents in SM successfully without errors.

Manager (SM), the UCMDB integration fails to
create changes or incidents in SM because the
configuration item data modification event fails.
The following error occurs:
ERROR TypeError:
lib.uCMDBConfiguration.isEnable is not a
function at char 1
QCCR1E91727

When you invoke an OO flow from Incident or

If no fileName variable is passed to SM, a activity log

Knowledge Management, updates from OO are

record is updated/added as expected.

not created in the activity log.
QCCR1E91828

When you change a single 1-to-1 relationship for

When a cirelationship record status is updated, only the

a configuration item, all relationships for that

relationship of the cirelationship is affected.

configuration item are affected.
QCCR1E97064

You cannot select a different value in the fill/find

Now you can select a different value in the fill/find widget

widget in the build additional filter panel in

in the build additional filter panel in Survey.

Survey.
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QCCR1E87775

In catalog items with date fields, the date

Converted the date format of the logged-in user to GMT

format displays in US date format despite

in user options.

users in other countries logging the request and
their regional settings on their PC are set to
their country of origin. The Operator and
Contact records for these users also have their
regional time zones and date formats applied.
QCCR1E90082

When you approve a line item request in SRC,

The "Approve" and "Deny" buttons now always display.

the "Approve" and "Deny" buttons on the
request are randomly appearing or
disappearing.
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QCCR1E91429

Consider the following scenario in SRC 1.4

This issue has been resolved by applying the unload

under SM 9.31:

file: "QCCR1E91429.unl".

l

l

Your Service Desk profile does not allow

SM can return the error code to SRC, so SRC can

you to close an interaction ticket.

determine the "close" action is negative.

You submit a support ticket to the SRC, and
then you click the Status button.

l

In the details of the ticket, you click the
Close button.

In this scenario, you receive the following error
message:
Unexpected exception: Runtime error or
exception incurred in server. Please contact
your administrator.
QCCR1E91771

QCCR1E91922

SRC generates a "request submission failed"

Now SRC generates a message to show the request is

error when you submit a request outside of the

outside service hours for SLA when you submit a

SLA hours. This defect is fixed.

request outside of the SLA hours.

Setting applicationContext.properties:

Disabled support requests in the account inbox when

src.sm.enableSupport=false in SRC 1.4

the src.sm.enableSupport is set to false.

cannot hide the Support tab. The footer still has
the Support link, which directs the user to the
Support section of SRC.
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QCCR1E94739

When approving a request (Interaction, Change

When approving a request (Interaction, Change or

or Quote) in SRC and adding approval

Quote) in SRC and adding approval comments, the

comments, the approval comments are not

approval comments are saved to the approval log; even

saved to the approval log.

if the 'Require app.comments' is not checked in the doc
engine, the system also writes the comments to the
database.

QCCR1E97365

If you have SRC 1.40 installed together with

SRC works normally after you apply the Process

SRC 1.40 Hot Fix 5 or 6, SRC stops working

Designer Content Pack 9.30.3. You must also apply the

after you apply Process Designer Content

following unload files for Process Designer hotfixes

Pack 9.30.3.

over the previous versions of the unload for SRC to
work again:
l

PD4_SRC1.40HF5_QCCR1E90727.unl

l

PD4_SRC1.40HF6_QCCR1E91429.unl

Language Pack
The Service Manager 9.32 language packs fix the following localization defects.
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QCCR1E48936

For all languages, including German, Spanish,

The "Yes" and "No" button labels have been translated

French, Italian, Dutch and Portuguese, the

for all supported languages.

Message, and the "Yes" / "No" button text in the
popup box should be translated to the local
language (such as "You have unsaved changes
to this record. Save them now?).
QCCR1E73102

On a system that has the Brazilian Portuguese

The web tier client renders objects in Portuguese

Language Pack installed, the web tier client

correctly.

renders most objects in English when the
browser language is set to Portuguese.
However, if you set the browser language to
English, forms render in Portuguese correctly.
QCCR1E94928

When upgrading the applications using this

These localized formats have been updated for the

upgrade path: SM 9.30 apps + Spanish

UCMDB Integration.

Language Pack + UCMDB Content Pack + SM
9.31 apps, none of the Spanish forms for
CM.relationship, CM.relationship.qbe,
CM.relationship.type, CM.relationship.type.qbe
are getting updated to look like the English
formats. The relationship type fields remain
there in the English formats for logical/physical
values that have been removed in the 9.31 apps
by design.
QCCR1E97779
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QCCR1E72320

After upgrading from SM 7.11 to SM 9.30 by

Updated the upgrade guide to let users ignore the

using SM 9.30 Upgrade Patch 3, the following

licenseinfo exception in the except.log file, and also

error is logged in the except.log file:

modified the code to ignore the licenseinfo exception in

"licenseinfo, field:id, field type is character --

the except.log file.

expected to be:number"
Once the id field is changed to number, you
cannot log on to Service Manager.
The documentation should reflect that this
change should not be made. Additionally, the
upgrade utility should list this as an exception
because customers cannot log in after making
the change to the "id" field in the licenseinfo file.
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QCCR1E77116

NEW930, PRE<version>, and OLD<version>

For the Purge Existing Upgrade Files feature, an option

records still exist after applying a custom

was added to only remove duplicate upgrade records that

upgrade package. It is time-consuming to delete

are prefixed with "NEW", "PRE" or "OLD".

these records manually.

This option not only removes duplicate upgrade records,
but also makes upgraded display screens and display
options effective, and re-compiles upgraded display
screens.
The unique key values of the removed duplicate upgrade
records and re-compiled display screen records are
logged in the detail.log file.
There are some sample messages in the detail.log:
4 06/19/13 02:41:32 Start purging duplicate upgrade
records prefixed by NEW, PRE and OLD...
4 06/19/13 02:41:33 Finished purging
scmessage;syslanguage="OLDSM7en" and
class="object" and message.id="49"
......
4 06/19/13 03:19:18 Finished purging with 17668
duplicate upgrade records prefixed by NEW, PRE and
OLD.
4 06/19/13 03:19:18 Start compiling displaycreen
records...
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4 06/19/13 03:19:18 Compiling
displaycreen;screen.id=CM.select.depts
......
4 06/19/13 03:19:26 Finished compiling 476
displayscreen records.
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QCCR1E78893

Cannot merge certain records when upgrading

No error occurs when merging certain records during an

from SM 9.20 (No applications patches) by

upgrade from SM 9.20 (No applications patches) by

using SM 9.30 Upgrade Utility (UP5).

using the Upgrade Utility.

The following error is received when a merge is

The missing xml files have been added.

attempted:
Process panel get.xml.data in RAD
run.merge.tool encountered error in line 1
(run.merge.tool,get.xml.data)
Cannot evaluate expression
(run.merge.tool,get.xml.data)
Bad arg(2) oper = (run.merge.tool,get.xml.data)
Cannot evaluate expression
(run.merge.tool,get.xml.data)
Script 'upgradeHelper' line 337: ERROR
TypeError: strAncestorXml.replace is not a
function at char 1
Unable to open file /dev/Install_Files/930_
UpgradeUtilities/SM9.30UP5/AppUpgrade/localized_app_
upgrade/SC6.2-9.30.002_v1.5_
L10N/3waymerge/oob/9.2/
link/contacts.search.xml for reading
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CR

Problem

Solution

Unrecoverable error in application:
se.call.process on panel call.rad.1
Unrecoverable error in application:
run.merge.tool on panel get.xml.data
QCCR1E88133

QCCR1E88260

The SM7.11 Application Patch 3 signatures are

The SM7.11 Application Patch 3 signatures have been

not included in the upgrade package.

included in the upgrade package.

After an initial upgrade from 7.11ap1/7.11ap2

For the Purge Existing Upgrade Files feature, added

with UP3, there is some duplicate data prefixed

code to remove duplicate data prefixed with

with OLD7.11.000.

OLD7.11.000.

Service Request Catalog (SRC)
CR

Problem

Solution

QCCR1E77087

When searching employees and one of the

"An Error occurred" This issue occurs because of a null

employees in the returned search list has a

pointer on username. Now, there is a check to prevent

contacts record with no value for the operator.id,

the null pointer exception from occurring.

the following error message is received:
QCCR1E77950

If you fill "999999999999999999999999" as the

"NewServer - Validation failed Additional Harddisk Size

value in a number-field in a Service Request, the in GB (1) is mandatory Additional Harddisk Size in GB (1)
value is replaced by "2147483647." If the order

is mandatory" This issue is resolved by accept the big

process is continued, the following error is

integer as a Double type in the SM server.

received one-click before the SD is created:
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CR

Problem

Solution

QCCR1E78754

The total cost for a Catalog item with default

This occurs if there are default settings for user

settings is not calculated correctly. This is

selections in a catalog item. The value with space

noticeable in the pending request status details

character in the picklist is calculated to cost.

page in SRC.
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CR

Problem

Solution

QCCR1E78892

You cannot add attachments through SRC

With the new upload feature, attachments can be

when running in a TSO environment.

uploaded correctly even under an SSO authentication

With the new upload feature, attachments can
be uploaded correctly even under an SSO
authentication environment (such as NTLM). To
enable the new upload feature, set the new
src.security.flex.UploadByURLLoader property

environment (such as NTLM). To enable the new upload
feature, set the new
src.security.flex.UploadByURLLoader property to "true"
in applicationContext.properties.
Note the following limitations of the new upload feature:

to "true" in applicationContext.properties.
l

SRC only supports attachment files that are less than

Note the following limitations of the new upload

< 30 MB. If user selects a file that is greater than 30

feature:

MB, the Upload button will not appear.

a. SRC only supports attachment files that are
less than < 30 MB. If user selects a file that is

l

An indeterminate progress bar will show instead.

greater than 30 MB, the Upload button will not
appear.

The accurate progress of Uploading will not display.

l

When a user uploads a large file ( > 10 MB), the GUI

b. The accurate progress of Uploading will not

may apparently hang for some time after the Upload

display. An indeterminate progress bar will show

button is clicked. This time depends on the size of the

instead.

file and the performance of user's local machine. We
recommend uploading files that are less than 10 MB.

c. When a user uploads a large file ( > 10 MB),
the GUI may apparently hang for some time
after the Upload button is clicked. This time
depends on the size of the file and the
performance of user's local machine. We
recommend uploading files that are less than 10
MB.
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CR

Problem

Solution

QCCR1E79169

When adding a comment to a request in SRC in

Updated the urgency label from English to French in the

a locale other than English, the comment is not

support interaction page.

posted and a localized error is received.
QCCR1E79281

When you open an Incident of the Request for

The Change Management module is now available from

Change type in the SM Web Client tier or in the

the Choose Type dropdown list.

SM Windows Client, the category is displayed
as a Request for Change. However, if look at
the same interaction in SRC, the category is
displayed as "Incident."
QCCR1E79594

The statuses of the individual items in a bundle

This issue occurs because of the difference between null

are not displayed. If the items that make up the

and "" when comparing bundle item properties. By

bundle are ordered as individual items and then

ignoring this difference, the issue has been fixed.

submitted as one SD, the item status values
can be displayed correctly.
QCCR1E80249

Date formats display in the US date format

This issue is not related to user's profiles. Now, SRC

(where the server is located) despite users

uses a fixed GMT date format (yyyy/MM/dd HH:mm:ss),

logging the request from another country (so the

and the time zone information was added to the item

regional settings on the PC differ). This behavior

option.

occurs even though these users Operator and
Contact records also have Australian time
zones and date formats applied.
QCCR1M5068
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Images that are embedded in a Knowledge Management

Management document appear as a red X.

document now display normally.
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CR

Problem

Solution

QCCR1M5235

With Process Designer Content Pack 9.30.1

Now, the approve delegation capability is retrieved from

applied in Service Manager, after logging in to

a global variable, but the selection list is from the profile

SRC, an operator who has a required change

table.

security role (for example, a system
administrator) cannot select the Change
Management module for Approval Delegation
(on the Approval Delegation page, the Change
Management module is not available from the
Choose Type dropdown list).
QCCR1E88365

QCCR1E88960

After submitting a support case through SRC,

This issue has been fixed by adding a maxwidth attribute

the contact information is truncated in the status

to the "TileLayout" component in the supportrequest

record.

details and servicerequest details pages.

When you perform a Knowledge search in SRC

Now, SRC ignores the missing fields, and a warning

1.4 together with an upgraded SM 9.31, the

message is logged on the server.

catalog items that contain the search terms
show up, but a run-time error appears on the
screen and nothing is returned. This issue
occurs when the "category" or "categorystr"
fields are missing in KM document and SRC
could not handle this case.
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CR

Problem

QCCR1E89728

The URL generated from the Notification engine

Solution

by using the urlCreator Script Library is not valid
and does not take the user to the service
request/approval page. SRC defines a new URL
format to access the service and approvals. The
urlCreator Script Library is updated to align with
this change.
QCCR1E89904

Consider the following scenario when your

In this scenario, SRC only displays the following error

Service Desk profile does not allow you to close

message:

an interaction ticket:
1. You submit a support ticket to Service
Request Catalog (SRC), and then you click

"You do not have permission to close this
support request. Contact your Service Manager
administrator."

the Status button in the pop-up dialog box.
2. You click the Close button in the request
details page.
In this scenario, SRC displays the following
error message:
Unexpected exception: Runtime error or
exception incurred in server. Please
contact your administrator.
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CR

Problem

Solution

QCCR1E90727

After an SRC order from catalog order has been

Now, the cartID field is added to the Interaction records

placed, a change is opened and is in progress or

for SRC Requests. Therefore, when the user submits an

even closed. However, after some time, the

SRC request, the cartID field is populated in the list of

svcCart for the Interaction no longer exists.

Interactions.

In addition, the cartId field appears empty if you

Note: The fix for this issue is delivered via an unload file.

view the field in a list of Interactions, but the

You must load the unload file into Service Manager for

field is populated if you check the record (d

this fix to take effect.

cartId in $L.file).
QCCR1E91065

In SRC, when an interaction is locked for an

This CR only fixes the issue of runtime error message in

update, a runtime error appears. However, SRC

SRC, the enhancement to check the lock status when a

should display a more user-friendly message.

user clicks update is handled in another CR.

Additionally, when a user clicks on update,
locks should be checked at that time, so the
user does not enter in an update that cannot be
submitted due to the lock status. This behavior
leads to a great deal of user frustration.
QCCR1E91589

The back arrow icon for the Back button in the

The back arrow icon was changed to a link button

detail item page does not clearly reflect the

together with an icon and label.

button's function.
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CR

Problem

Solution

QCCR1E92867

You create a request in SRC 1.40 using a

You can see these options in SRC even if you do not

catalog item, for which you have prepared

mark the checkboxes.

several checkboxes in User Options. However,
if you do not mark the checkboxes, you do not
see these options in SRC.
QCCR1E97229

If the user selects "Keep me logged in", and

End-users can now log into SRC with their new

then their password is changed, they are no

password as expected if they selected "Keep me logged

longer able to log in to SRC. This occurs even if

in" option, even when their password is changed in SM

the user de-selects the "Keep me logged in"

client.

option and enters the new password.

Mobility Client
CR

Problem

Solution

QCCR1E63548

On an android phone, the log-in screen

The labels are now displayed correctly.

username and password labels are inside the
text fields.
QCCR1E69056

The memory settings for the SM Mobile

Provided the recommended heap size settings in the

applications are conflicting. The Java heap

SM9.32 Mobile Applications User Guide. There is no

settings being set by the installer conflict with

confusion or ambiguity about what the proper Java heap

the initial Memory Pool and the Maximum

settings should be.

Memory Pool.
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CR

Problem

Solution

QCCR1E79019

When one user logs in to the Mobility client, two

During login, the Mobility client uses one session per

or three sessions are initiated. Additionally, after

user and releases the sessions on logout.

the user logs out, the sessions are not released.
QCCR1E70703

QCCR1E71857

Drilling down to a specific change record from

Drilling down to a specific change record from Service

Service Manager Mobile Applications does not

Manager Mobile Applications now displays both date and

display time, but only date information.

time information.

The SM Mobility log contains the following

This error no longer occurs in the log.

warning message: "WARN: Timezone offset is
missing in SM Mobility".
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CR

Problem

Solution

QCCR1E71858

SM Mobility creates an instance of ThreadLocal

The log entries are no longer generated.

with a key of type [null], but fails to remove it
when the Web application is stopped. When this
issue occurs, the following log entries are
generated:
" SEVERE:
The web application [/mobileItsmWebApp]
created a ThreadLocal with key of type [null]
(value
[org.codehaus.groovy.grails.commons.spring.
ReloadAwareAutowire
CapableBeanFactory$2@4effa014]) and a
value of type [java.lang.Boolean] (value [false])
but failed to remove it when the web application
was stopped. "
QCCR1E76231

The Mobile Applications shows different records

The Mobile Applications shows the same records as the

from those in the Web and Windows clients.

Web and Windows clients do, including the 'Assigned to
My Groups' change view.

QCCR1E71856
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The SM Mobility log no longer contains useless warning

messages.

messages.
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CR

Problem

Solution

QCCR1E95590

The modified CustomConfig.groovy causes SM

This issue no longer exists due to refactoring of the

Mobility mobileItsmWebApp application

Mobility client.

unavailable.
QCCR1E79188

The Mobility client does not initially display the

The Mobility client now initially displays the "Search"

"Search" button or the "Sort by" options in the

button or the "Sort by" options in the list page.

list page. Instead, you must drill down to the
details page, and then return to the list page.

Knowledge Management Search Engine
This release fixes the following defect in the KM Search Engine.
CR

Problem

Description

QCCR1E91035

When you perform a search in Knowledge

The search result returns the correct document count,

Management, and you type some key words in

and no documents contain the omitted key word.

the "none of these words" field, the search result
returns an incorrect document count, and some
documents still contain the omitted key word.
Additionally, highlighted search results in
attachments causes a performance decrease.

Additionally, an option is added to enable administrators
to remove highlighted search results in attachments.
Note: This fix is provided through the
QCCR1E91035_SM932_SM930.unl file, shipped with
the KM package. See "Knowledge Management (KM)
Update Installation" on page 218.
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Documentation
CR

Problem

Solution

CCR1E72765

The SM online help incorrectly states that

Updated help topic "Problem record information" as follows:

affected.ci.count (read-only field) should fill
automatically with the count of all problems related
to the Configuration Item (logical.name) specified
in the problem record.

Affected CI Count: A system-generated count of the
number of CIs affected by the outage. The count does not
include the Primary CI. Affected CI count is based on the
number of items entered in the Assessment section. It is
calculated based on what is in the Assessment section in
the Affected CIs table.

QCCR1E74511

Documentation is incomplete for implementing the

Updated the "Invoke auditing from Format Control" help

"database record auditing" functionality.

topic to provide additional parameter values, and added a
new topic "Invoke auditing for joindefs tables".
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CR

Problem

Solution

QCCR1E78493

When trying to use the Compare/Merge tool in SM

Added the following note in Upgrade Guide under "Using

9.30up5, the following errors are received during

the Auto Merge and Revert options:" "If you do not choose

conflict resolution phase:

to use the auto-merge option, you must manually unzip the

Script 'upgradeHelper' line 304: ERROR
TypeError: lib.upgradeMerging.getOOBFileName
is not a function at char 1

OOB data to the same folder in which you extracted the
Merge Tool. If you do choose the auto-merge option, the
OOB data is extracted automatically by the Merge Tool."

Cannot evaluate expression
(run.merge.tool,get.xml.data)
Bad arg(2) oper = (run.merge.tool,get.xml.data)
Cannot evaluate expression
(run.merge.tool,get.xml.data)
QCCR1E80006

There is no documentation to explain how to apply

Added the documentation to the Service Manager 9.32

Mandanten in Knowledge Management in Service

Search Engine Guide.

Manager 9.30 utilizing the SOLR search engine.
QCCR1E95326

Documentation provided for RAD function

The Programming Guide has been updated with the

iscurrent() is confusing. In the document, the

following information:

description of iscurrent() is A RAD function that
determines if the record that you are working with

l

is identical to the version in the database. if

another user has changed the current record since you

opening a ticket and modifying some fileds, what

open it;

is returned by calling iscurrent()? Need to cover
l

some senaris to give more details in the
document.

HP Service Manager (9.32)

Further clarification that this function only determines if

Two example scenarios in which calling iscurrent()
returns true and false, respectively.
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CR

Problem

Solution

QCCR1E96019

Documentation of parameter

When appthreadspersession:5 is specified in sm.ini, users

appthreadspersession needs update.

cannot open the 4th tab for executing a command such as
"db".
The following note is added to the description of the
appthreadspersession parameter:
Note: A user cannot open the last allowed tab by executing
a command via the command line. For example, the
appthreadspersession parameter is set to 5, user has four
open tabs (including the first tab). The user tries to open the
fifth tab by executing a command (for example, the db
command) via the command line. In this scenario, the fifth
tab cannot be opened. However, the user can open the fifth
tab from the System Navigator.
This is a known limitation caused by the mechanism that
calculates the number of open tabs.

QCCR1E97505

The current statement of maximum file attachment

Updated the online help as follows:

size is unclear.
l

Updated the "Setting file attachment size limits" topic to
add a description of total attachment size.

l

Added two new topics on how to set the total
attachment size:
n

Set the total file attachment size for the entire
company

n
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Known Problems, Limitations, and Workarounds
This software release has the following known issues and limitations. This is a cumulative list of known issues and limitations in Service
Manager 9.32, including those that are already documented in previous release notes (Service Manager 9.31 and patches).

Issues in SM9.31 and Patches
Global ID

Problem

Workaround

QCCR1E63663

The Service Manager (SM) client loses

No workaround available.

connectivity during JavaScript execution of the
file.list RAD application.

Created a knowledge article (KM1166532),
which states that Service Manager does not
currently support calls from JavaScript on RAD
applications that use the rio/fdisp panels.
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Global ID

Problem

Workaround

QCCR1E57385

When Service Manager is running on Unix, the

Use one of the following solutions to solve this

legacy listener may log intermittent signal 11

issue on Unix.

upon CIT initial connectivity test if exec-shield
is not set properly.

Solution 1:
Connect Connect-It to the Web Services
connector instead of the Legacy Listener
connector.
Solution 2:
Before connecting Connect-It to the Legacy
Listener connector, do the following:
1. Add usethreading:0 in the sc.ini file, which
is located in <Service Manager server
installation path>\LegacyIntegration\RUN.
Note: For 64-bit RedHat Linux servers only,
you can alternatively run the following shell
commands as root:
# sysctl -w kernel.exec-shield=0
# sysctl -w kernel.randomize_va_space=0
2. Start the legacy listener.
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Global ID

Problem

Workaround

QCCR1E67491

When the collation of the db instance is

Note: This issue only exists in Web service

Chinese_PRC_BIN, Web service clients fail to

integrations. Therefore, the SM clients do not

connect to Service Manager (SM). Only ASCII

have this problem.

operator names are supported, so only ASCII
operator names can be used.

When SM is handling an incoming SOAP
request, the authorization string is decoded by
BASE64Decoder. SM uses the decoded string
value to construct a UTF-8 string that is used in
the RTE. However, the authorization string is in
the header and SM does not know the charset or
encoding of the underling string value, which is
BASE64 encoded.
Therefore, if the underlying string value is not
UTF-8, this problem will occur. In SM, when
fetching an operator record from the database,
no matter what collation the database uses, the
operator record finally will get a UTF-8 operator
value. However, even if users put the same
value in the authorization header, the operator
name may differ because of the
charset/encoding issue. Because of this, the
operator will fail to log on.
This is a limitation of SM. Do not use non-ASCII
characters in operator names. Created a
knowledge article (KM1442479) to document
this limitation.
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Global ID

Problem

Workaround

QCCR1E75182

HTML email truncates the body of the message

When the content of an HTML email template

and sends the HTML code without translating it.

exceeds 8192 bytes in size, the content will be
truncated and displayed as HTML code.
Make sure your HTML email templates do not
exceed this size limit.

QCCR1E89890

Grouped Views are not correctly updated after

When you log a new incident, to keep

logging a new Incident.

consistency with actual incidents, the group
number is not updated.
You need to click the "Refresh" button to update
grouped Views.

QCCR1E72835

Add the ability to limit the memory consumed by

The requested change is not implemented to

individual threads in SM as specified by an

avoid performance degrade.

Administrator.
QCCR1E77563

Signal 11 error is received when calling the

No workaround is currently available.
No workaround is currently available.

toXMLString() routine of the Users object.
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Global ID

Problem

Workaround

QCCR1E88222

An unload file that is exported from an Oracle to

This request is caused by the product running in

an SQL Server database fails to import when the an unsupported configuration. Change to a
unload file already contains a RECORD_KEY

documented and supported configuration. If the

field and the length of first unique key exceeds

problem still exists in a supported environment,

the db limitation.

contact HP Support.
To work around this issue, do not use
"RECORD_KEY" as a SQL Name for a field in
dbdict. This field name is reserved by SM. To do
this, follow these steps:
1. Enter dbdict in the SM command line box.
2. Enter "esdquestions" in to the search field,
and then click the Search button.
3. Select the "record.key" field, and then
change the SQL Name from "RECORD_
KEY" to anything else.

QCCR1E74808

After clicking the Cancel button in the Condition

No workaround is currently available.

Editor from the Workflow Editor, the current tab
sometimes becomes a blank screen and the tab
cannot be closed.
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Global ID

Problem

Workaround

QCCR1E99940

Customers on Solaris 9 cannot upgrade to

To continue to use JRE 1.6 on Solaris 9, modify

SM9.31p2 or a later patch because JRE7 does

the following three lines in the validjava.sh file

not support Solaris 9 and Service Manager

located in the SM server's RUN/ folder.

starts with a JRE validation that does not allow
a JRE version below JRE7 up15.

From:
JAVA_UPDATE_VERSION_SUPPORTED=15
To:
JAVA_UPDATE_VERSION_SUPPORTED= 20
From:
if [ "${JAVA_VERSION}" = "1.7" ]; then
To:
if [ "${JAVA_VERSION}" = "1.6 " ]; then
From:
echo "Install or setup Java 7 correctly
and then run ./setupLinks.sh to
re-create the symbolic links."
To:
echo "Install or setup Java 6 correctly
and then run ./setupLinks.sh to
re-create the symbolic links."
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Issues in SM9.32
Service Manager Issues
Global ID

Problem

Workaround

QCCR1E64377

In the web client, when a Configuration Item

As Oracle has fixed this Applet issue, JRE 6 customers

(CI) record is opened, the CI label does not

need to upgrade their JRE to the latest JRE6 or JRE7 on the

show (or only shows for the first time) in the

machine that runs Internet Explorer or Firefox in order for CI

CI Visualization (Relationship Graph). This

Visualization to display CI labels correctly.

issue occurs only when JRE 6 is used.
QCCR1E95418

CI Relationship Graph is not immediately

No workaround is currently available.

refreshed after changing CI Relationships.
QCCR1E95725

Due to a known issue in JDK (bug

When Httponly cookies are enabled, users can only use

id:7196513), CI icons are not displayed

Internet Explorer 7 or higher for CI icons to display correctly.

correctly in Firefox when Httponly cookies

As Oracle has fixed the Httponly cookie issue as of JDK

are enabled in the web application server.

7u6, users need to install the latest 32-bit JRE (7u6 or
above) on the machine that runs Internet Explorer 7 or
higher.

QCCR1E95963

An error occurs when loading a dbdict twice in Do not export to an unload file a dbdict record whose key
an unload file. The two dbdict records have

type has changed.

the same name, but different key types: the
first one has unique key, while the second's
key type is primary key.
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Global ID

Problem

Workaround

QCCR1E97260

When SSL is enabled between the web

There are two workarounds:

application server and Firefox, a ClassNot
found Exception error displays in the

l

Use Internet Explorer instead of Firefox.

l

If using Firefox, import the client certificate into the Java

workflow section of the Change form. This
issue does not occur in IE or in Firefox
without SSL enabled.

console on the end user's machine. Here are the steps
for Windows 7:
a. Open Control Panel, and i n the Control Panel Search
box enter "Java Control Panel".
b. Double-click the Java console icon to open the Java
console.
c. On the Security tab, click Manage Certificates ....
d. On the Certificates window, select certificate type:
Client Authentication, and click Import.
e. Follow the wizard and import the client user's
certificate.

QCCR1E97492

Clicking the Back button on the CI

No workaround is currently available.

Visualization page (which opens when you
click More > Expand CI Visualization in a
CI record) causes a Firefox crash.
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Global ID

Problem

Workaround

QCCR1E97539

If JRE 7 (update 21 or greater) is used in the

This warning does not indicate the Service Manager product

web browser, when the user opens a

is unsafe.

configuration item the browser displays a
security warning:

Ignore this warning and select Don't Block in the warning
dialog to continue.

Block potentially unsafe components
from being run?
The reason why this warning occurs is that as
of Java SE 7 update 21, JavaScript code that
calls code within a privileged applet is treated
as mixed code and warning dialogs are raised
if the signed JAR files are not tagged with the
Trusted-Library attribute.
QCCR1E97603

If a format that contains a button with Enable

Upgrade both of the SM server and client to the same patch

condition is created or modified by using a

level: SM 9.31 patch 1 or later.

SM9.31 patch 1 server, when using it in SM
9.31 GA or earlier, the client crashes.
However, formats created by using the
SM9.31 GA or earlier server work fine.
QCCR1E94657

When PDCP4 is applied, the first group on

Move the scroll bar to the top-most position and then you will

the form is not shown in the Jump Address

see the first group.

drop down list.
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Global ID

Problem

Workaround

QCCR1E97856

In a single-line text field, some special

No workaround is currently available.

characters whose HTML code is &#x...;
(where ... stands for a hex number) are not
represented as their original format. Instead,
they display as &#x...;. However, such
characters are represented as the original
format in other widgets (textarea, label,
message panel, and so on).
QCCR1E98343

When you try to remove a group from the

Before clicking the "Remove" button to remove the group,

permission list of a Knowledge Category

try making the selection by clicking on the text in either cell.

record, if you select the group by clicking on
the white space in either cell and then click
the "Remove" button, the group is still there.
QCCR1E98705

QCCR1E93604

The image uploaded for a service catalog

Go ahead to save the current record. When you retrieve this

item displays as broken (a cross-mark).

record again, the image will display correctly.

The HTTP Response Code is 200 instead of

Use a valid sort field separator.

400 when a RESTful request uses an invalid
sort field separator (for example, a plus
symbol).
QCCR1E94204

QCCR1E94206
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Because of the incorrect status, the operation Reset the status of this record (for example, reopen the
could not proceed after merging a record.

closed record) and perform the last operation again.

The last operation could not be repeated after

Reset the condition for the button in this record, for example,

merging a record because the button for the

Reopen the closed record, and perform the last operation

last operation disappears.

again.
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Global ID

Problem

Workaround

QCCR1E96353

RESTful API: An incident record is

Validation is not performed for the fields.

successfully resolved when posting an
incident resolve action with a blank
"ClosureCode" and "Solution".
QCCR1E96391

Restful API: Results are in the wrong order

To work around this issue, validate them at the RESTful
client side, or manually add validation for the fields to the
format control.
No workaround is currently available.

when sorted by an array field.
This issue occurs because the SM RTE does
not support sorting by array fields. A list is
returned without any error message.
QCCR1E97898

Restful API: A 400 Bad Request error occurs

The RESTful API framework supports simple queries and

when a RESTful API request is a cross-table

SM native queries.

join query.

Currently RESTful API framework does not support crosstable SQL queries.

QCCR1E98320

When a record is removed after being read,

No workaround is currently available.

the Merge function still allows the user to
merge the record and the user's input is lost.
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Global ID

Problem

Workaround

QCCR1E98227

In Approval Delegation wizard, go to another

This is only a display issue, and will not impact the

page (do not change the delegation module)

functionality. If you need to remove the operator from the

after choose the operator to delegate in

delegation list, choose the blank line, and then click the

"Select Approval Groups" page, then back to

remove icon; otherwise the operator will be successfully

"Select Approval Groups" page again. You

delegated once you save the update.

will find a blank line is displayed in the right
table, instead of the operator record.
QCCR1E98576

when there are conflicted updates on system

Ignore the Merge button. Reload the latest record to edit this

fields, the system displays the message "The record again.
conflicted fields cannot be merged. Reload
the record.", whereas the Merge button is
available. Actually, the merge function should
not be available in such case.
QCCR1E98398

When you are updating a record and adding

After automatic or manual merge, add the attachments again

attachments to this record, if your updates

before saving the merged result of the record.

conflict with another users' updates or the
updates of a background process, the
attachments will be lost after either automatic
or manual merge.
QCCR1E98411

SRC failed to retrieve service catalog items

In the svcCatalog dbdict, the id.attach field is character

from SM on upgrade from SM 7.11 to SM

type, which should be number type. The id.attach field is an

9.32.

alias of the id field in the svcCatalog table.
To fix the issue, change the field type using the Dbdict
Utility.
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Global ID

Problem

Workaround

QCCR1E98606

When purging all duplicated records for

No workaround is currently available.

upgrade, the following error message occurs:
No display screen named
"kmgroup.save" found
QCCR1E98618

Subcategory data on the Incident form is not

If necessary, manually add the subcategory data.

available after upgrading from ServiceCenter
6.2 to Service Manager 9.32.

1. Enter db in the SM command line box.

Subcategory data is not upgraded.

2. In the Table field, enter subcategory, and click
Search.
3. For each Catagory in the dropdown list, add the
following Areas (enter a value in the Area field and click
Add): access, data, failure, hardware,
performance, and security.
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Global ID

Problem

Workaround

QCCR1E98713

After applying an upgrade, the following error

This error has no impact on the upgrade, and can be ignored.

message occurs:
Unable to open file <file path> for
writing

To prevent this message from occurring, do the following
before applying an upgrade:
1. In Database Manager, search for table help.
2. Double-click help.detail.
3. Enter the following values, and click Search:
File Name: formatctrl
Format: formatctrl.maint.seq.b
Term: Format Control maintenance Sequentially Numbered fields
4. Click Delete to delete the record.

QCCR1E98298

Survey Integration: If you use an invalid

Do not use invalid parameter names.

parameter name when you configure a survey
with an API-based connector, the parameter
is replaced with an empty value incorrectly.
QCCR1E98299

Survey Integration: When you use the Mass

No workaround is currently available.

Update utility to update multiple survey
records, ruleset validation does not work.
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Global ID

Problem

Workaround

QCCR1E98475

With Process Designer Content Pack 9.30.3

If you encounter the error "This record has changed since

applied, the Merge functionality does not

you selected it." when clicking the Save & New button on

work when a user clicks Save & New in an

an interaction opened through a search, to avoid abandoning

interaction record opened through a search.

your updates, do not use the Save & New button to save
your updates; instead, first click the Save button to save

1. Open an interaction through a search.
2. Update the Title.

your updates with the merged result, and then register a new
interaction from the navigation menu.

3. Another back-end process has updated
the Title to another value.
4. Click Save & New. An error occurs:
This record has changed since you
selected it.
You cannot perform Merge for the
conflicted updates as expected.
QCCR1E99998

The following text string in the web tier is not
localized:
File: <webtier-9.32.war>WEB-INF/lib/cwc9.32..jar/com/hp/ov/cwc/web/login.properties

Manually localize it using the native2ascii tool.
For detailed steps, see the SM9.31p2 Release Notes:
http://support.openview.hp.com/selfsolve/document/KM00
408894

Text:
Logout.WarningMessage.CloseBrowser=Pl
ease close your browser window.
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Service Request Catalog Issues
Global ID

Problem

Workaround

QCCR1E90074

When entering a search string in Service

No workaround is currently available.

Request Catalog, auto-complete does not work
if the browser's preferred language is set to an
East Asian language (for example, Simplified
Chinese).
QCCR1E98339

Custom fields do not load the DEFAULT

After upgrade, you should manually add the

company value when the checkout panel is

same structure configuration of the DEFAULT

empty for one of the three checkout panels of

company for the empty checkout panel of your

your company.

company. For example, before upgrade, you, as
an SRC administrator, only defined custom
fields for the Service Catalog checkout panel for
your company. After upgrade to SM932, if you
want to use the support checkout panel and
generic support checkout panel in SRC
correctly, you need to manually add OOB
configurations for the Support Catalog and
Generic Support checkout panels, which you
can copy from those panels of the DEFAULT
company.
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Backup and Backout Instructions
In case you need to restore your Service Manager system to its original state after installing the
component patches in this release, make necessary backups before each patch installation. If a
rollback is needed, follow the backout instructions.

Server
Backup
Before applying the server patch, make a backup of the server installation folder. For example,
C:\Program Files\HP\Service Manager 9.30\Server.
Note: If you have a horizontally scaled system, be sure to back up the server installation folder
for each server instance.
Backout
Service Manager 9.32 supports FIPS mode. To run SM in FIPS mode, you must upgrade your
database to the 256-bit AES encryption algorithm. Once you change all of the encrypted fields to
use the new 32 character encryption you cannot roll back the RTE and still read the encrypted data.
After installing the patch, do the following to backout:
1. Stop the Service Manager server.
2. Remove the existing server installation folder.
3. Copy the backup folder back.

Note: Make sure that the embedded Tomcat is also replaced with the backup, because
the version of the embedded Tomcat may have dependency on a specific server version.

Note: If you have a horizontally scaled system, make sure that every server instance is
replaced with its backup.

4. If you have also loaded platform unload files required for your server changes, you must also
roll back the application changes made by the unload files. See "Applications" on page 194.
5. For Unix-based platforms other than Linux, make a backup of your JRE if you have not yet
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upgraded to JRE 1.7.
6. Restart the Service Manager server.

Web Tier
Backup
Before deploying the new web tier, make a backup of the following items:
l

web.xml file

l

application-context.xml

l

log4j.properties

l

splash screen

l

style sheets

l

any other customizations you made, including your webtier-<version>.war (webtier-ear<version>.ear) file.

Backout
To roll back to the old web tier:
1. Delete or uninstall the existing web tier.
2. Clear the cache of your web application server (for example, Tomcat).
3. Redeploy the old web tier.
4. Restore your old customizations.

Windows Client
Backup
1. Make a backup of your Windows client home folder, for example,
C:\Users\<username>\ServiceManager. Your connections and personalized settings are
stored in this folder.
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Note: This is the out-of-the-box home directory, and could differ from yours if you made
changes to <Client>\configuration\config.ini file. If so, back up the files from the
location specified in that file.

2. Make a backup of your certificate configuration files if any (Window > Preferences > HP
Service Manager > Security). For example, your CA certificates file and client keystore file.
Backout
1. Uninstall the new Windows client.
2. Reinstall the previous Windows client.
3. Restore your old Windows connections and configurations.

Applications
If you plan to upgrade your applications to this release level, make a backup of your database
before the upgrade, in case you need to restore your database after the upgrade. Creating a backup
of the entire database and restoring the database if needed is a better approach for a full
applications upgrade.
If you plan to load individual unload files in this release, follow the backup and backout instructions
below.
Backup
Tip: If your application version is 7.11 ap3, 9.21 ap3, 9.30 ap3, 9.31 or later, you are
recommended to use Unload Manager to make a backup of the files to be modified by an
unload file, because Unload Manager can create a backup of your old data during the
installation of the unload; if your application version is other than any of these, Unload Manager
is not available and you can use Database Manager instead.
To use Unload Manager to make a backup:
1. Go to System Administration > Ongoing Maintenance > Unload Manager.
2. Double-click Apply Unload. A wizard opens.
3. Select the unload file you want to apply, also specify a backup file, and then click Next. Details
of the unload file appear.
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4. Double-click a conflicting object in the table to open the merge tool:
a. Merge the object, and then select the Reconciled check box.
b. Click Save to go back to the wizard.
5. Click Next after all the conflicting objects are reconciled.
6. Click Yes on the confirmation window to apply the unload.
7. Click Finish.
Now, the unload has been applied and at the same time your old data backed up.
To use Database Manager to make a backup:
1. Go to Database Manager, select Import/Load from More or the More Actions menu, and
browse to the unload file.
2. Click List Contents on the menu bar, to view a list of files that have been updated in this
unload.
See the following figure for an example.

This figure shows the contents of an unload file that contains changes to the following files:

Page 195 of 229

HP Service Manager (9.32)

Release Notes
Backup and Backout Instructions

File

Record

Process

svc.add.cart

application

money.format
Note: The scmessage records listed under each RAD application are
messages used in this RAD application; no backup is needed for them.

ScriptLibrary

svcCartHelper

datadict

activity

dbdict

activity

Note: The “activity” file with no records actually represents the dbdict
record of the activity file.
scmessage

The record whose message class is “fc” and message number is 1000.

3. Go to Database Manager, in the Table field enter a file name you got in step 2, and click the
Search button.
4. If the format selection page shows, select the proper format by double-clicking it (for example,
select the device format for the device file), and then search for the file record.
5. Click More (or the More Actions menu) > Export/Unload after the file record displays.

Note: If Export/Unload is not available, check the Administration Mode check box in
Database Manager and try again.

6. In the pop-up window, specify your backup upload file path/name, and click Unload Appl.

Caution: Make sure that Append to file is selected.

7. Repeat steps 3 through 6 to back up the rest of the files you got in step 2.
Backout
Tip: You can use Unload Manager (recommended) or Database Manager (if Unload Manager is
not available in your application version) to roll back to your old data, as described in the
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following.
To roll back to your old data using Unload Manager:
1. Go to System Administration > Ongoing Maintenance > Unload Manager.
2. Double-click Apply Unload. A wizard opens.
3. Select the unload file generated in the backup process, specify a backup file, and then click
Next. Details of the unload file display.
4. Double-click a conflicting object in the table to open the merge tool:
a. Merge the object, and then select the Reconciled check box.
b. Click Save to return to the wizard.
5. Click Next after all the conflicting objects are reconciled.
6. Click Yes on the confirmation window to apply the backup unload.
7. Click Finish.
To roll back to your old data using Database Manager:
1. Go to Database Manager, click More > Import/Load.
2. Browse to the backup unload file you created.
3. Click Load FG.

Knowledge Management Search Engine
To backout your Knowledge Management (KM) search engine changes, make a backup before your
KM patch installation.
Note: Keep in mind that you also need to roll back KM-related server side and application side
changes. For details, see the Server and Application backup and backout Instructions.
Backup
Before applying the KM patch and upgrading the JDK and KM embedded Tomcat, do the following:
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1. Make a backup of the search engine installation folder. For example, C:\Program
Files\HP\Service Manager 9.30\Search Engine Backup
2. Make a backup of the files to be modified by the unload files in the KM patch.
3. Make a backup of your schemastub.xml file under directory <SM server>/RUN/km/styles/.
Backout
After installing the patch, do the following to backout:
1. Stop your KM search engine.
2. Remove the existing search engine installation folder.
3. Copy the backup folder back.
4. Rollback the previous JDK installation and change the JAVA_HOME environment variable back.
5. Be sure to roll back KM related changes on the SM server and application sides, including the
kmsolr unloads files and the server's schemastub file.
6. Restart your KM search engine.
7. Perform a full re-indexing on all of your knowledgebases.
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This section provides instructions on installing each component in this release.
Before you proceed, HP recommends that you consult the latest Service Manager 9.32 Support
Matrix and the Compatibility Matrix for Service Manager Applications Content at:
http://support.openview.hp.com/sc/support_matrices.jsp
For more information, see "Service Manager Support Matrix and Applications Content Compatibility
Matrix" on page 226.

Digital Signature Notice
HP signs Windows executable files with a digital signature. Since January 2012, this process has
been updated to use a new VeriSign root certificate. On a Windows system that does not have the
new VeriSign root or intermediate certificate installed, when the user right-clicks the file and then
goes to Properties > Digital Signatures > Details, a verification error will display: “The certificate
in this signature cannot be verified.”

To resolve this issue, either enable Windows Update or download and install the G5 Root certificate
as documented at: https://knowledge.verisign.com/support/ssl-certificatessupport/index?page=content&actp=CROSSLINK&id=SO19140
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Server Update Installation
The server update for your operating system (OS) consists of a compressed file, sm9.32.0016_
<OS>.zip (or .tar), which contains updated files of the Service Manager server. These files add to
or replace the files in the [SM Server Root]\([SM Server Root]/)RUN, irlang, bin,
legacyintegration, and platform_unloads directories.
Note: If using an Oracle RDBMS, be aware that Oracle Call Interface (OCI) 11.2.0.3 is
required for SM9.30p5, SM9.31, SM9.32 and later. See the latest Service Manager 9.32
Support Matrix at http://support.openview.hp.com/sc/support_matrices.jsp.
Built-In Troubleshooting Tool (SM Doctor)
Additionally, this server patch includes an installation of the HP Service Manager Doctor (SM
Doctor) tool. The server patch will install the tool in the [SM Server Root]\([SM Server Root]/)
smdoctor directory. For information on how to use this tool, see the Guides and reference >
Troubleshooting > HP Service Manager Doctor section in the online help.
Upgrade Paths
This server patch must be applied on top of one of the following versions/patch levels of the
SM server:
l

SM9.30 GA

l

SM9.30 Patch/Hotfix

l

SM9.31

l

SM 9.31 Patch/Hotfix

The following server upgrade paths are recommended:
l

New customers: Install the SM9.30 GA server, and then directly apply the 9.32 server patch;

l

Existing SC6.2, SM7.11 and 9.21 customers: Uninstall the old server, install the SM9.30 GA
server, and then apply the 9.32 server patch;

l

Existing SM9.30 or 9.31 customers: Apply the 9.32 server patch.

For installation instructions of the SM9.30 GA server, see the Service Manager 9.30 Interactive
Installation Guide, which is available from the HP Software Manuals Site:
http://support.openview.hp.com/selfsolve/document/KM1195794
For installation instructions of the server patch, see "Server Patch Installation Steps" below.
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Compatibility Mode for Installation on Windows Server 2012
As of this release, Windows Server 2012 is supported. Be aware that compatibility mode is required
for installing the SM9.30 GA server on Windows Server 2012 (not required for Windows Server
2008). To run your server installation in compatibility mode, do the following:
1. Right–click the server's setupwin32.exe file icon.
2. Click Properties > Compatibility.
3. Click Run this program in compatibility mode for and select Windows Vista (Service
Pack 2).
4. Click Apply and OK.
5. Run the setupwin32.exe file to complete the installation.
When uninstalling your server on Windows Server 2012, you should also use compatibility mode.
To do so, set your Windows server uninstaller file (_uninst\uninstaller.exe) to compatibility
mode as described above and then uninstall the server using the uninstaller or from your Control
Panel.
Server Patch Installation Steps
Caution:
l

The server patch will upgrade your embedded Tomcat to version 6.0.36, and therefore
requires additional steps.

l

The server patch will upgrade your JGroups (in the RUN/lib directory) to version 3.2.

l

Starting with SM9.31p2, the SM server requires JRE 1.7. For Windows and Linux, the
embedded JRE has already upgraded to version 1.7; for other Unix-based platforms, you
need to manually perform this JRE upgrade.
The JRE upgrade will cause external web service calls over SSL to fail if the remote
endpoint does not support Server Name Indication (SNI), which is by default activated in
JRE 1.7. Once Service Manager is upgraded to use JRE 1.7, it starts to use SNI
extensions during the SSL handshake. If the remote endpoint does not support SNI, the
web service call will fail with an error message. To solve this issue, do either of the
following:
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n

Activate SNI at the remote end point (recommended)

n

If the remote endpoint does not support SNI extensions, and SNI cannot be activated,
add the following JVMOption<n> parameter either to the sm.ini file, or to the start
command of the servlet(s) in the sm.cfg file:
JVMOption2:-Djsse.enableSNIExtension=false

Note: If you have a horizontally scaled system, you must upgrade all of your server instances.

1. Stop all Service Manager clients.
2. Stop the Service Manager server.
3. Make a backup of the Server installation directory. See also "Backup and Backout
Instructions" on page 192.
4. Delete the RUN/tomcat directory. Tomcat in this directory will be upgraded to version 6.0.36
when you extract the server files later.
5. Delete the RUN/lib directory.
6. For Windows and Linux platforms, delete the RUN/jre directory.

Note: This step is required only when you are upgrading from a server version earlier than
9.31p2. This is to avoid conflicts between the old 1.6-based JRE and new 1.7-based JRE.

7. Extract the compressed files for your operating system into the main Service Manager
directory on the server. The default path is: C:\Program Files\HP\Service Manager
9.30\Server.
8. For UNIX servers, set the file permissions for all Service Manager files to 755.
9. For the following Unix servers, manually upgrade to JRE1.7 if you have not already done so.
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a. Install either JDK1.7 or JRE1.7 for your specific platform.
Solaris

JRE1.7 (update 15 or greater)

HP-UX JRE1.7 (JRE_7.0.04 or greater)
AIX

JRE1.7 (SR4 or greater)

b. Set your JAVA_HOME environment variable to point to JDK1.7 (if you have JDK1.7
installed) or JRE1.7 (if you have only JRE1.7 installed).
c. Execute \RUN\removeLinks.sh to remove the old symbolic links and then execute
\RUN\setupLinks.sh to create new symbolic links.
d. Run the following command to check that the JRE version is 1.7:
RUN\jre\bin\java –version

10. If you have made any customizations/changes to the original RUN/tomcat folder, restore them
in the new RUN/tomcat folder.
11. Your old schemastub.xml file (in the <SM_Server_Home>\RUN\km\styles\ directory) has been
updated to a newer version. Either keep your old file by copying it back or keep the updated
version (a KM knowledgebase full reindexing is then required).
12. Run the sm -unlockdatabase command.

Note: This step is required the first time you upgrade to 9.30p4 or later; it is also required
whenever you change the server’s IP address after your upgrade to 9.30p4 or later. The
purpose of this step is to prevent stale license information from being kept in the system.
In a scaling implementation, you can run this command from any one of your servers.

13. Restart the Service Manager server.
14. Restart the Service Manager clients.
15. Check the version in Help > About Service Manager Server. The server should be Release:
9.32.0016.
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Web Tier Installation
The web tier update consists of a compressed file, sm9.32.0016_Web_Tier.zip, which contains the
installation files (both the .war and .ear files) for installing the SM9.32 web tier. Installing the new
web tier will upgrade your web client to this release level.
The installation steps are the same as installing the SM9.30 web tier. The specific installation
process depends on your particular web application server. For detailed steps, see the Service
Manager 9.30 Interactive Installation Guide, which is available from the HP Software Manuals Site:
http://support.openview.hp.com/selfsolve/document/KM1195794
New Customers
You only need to install the new web tier using the .war or .ear file from the sm9.32.0016_Web_
Tier.zip file in this release. For installation instructions, see the Service Manager 9.30 Interactive
Installation Guide.
Existing Customers
To upgrade your web tier to this patch level, you need to back up and uninstall your old web tier and
then install the new web tier. The upgrade does not automatically save your web tier
customizations. To keep your changes, you must back up your customized files and restore your
customizations in the new deployment.
Note on Tomcat 7.0: If you plan to deploy the web tier on Tomcat 7.0 using the Tomcat Manager, be
sure to set the max-file-size and max-request-size parameters (default: 52428800) in the
<Tomcat 7.0_Home>webapps\manager\WEB-INF\web.xml to an appropriate value greater than the
web tier .war file size; otherwise the deployment request will be rejected because the web tier .war
file exceeds the default maximum values. This restriction does not exist in Tomcat 6.0.
To install the new web tier:
1. Make necessary backups. For details, see "Backup and Backout Instructions" on page 192.
2. Delete or uninstall the existing web tier .war (or the .ear) file.
3. Clear the cache of your web application server.
4. Deploy the new webtier-9.32.war (or the .ear) file following the instructions in the Service
Manager 9.30 Interactive Installation Guide.
Note: It is best practice to deploy with a unique context root. For example: /webtier-9.32.0016
5. Use a diff utility to compare the new web tier’s web.xml file against your backed-up version to
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ensure that any new parameters are properly merged into the files used in your final
deployment. Do this for application-context.xml as well as any other files you may have
customized (such as style sheets and splash screens).
6. Make any new customizations necessary for your deployment.
7. Restart the web application server.
8. Check the version by clicking the HP logo (About HP Service Manager) icon. The web tier
version should be: 9.32.0016.

Windows Client Installation
Note: No features are being added to the Service Manager Windows (Eclipse) Client. HP
recommends that Service Manager administrators deploy one of the other three clients (Web
Client, SRC client or Mobility client) to end users. You still need the Windows Client to perform
administrative tasks.
The Windows client update consists of a compressed file, sm9.32.0016_Windows_Client.zip,
which contains the executable installation files of the new Windows client. Installing the new
Windows client will upgrade your Windows client to this patch level.
The installation steps are the same as installing the SM9.30 Windows client. See the Service
Manager 9.30 Interactive Installation Guide, which is available from the HP Software Manuals Site:
http://support.openview.hp.com/selfsolve/document/KM1195794
New Customers
You only need to install the new Windows client. by following the steps in the Service Manager 9.30
Interactive Installation Guide.
Existing Customers
You need to back up and uninstall the old Windows client, and then install the new Windows client.
To install the new Windows client:
1. Stop the Service Manager Windows client.
2. Make necessary backups. For details, see "Backup and Backout Instructions" on page 192.
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3. Uninstall the Service Manager Windows client. (Your connection and personalized settings are
retained.)
4. Run setup.exe from this Windows client patch to install the new client by following the
instructions in the Service Manager 9.30 Interactive Installation Guide.
5. Check the version in Help > About Service Manager Client.
The client should be Release: 9.32.0016.

Windows Client Configuration Utility Installation
Service Manager 9.32 includes an updated version of the Windows Client Configuration Utility
(sm9.32.0016_Windows_Client_Configuaration.zip). It is intended only for customers who have
upgraded their Windows client to version 9.31p2 or later (for example, 9.32).
For detailed installation instructions, see the Service Manager 9.30 Interactive Installation Guide,
which is available from the HP Software Manuals Site:
http://support.openview.hp.com/selfsolve/document/KM1195794

Applications Update Installation
You apply the 9.32 applications using either the SM9.32 Applications Patch Manager
(sm9.32.0016_Application.zip) or Upgrade Utility (sm9.32.0016_Application_Upgrade.zip)
depending on your current application version. You must also be aware of the dependencies if you
have already installed or plan to install SM9.3x content patches.
Prerequisites
l

Service Manager application release level
n

If using Applications Patch Manager: 9.3x (9.30, 9.30 Applications Patch, or 9.31)

n

If using Upgrade Utility: 6.2, 7.11 or 9.2x

l

Service Manager application release language: All languages for 9.32

l

Service Manager client/server release level: 9.32 or greater

l

The Service Manager server process must have read-write access to the database
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Content Patch Dependencies
Refer to the Compatibility Matrix for Service Manager Applications Content document, which is
available from the HP Support Matrices portal:
http://support.openview.hp.com/sc/support_matrices.jsp
Upgrading to the 9.32 Applications
Note: For upgrades from Service Manager 7.11, 9.30, or 9.31, make sure that primary key
mode is disabled before upgrading from the Service Manager 7.11, 9.30, or 9.31 applications;
for new installations of Service Manager, make sure that primary key mode is disabled before
loading the OOB application data. Also, if you plan to install Process Designer Content Pack
9.30.2 or 9.30.3, make sure primary key mode is disabled before the content pack installation.
For more information, see "Primary Key Mode" on page 18.
Existing customers and new customers can upgrade to the 9.32 applications using different
approaches. For detailed instructions, see the Applications Patch Manager Guide and Upgrade
Guides for Service Manager 9.32.
For a list of changed objects, see the List of objects added or updated by the 9.32 Applications
Patch Release.
For existing customers:
1. Upgrade the SM server and clients to version 9.32.
2. To upgrade from a 9.3x version of the applications, use the SM9.32 Applications Patch
Manager.
3. To upgrade from the 6.2, 7.11 or 9.21 applications, use the SM9.32 Upgrade Utility.
For new customers:
1. Install the SM9.30 GA server and load SM9.30 GA demo data.
2. Install the SM9.32 server patch.
3. Install the SM9.32 Windows or web client.
4. Upgrade to the SM9.32 applications using the SM9.32 Applications Patch Manager.
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Application Unload Installation
Note: All unload files in the server’s platform_unloads directory in this release have been already merged into the Service Manager 9.32
applications. These files are provided just in case you do not plan to upgrade to applications 9.32 while still want to take advantage of the
relevant new features/fixes.
If a platform fix (in most cases, a server fix) also requires an applications change to resolve the relevant issue, an unload file is provided.
Unload files introduced in earlier patches are also included in this cumulative release. If you have not already applied them for a previous
patch, you should also apply the unload files that are intended for your applications version. For more details about these applications
updates, see the Release Notes for those patches.
This patch release includes the unload files that come with the server update. When you extract sm9.32.0016_<OS>.zip (or .tar), it will add
the files to the following directory:
[SM Server Root]\platform_unloads ([SM Server Root]/platform_unloads)
Note: Unload files should be installed in their patch order. That is, those introduced in patch 1 should be applied first, then those
introduced in patch 2, and so on. However, unload files introduced in the same patch can be installed in a random order, unless otherwise
specified.
Unload File Naming Convention
The unload files use the following naming convention: <CR_ID>_SMxxxPxx_SMxxx.unl, where:
l

<CR_ID>: The identification number of the applications defect that the unload file fixes. For example, QCCR1E12345.

l

SMxxxPxx: The minimum Service Manager patch level that requires the unload file. For example, SM921P2, which means the unload file

Page 208 of 229

HP Service Manager (9.32)

Release Notes
Installation Notes

comes with the server updates in Service Manager 9.21 patch 2 and should be used for patch 2 or higher.
Note: Sometimes this portion contains an additional hot fix number, for example, SM711P16HF8. This example means the unload file is
intended for Service Manager 7.11 patch 16 Hot Fix 8 or higher.
l

SMxxx: The Service Manager applications version that requires the unload file. For example, SM711, which means the unload file is
intended only for Service Manager applications version 7.11.
Note: If the applications version suffix is omitted, the unload file is then intended for all applications versions compatible with the server
version, unless otherwise specified. For example, QCCR1Exxxx_SM930P4.unl is normally intended for applications versions 7.11, 9.20,
and 9.30 (which are compatible with Service Manager server 9.30), unless otherwise specified in the unload file description. For
information on the applicable applications versions for each unload file included in the current patch, see Unload Files Included in the
Current Patch.

Unload Files Included in the Current Patch
The following are unload files included in the current patch release.

Unload file

Used for
Introduced in apps version
9.3x patch
(s)

Description

QCCR1E31324_

9.32

7.11, 9.21,

Fixes this issue : With Syslog audit turned on, only a syslog record

9.30 and 9.31

showing login is created; no record for logoff is recorded if the user does

SM932.unl

not log out "normally."
Associated server fix: QCCR1E31324
QCCR1E96802_
SM931P3.unl

9.31p3

7.11, 9.21,

Changes the behavior when handling web service request user

9.30 and 9.31

passwords. See the SM9.31p3 Release Notes.
Associated server fix: QCCR1E96802
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Unload file

Used for
Introduced in apps version
9.3x patch
(s)

Description

QCCR1E52767_

9.31p3

Fixes the issue that users cannot add data policy definitions on joined

9.30

SM931P3_SM930.unl

tables.
Note: You do not need to load this unload if you are running on SM9.31,
9.21, or 7.11 applications.
Associated server fix: QCCR1E52767

QCCR1E76724_

9.31p2

9.30 and 9.31

SM931P2_SM930.unl

Fixes the issue that after deleting the unique key of cm3r, a signal 11
happened while doing an IR regeneration.
Associated server fix: QCCR1E76724

QCCR1E76227_

9.31

9.30

SM930P6_SM930.unl

Contains the code changes to support localization of incident/change
priority and urgency strings for the 9.31 Mobility Client.
Note: Not needed for the SM9.32 or later Mobility client.

QCCR1E78794_
SM930P6_SM930.unl

9.31

9.30

Removes incident.assignee when a Web Service call specifies the
assignee as 'NULL' through the SM9.31 Mobility Client.
Note: Not needed for the SM9.32 or later Mobility client.
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Unload file

Used for
Introduced in apps version
9.3x patch
(s)

Description

QCCR1E76796_

9.31

Provides the ability to turn on debugging dynamically for user sessions or

9.30

SM930P6_SM930.unl

schedulers.
Note: This unload requires the SM9.31 server.

QCCR1E71099_

9.30p5

7.11

SM930P5_SM711.unl

Displays Value Lists instead of the data directly retrieved from the
database in a QBE list when adding a field by using Modify Columns.
Associated server fix: QCCR1E71099

QCCR1E71099_

9.30p5

9.20

SM930P5_SM920.unl

Displays Value Lists instead of the data directly retrieved from the
database in a QBE list when adding a field by using Modify Columns.
Associated server fix: QCCR1E71099

QCCR1E71099_

9.30p5

9.30

SM930P5_SM930.unl

Displays Value Lists instead of the data directly retrieved from the
database in a QBE list when adding a field by using Modify Columns.
Associated server fix: QCCR1E71099

QCCR1E71139_
SM930P5_SM930.unl

9.30p5

9.30

Works with server fix QCCR1E71139 to solve this issue: When Service
Manager is configured to use LDAP as the authentication data source, the
user is still forced to change the password if the user is expired in the local
database.
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Unload file

Used for
Introduced in apps version
9.3x patch
(s)

Description

QCCR1E31941_

9.30P4

Enables users to use a pre-configured decimal symbol when completing

9.30

SM930P4_SM930.unl

numeric fields.
Note: This enhancement requires a 9.30p4 or later server; however if
you are using RTE version 9.30 with applications version 7.11 or
9.20, do not load this unload file; you can safely upgrade your server
to 9.30p4 or later without applying this applications change.
Associated server fix: QCCR1E31941.

QCCR1E73452_

9.30P4

7.11 - 9.30

SM930P4.unl

Enables Mandanten restricting queries to be updated correctly after a
profile is edited.
Associated server fix: QCCR1E71897

QCCR1E67072_

9.30P3

7.11 and 9.20

SM930P4_SM930.unl

Enables users to take advantage of the new KMStatusListener
background process.
Note: This unload file is not needed for applications version 9.30 or
later, which supports only the Solr Search Engine.
Associated server fix: QCCR1E67071

QCCR1E70163_
SM930P4_SM711.unl
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Unload file

Used for
Introduced in apps version
9.3x patch
(s)

Description

QCCR1E70163_

9.30P3

Fixes the issue that the KMUpdate process terminates abnormally.

9.20

SM930P4_SM920.unl
QCCR1E70163_

Associated server fix: QCCR1E69687
9.30P3

9.30

SM930P4_SM930.unl
QCCR1E67647_

Fixes the issue that the KMUpdate process terminates abnormally.
Associated server fix: QCCR1E69687

9.30P3

7.11 - 9.30

SM930P3.unl

Updates the exception message that occurs in the request response
when closing an interaction by calling CloseInteraction from a web
service without specifying the localSolution field in the request.
Associated server fix: QCCR1E54192

QCCR1E67610_

9.30P2

7.11 - 9.30

SM930P2.unl

Enables you to block potentially dangerous attachments.
Associated server fix: QCCR1E64290

Tip: If your application version is 7.11 ap3, 9.21 ap3, 9.30 ap3, 9.31 or later, you are recommended to use Unload Manager to load an
unload file, because Unload Manager can help you create a backup of your old data and reconcile conflicts during the installation of the
unload; if your application version is other than any of these, Unload Manager is not available and you can use Database Manager
instead.
To load an unload file using Unload Manager:
1. Go to System Administration > Ongoing Maintenance > Unload Manager.
2. Double-click Apply Unload. A wizard opens.
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3. Select the unload file you want to apply, also specify a backup file, and then click Next. Details of the unload file appear.
4. Double-click a conflicting object in the table to open the merge tool:
a. Merge the object, and then select the Reconciled check box.
b. Click Save to go back to the wizard.
5. Click Next after all the conflicting objects are reconciled.
6. Click Yes on the confirmation window to apply the unload.
7. Click Finish.
Now, the unload has been applied and at the same time your old data backed up.
To load an unload file using Database Manager:
1. Make sure the Windows client is configured for server-side load/unload.
a. From the Windows client, go to Window > Preferences > HP Service Manager.
b. Unselect Client Side Load/Unload if is flagged.
c. Restart the Windows client.
2. Open Tailoring > Database Manager.
3. Right-click the form or open the More Actions menu and select Import/Load.
4. Browse to the unload file, and view the contents of an unload file before importing it by clicking List Contents.
5. Make a backup copy of all files to be modified by this unload. For detailed steps, see "Backup and Backout Instructions" on page 192.
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6. Fill in the following fields.
Field

Description

File Name

Type the name and path of the file to load.

Import Descriptor

Since unload files do not require an Import Descriptor record, leave this field
blank.

File Type

Select the source operating system of the unload file.

Messages Option —
All Messages

Select this option to see all messages that Service Manager generates
loading the file.

Messages Option —
Totals Only

Select this option to see only the total number of files Service Manager loads.

Messages Option —

Select this option to hide all messages that Service Manager generates when

None

loading the file.

7. Click Load FG.

Service Request Catalog (SRC) Installation
Service Manager 9.32 includes the SRC package (sm9.32.0012_SRC.zip), which contains the following files:
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l

a .war file for SRC 9.32 (src-9.32.war)

l

a migration tool for upgrading customizations from an SRC 1.4 deployment to SRC 9.32 (src-migration-9.32.zip)

l

an encryption tool for generating an encrypted password (encryptor-9.32.zip)

l

a validation tool that you can use to help ensure that your manifest.xml file is valid and usable (validator-9.32.zip)

Before you proceed, download the Service Request Catalog 9.32 Interactive Installation Guide and Service Request Catalog 9.32
Customization Guide from the HP Software Manuals Site:
http://h20230.www2.hp.com/selfsolve/manuals
These guides provide details about deploying the .war file and the usage of the three tools.
New Customers
1. Install SRC 9.32, deploy the src-9.32.war file by following the instructions in the Service Request Catalog 9.32 Interactive Installation
Guide.
2. Configure SRC 9.32 by following the instructions in the Service Request Catalog 9.32 Customization Guide.
Existing Customers
1. Install SRC 9.32, as described above.
2. Migrate the customizations from your old deployment to SRC 9.32.
n

SRC 1.4 customers: Run the SRC migration tool to migrate your specific customizations from your old SRC 1.4 deployment to SRC
9.32. For details, see the Service Request Catalog 9.32 Customization Guide.

n

SRC 1.2x or 1.3 customers: Manually restore your customizations.
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Mobile Applications Installation
Service Manager 9.32 includes a new version of the Mobility client (sm9.32.0005_Mobility.zip). New customers can directly install the new
Mobility client by deploying the webapp-9.32.0005.war file, while existing customers can only uninstall their old Mobility client and then install
the new one.
Installation Steps
Note: The Service Manager 9.32 Mobility client supports Apache Tomcat 7.0 (7.0.32 or greater) web application server only.
To install the SM9.32 Mobility client:
1. Stop the Tomcat Web application server.
2. Copy the webapp-9.32.0005.war file to your Tomcat webapps directory. For example, C:\Program Files\Apache Software
Foundation\Tomcat 7.0\webapps
3. In the web.properties file, specify the Service Manager server host and port in the endpoint parameter.
http://<server host>:<port>/SM/ui

For details, see the Service Manager 9.32 Mobile Applications User Guide.
4. Add the updated web.properties file back to the .war archive.
5. Restart Tomcat.
Application Changes Required for SM9.31 or SM9.30
The Service Manager 9.32 Mobility client can work with the SM9.32, SM9.31, or SM9.30 applications; however, if using the SM9.31 or
SM9.30 applications, before users can use the Mobility client, you ,as an administrator, need to make additional application changes by either
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importing or manually implementing the unload files shipped with the Mobility client package (be sure to import or implement them in listed
order):
l

l

mobile2-update-9.30-9.31.unl
mobile2-new-9.30-9.31.unl

For details, see the Service Manager 9.32 Mobile Applications User Guide.

Knowledge Management (KM) Update Installation
The KM package (sm9.32.0016_KM.zip) in this release includes updated files for the KM Solr Search Engine and the KM Import Utility.
KM Search Engine Update Installation
The KM Search Engine update contains the following files:
Folder

Files

kmsolr_unloads

l

QCCR1E67750_SM930P4_SM930.unl

l

QCCR1E75104_SM930P5_SM930.unl

l

QCCR1E77409_SM930P5_SM930.unl

l

QCCR1E91035_SM932_SM930.unl

l

installasservice.cmd and startup.cmd (updated for JDK7 support added in 9.31p2)

l

kmsearchengine subfolder (which contains several search engine fixes)

knowledgemanagement

The Solr Search Engine update aims to enable the following features or fixes for Knowledge Management searches:
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l

Support of Knowledge Management search for Service Request Catalog (SRC) 1.4 or greater. For more information, see the SM9.31
Release Notes.

l

Ability to specify search result sort preferences in Knowledge Management (by Modified Date, Status, or Relevancy). For more
information, see the SM9.30p4 Release Notes.

l

Ability to select whether or not to highlight attachment content in KM search results. A new option (Highlight content of attachment in
search result?) is available in the KM environment record. By default, this option is not selected, and therefore attachment content in
user’s KM search results will not be highlighted. This can significantly improve search performance when there are a large number of largesize attachments like PDF manuals in the knowledgebases. For more information, see the Highlighting Attachment Content in Search
Results Optional section in the 9.30p5 Release Notes.

l

Fix QCCR75104 (Searches that use "NOT" or '-' to exclude terms produce unexpected results. For example, the search results when
using the None of these words option in Advanced Search may include the search terms that should have been excluded. For more
information, see the 9.30p5 Release Notes.

l

JDK 7 support ("Knowledge Management Search Engine" on page 172): To use JDK7 on a Windows platform, you need to update your
installasservice.cmd and startup.cmd files with those shipped with this KM patch; for UNIX platforms, no file changes are needed to
use JDK7.

l

Fix QCCR1E91035 (which fixes the issue that search results using the None of these words option display incorrect total number of
documents searched, and also provides the option to make search results highlight search words in attachments)

Prerequisites:
This KM Search Engine patch can be applied on top of any of the following versions of the KM Solr Search Engine:
l

SM9.30 GA

l

SM9.30 Patch/Hotfix
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l

SM9.31

l

SM 9.31 Patch/Hotfix

Compatibility Mode for Installation on Windows Server 2012
As of this release, Windows Server 2012 is supported. Be aware that compatibility mode is required for installing the SM9.30 GA KM search
engine on Windows Server 2012.
1. Right–click the search engine's setup.exe file icon.
2. Click Properties > Compatibility.
3. Click Run this program in compatibility mode for and select Windows Vista (Service Pack 2).
4. Click Apply and OK.
5. Run the setup.exe file to complete the installation.
When uninstalling your KM search engine on Windows Server 2012, you should also use compatibility mode. To do so, set your search engine
uninstaller file (Search_Engine_Uninstall\change_or_uninstall.exe) to compatibility mode as described above and then uninstall the
search engine using the uninstaller or from your Control Panel.
KM Search Engine Patch Installation Steps
To install the KM Search Engine update:
Note: JDK 7 Update 17 and Tomcat 6.0.36 have been certified on this release of the KM Search Engine. Upgrading to JDK 7 or Tomcat
6.0.36 is optional but recommended.
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1. Stop your KM Search Engine.
2. Make a backup of your Search Engine installation folder and other necessary backups. See the instructions in "Knowledge Management
Search Engine" on page 197.
3. Optionally, update the JDK installed on your search engine server host to JDK7 Update 17, if you have not already done so.

Note: If you are using a Windows platform, be aware that if you do not update your JDK, later you will need to copy your old
installasservice.cmd and startup.cmd files back (located directly under your search engine backup folder).

4. Optionally, update the KM embedded Tomcat to version 6.0.36.
a. Download the Tomcat 6.0.36 zip file specific for your operating system.

Caution: The KM search engine requires a 32-bit Tomcat if running on a 32-bit operating system, and a 64-bit Tomcat on a 64-bit
operating system.

b. Extract the zip file to overwrite your existing Tomcat folder.

Caution: Before this step, be sure not to remove the embedded Tomcat folder, which contains certain files that do not exist in
the Tomcat 6.0.36 zip file that you downloaded. This way these files will remain after you overwrite the old Tomcat folder.

c. Copy your old Tomcat configuration file (server.xml in the conf folder) back to the updated Tomcat folder.
5. Make sure you have already installed the SM9.32 server package.

HP Service Manager (9.32)

Page 221 of 229

Release Notes
Installation Notes

Note: The server package will update your schemastub.xml file to support the new features. If you do not want to use the new
features, copy your old schemastub.xml file back from the backup of your server’s RUN directory so that your search engine can
continue to work.

6. Copy all files and folders in the knowledgemanagement folder to your existing search engine installation folder (for example: C:\Program
Files (x86)\HP\Service Manager 9.30\Search_Engine).
7. Load the unload files in the kmsolr_unloads directory into Service Manager in the following order:
n

QCCR1E67750_SM930P4_SM930.unl

n

QCCR1E75104_SM930P5_SM930.unl

n

QCCR1E77409_SM930P5_SM930.unl

n

QCCR1E91035_SM932_SM930.unl

Note: This step is required only when you are using an applications version earlier than 9.32. These unload files have been already
merged into the SM9.32 applications.

8. (Windows platforms only) If you selected to not update your JDK, copy your old installasservice.cmd and startup.cmd files back.
9. Restart your KM search engine.
10. Log off Service Manager and log back in for your changes to take effect.
11. Perform a full re-indexing for all of your knowledgebases.
KM Import Utility Installation
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Note: The km-import-9.32.zip file included in this release in same with the one shipped with previous releases.
Extract km-import-9.32.zip in the Knowledge Management package to a local drive. For detailed instructions on the use of the import utility,
see the README file packaged in this .zip file.

ODBC Driver Update Installation
This release does not contain any ODBC Driver update. The latest ODBC Driver package has been shipped with the SM9.30p4, SM9.30p5,
and SM9.31 releases.
You can download the package from:
http://support.openview.hp.com/selfsolve/document/KM00207925
The ODBC Driver package contains the following updated files:
l

Scodbc32.dll

l

sci18n.dll

l

sccl32.dll

To install the ODBC Driver update:
1. Extract the files to your ODBC Driver installation folder, for example: C:\Program Files\Peregrine Systems\ServiceCenter 6.2\ODBC
Driver.
2. When prompted, replace the three old DLL files with the new ones.
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Language Pack Installation
Service Manager 9.32 includes language packs for the Service Manager server, for 15 supported languages other than English. For a list of
supported languages, see "Local Language Support" on page 227.
To install the language pack for a language:
1. Install the Service Manager 9.30 GA language pack.
2. Upgrade to the Service Manager 9.32 language pack.
For detailed installation instructions, see the Service Manager 9.32 Language Pack Installation Guide, which is available from the HP
Software Manuals Site:
http://h20230.www2.hp.com/selfsolve/manuals

Online Help Installation
Service Manager 9.32 includes only an English version of the online help. You should follow the SM9.30 online help installation steps, except
that you need to download the online help zip file from the HP Software Manuals Site instead of from the product DVD. The Service Manager
9.30 Interactive Installation Guide is available from:
http://support.openview.hp.com/selfsolve/document/KM1195794
To install the Service Manager 9.32 online help:
1. Download the Service Manager 9.32 online help zip file from the HP Software Manuals Site:
http://h20230.www2.hp.com/selfsolve/manuals
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2. Install the online help by following the installation steps for the SM9.30 online help, except that you download the zip file from the manuals
site instead of from the product DVD.
3. Configure the Service Manager web tier and Windows preferences so that end users can access the online help from the SM UI. For
details, see the Service Manager 9.30 Interactive Installation Guide.
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Service Manager Support Matrix and
Applications Content Compatibility Matrix
The Support Matrix lists supported versions of operating systems, browsers, HP Software
products, and other compatibility and support information.
The Applications Content Compatibility Matrix (named Compatibility Matrix for Service Manager
Applications Content) provides compatibility information for Service Manager applications content
packs (for example, Process Designer Content Packs).
Note: Most of the support areas require that you register as an HP Passport user and sign in. Many
also require an active support contract. To find more information about support access levels, go to
Access levels.
To register for an HP Passport ID, go to HP Passport Registration.
To access the Support Matrix and Applications Content Compatibility Matrix:
1. Use a browser to navigate to the Software Support Online (SSO) web page:
http://support.openview.hp.com/sc/support_matrices.jsp
2. Log on with your Customer ID and password or your HP Passport sign-in.
3. Navigate to the applicable information.
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Local Language Support
This section includes localization information of this release.

User Interface Localization
The following table lists the supported languages for the Service Manager clients. All languages
listed are supported, except that two right-to-left display languages (Arabic and Hebrew) are not
supported for the Mobility client.
Note: Those highlighted in green are new languages added in this release.

Language

Windows Client Web Client Mobility Client SRC Client

Arabic

√

√

×

√

Brazilian Portuguese √

√

√

√

Chinese Simplified

√

√

√

√

Czech

√

√

√

√

Dutch

√

√

√

√

English

√

√

√

√

French

√

√

√

√

German

√

√

√

√

Hebrew

√

√

×

√

Hungarian

√

√

√

√

Italian

√

√

√

√

Japanese

√

√

√

√

Korean

√

√

√

√

Polish

√

√

√

√

Russian

√

√

√

√

Spanish

√

√

√

√
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Service Manager Applications Language Packs
A language pack is available for each of the languages listed in the table above.

Documentation Localization
This release includes only English documentation, except that the Service Request Catalog 9.32
online help (which is embedded in the product) is available in all supported languages.
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